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Notice

Hewlett-Packard makes no warranty of any kind with regard to this material,
including, but not limited to, the implied warranties of merchantability and
fitness for a particular purpose. Hewlett-Packard shall not be liable for errors
contained herein or for incidental or consequential damages in connection with
the furnishing, performance, or use of this material.

This document contains proprietary information which is protected by
copyright. All rights are reserved. No part of this document may be
photocopied, reproduced, or translated to another language without the written
consent of Hewlett-Packard Company. The information contained in this
document is subject to change without notice.

Microsoft is a U.S. registered trademark of Microsoft Corporation.

PageMaker is a U.S. registered trademark of Aldus Corporation.

(© Hewlett-Packard Company, 1988, 1989.



Printing History

New editions are complete revisions of the manual. Update packages, which
may be issued between editions, contain additional and replacement pages to
be merged into the manual by the customer. The dates of the title page change
only when a new edition is published.

Edition 1................ February 1989

Thanks to Bob Sobol and to the U.S. Department of the Interior for the
photographs used in chapter 4 of this manual.

This manual was created using HP Tag on an HP Vectra Personal Computer,

an HP ScanJet scanner with Scanning Gallery Plus, and an HP LaserJet series
II printer.



FCC Radio Frequency Interference Statement For Model
9195A 110V

This equipment generates and uses radio frequency energy and may, if
not installed and used properly, that is, in strict accordance with the
manufacturer’s instructions, cause interference to radio and television
reception.

It has been type tested and found to comply with the limits for a Class B
computing device in accordance with the specifications in Subpart J of Part 15
of FCC rules, which are designed to provide a reasonable protection against
such interference in a residential installation. Shielded data cables were
used during the type test; therefore, properly shielded and terminated data
cables should be used to reduce potential interference. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

m reorient the receiving antenna.

m relocate the computer with respect to the receiver.

m plug the computer into a different outlet so that computer and receiver

are on different branch circuits.

If necessary, the user should consult the dealer or an experienced
radio/television technician for additional suggestions.



FCC Radio Frequency Interference Statement Model For
9195AB 220V

This equipment generates, uses, and can radiate radio frequency energy and if
not installed and used in accordance with the instruction manual, may cause
interference to radio communications. It has been tested and found to comply
with the limits for a Class A computing device pursuant to Subpart J of Part
15 of FCC Rules, which are designed to provide reasonable protection against
such interference when operated in a commercial environment. Operation of
this equipment in a residential area is likely to cause interference, in which case
the user at his own expense will be required to take whatever measures may be
required to correct the interference.



Conventions Used in This Manual

Bold Font

Bold font highlights important information in the text and introduces new
terms. To find more information about words in bold font, refer to the
glossary.

Italic Font
Italic font designates the title of a document and statements that need to be
emphasized.

Typewriter Font
Typewriter font denotes commands to be typed on your keyboard or
screen menu items to be selected.

Caution
Cautions appear before procedures that could damage the equipment if not
observed.

Warning
Warnings alert you to the possibility of personal injury.

Mouse Actions

Pointing refers to positioning the pointer on the screen with the mouse
without pressing the mouse button. Clicking refers to pressing and releasing
the mouse button quickly without moving the mouse. Dragging refers to
holding down the mouse button, moving the mouse, and then releasing the
mouse button. Double-clicking refers to clicking the mouse button twice in
rapid succession.
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Introducing the ScanJet Plus Scanner

Congratulations on your purchase of the HP ScanJet Plus scanner and interface
kit for your HP Vectra or IBM XT/AT Personal Computer. Using the ScanJet
Plus scanner gives your computer the gift of sight.

The addition of the ScanJet Plus scanner to your computer system now

allows you to capture and save images to use in your desktop published
documents. Use the ScanJet Plus scanner together with Hewlett-Packard’s
exclusive software program, Scanning Gallery Plus, to scan, edit, and print
line art or photographs. Once saved, you can then bring these images into
your favorite paint, page composition, or other desktop publishing application
package. Scanning Gallery Plus also allows you to easily access and use an
optical character recognition package, ReadRight by OCR Systems. ReadRight
“reads” text and efficiently creates text files you can later use in a word
processing program.

Or use the ScanJet Plus scanner directly with other software packages that
have their own built-in scanning capability.

In all cases, your HP ScanJet Plus scanner now makes many different types of
publishing solutions possible for you—solutions available because you gave your
computer the gift of sight.
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Customer Support

If you have a problem with your ScanJet Plus scanner, follow these steps to get
the help you need.

1. Use This Manual

The information in this guide may help you solve the problem on your own. In
appendix A, you’ll find tips to help you with error messages, suggestions for
problem solving, instructions for using Scantest and a list of supported software
products for the scanner. In appendix C, you’ll find warranty and service
information to help you if you have a hardware problem.

2. Call Your Dealer
If you’re unable to find what you need in this manual, call your dealer. He or
she understands your software and equipment and can solve most problems.

3. Call HP Customer Assistance

If your dealer can’t help you, or if you purchased your scanner directly from
Hewlett-Packard, you’re a phone call away from Hewlett-Packard’s Customer
Assistance, a free service available from 7 a.m. to 4 p.m. (MST), Monday
through Friday. Our staff can answer questions on topics such as ScanJet Plus
installation and setup, and they can help you find software solutions that meet
your desktop publishing needs.



Complete This Form First

Before you call, make sure you've followed instructions in this manual and

have asked your dealer or HP sales representative for help. If you still have
problems, please complete the form below before calling. Be sure to include the
manufacturer and model number of the equipment you are using.

Computer model
Hard Disk
Printer
Scanning Gallery Plus version
Microsoft Windows version
Software version
version

version

After gathering this information, call this number:
(208) 323-2551
Customer Assistance Phone Number

Although this may be a long distance call for you, Hewlett-Packard provides
the Customer Assistance service free of charge.

Xi



Hardware and Software Recommendations

Hewlett-Packard has tested and will support the following hardware used with
ScanJet Plus scanner:

Personal Computers

Your personal computer must have at least 512 Kb RAM to operate with the
ScanJet Plus scanner, however 640 Kb RAM is recommended. A hard disk
with at least 20 Mb of memory and a floppy drive are required.

w HP Vectra, HP Vectra ES, CS, RS
m IBM XT, AT

s PS/2 30, 50, 60, 70, 80

m Compaq Deskpro

Mice and Tablets
= HP-HIL Mouse
s HP-HIL Tablets
» IBM PS/2 Mouse
» Microsoft Mouse (bus and serial)

m Logitech Mouse

Video Adapters and Monitors
A monitor supported by Microsoft? Windows is required. EGA or VGA
monitors are recommended.

m EGA

» VGA

s CGA

s MCGA

m HP Monochrome Plus Video Adapter with Display
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Printers

Parallel versions of these printers are required for acceptable printing
performance. An additional 2 Mb of memory or more is recommended for the
HP LaserJet printers.

m HP LaserJet Plus

m HP LaserJet Series 11
m HP ThinklJet

m HP QuietJet

m HP DeskJet

s HP PaintJet

Third-Party Peripherals and Accessories

ScanJet Plus scanner will operate with the following third party peripherals
and accessories, however neither the drivers nor the products are supported by
Hewlett-Packard.

m Genius high resolution monitor

m Wyse 700 high resolution monitor
m Viking monitor

m IBM 8514/A Display Adapter

m Hercules Monochrome Graphics Card
m Mouse Systems PC Mouse (serial)
m Epson FX-80 printer

m Epson MX-80 Graftrax printer

m Epson L.Q1000 printer

m IBM Graphics Printer

m NEC 3550 Spinwriter

a Okidata 92/93 printer

m Okidata 192/193 printer
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m PostScript/LaserWriter printer
m RuggedWriter printer

Supported software
m DOS 3.1t03.X
m HP/MS Windows/286 2.1
m HP/MS Windows/386 2.1
m ReadRight versions later than 1.30 available from Hewlett-Packard

Scanning Gallery Plus operates in a Windows environment. For users who do
not have Windows 2.1, a run-time version of Microsoft Windows is provided on
the Scanning Gallery Plus disks.

Although Hewlett-Packard has verified the use of Microsoft Windows version
2.03 with Scanning Gallery Plus, Hewlett-Packard does not support or
guarantee the use of Microsoft Windows version 2.03 with your Scanning
Gallery Plus software.

If You Have an HP ScanJet Scanner ...

If you are using the earlier model, the HP ScanlJet scanner, you can use
Scanning Gallery Plus. However, some screens will look slightly different

than those illustrated in this guide because some features of Scanning Gallery
Plus require the additional capabilities of the HP ScanJet Plus scanner. For
example, the 8-bit grayscale option appears only when Scanning Gallery Plus is
controlling the HP ScanJet Plus scanner.
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Getting Acquainted

Introduction

This chapter introduces you to the ScanJet Plus scanner. It describes the
contents of the scanner and interface boxes, tells how to unpack your scanner
and what to do if you find that anything has been damaged in shipment.

You’ll also learn how to unlock the ScanJet Plus scanner and how to select a
suitable site for scanning.

Computer

._;,th_lSeum
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Unpacking and Inspecting

ScanJet Plus scanner components are shipped in two boxes. Check for damage
while unpacking the scanner and the adapter kit boxes. If you notice any
damage, notify the dealer or the HP sales office where you purchased the
ScanJet Plus scanner and file a claim with the carrier.

Save all shipping and packaging materials in case you want to transport the
ScanlJet Plus scanner in the future.

You should find the following items in the scanner box:
m ScanJet Plus scanner
m Packing list (not pictured)
u Power cord
m Installation Guide

If you have received the ScanJet Plus Installation Guide in the scanner box,
disregard it. All installation instructions for installing and using the ScanJet
Plus scanner are included here in the HP ScanJet Plus User’s Guide.

Power
Cord

Installation ScanJet Plus
Guide

Figure 1-1. Contents of Scanner Box
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You should find the following items in the ScanJet Plus scanner interface kit.

Manual and Disks

Interface Cable

Figure 1-2. Contents of Interface Kit
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About the Scanner and Interface Kit

To become familiar with the scanner and the interface card refer to these
figures while following this guide.

Copyboard Cover

Document Set Mark

Figure 1-3. ScanJet Plus Scanner, Front View

Warning To avoid electrical shock, do not remove the copyboard glass
for any reason. If the glass breaks, the unplug the ScanJet Plus
power cord immediately.

1-4 Getting Acquainted



interlace Connecior

Power Cord
Receptacle  Power Switch

Figure 1-4. ScanJet Plus Scanner, Rear View

Example Setting

Mounting

) . Bracket
Configuration

Switches
and Cover Plug-In

Connector

Figure 1-5. Interface Card for PC Computers
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Unpacking the Scanner

Remove all packaging materials from the scanner, including the tape from
the copyboard cover and any paper between the copyboard glass and the
copyboard cover.

Unlocking the ScandJet Plus Scanner

Caution A locking mechanism secures and protects the scanner’s
internal mirror assembly during shipment. It must be unlocked
before you can use the ScanJet Plus scanner. Failure to unlock
the scanner can result in damage to the scanning mechanism.

To unlock the scanner:
1. Tilt the scanner on end so that the underside of the scanner faces you.
2. Locate the release lever on the underside of the scanner.

3. Slide the release lever out from the scanner until the bottom of the
release lever is even with the scanner body and you feel a click. See
figure 1-6.

4. Return the scanner to its original position.
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Reloase Lever

Figure 1-6. Unlocking the ScanJet Plus Scanner
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Repacking the Scanner

The ScanJet Plus scanner is a delicate instrument and must be carefully
packaged for shipping. If you transport or re-ship it, follow these steps:

1. Remove the automatic document feeder if you have one attached to the
scanner.

2. Return the scanning bar to its home position by turning off the scanner,
then turning on the scanner and waiting 10 seconds.

3. Turn off the scanner.
4. Disconnect the power cord from the electrical outlet.

5. Relock the scanner by tilting the scanner on end and sliding the release
lever toward the scanner until you feel it lock. See figure 1-7.

Caution It is important to relock the ScanJet Plus scanner before
moving it. Failure to relock the scanner may cause damage to
the scanning mechanism.

6. Repack the scanner in its original box with protective foam pads.
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Release Lever

Figure 1-7. Relocking the ScanJet Plus Scanner
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Selecting a Site for the ScandJet Plus Scanner

Choose a site for the scanner that meets the environmental and power
requirements listed in appendix C. Here are some general guidelines:

m Use the ScanJet Plus scanner only within normal office temperature
and humidity ranges.

m Keep the scanner out of direct sunlight.
m Install the scanner in locations free of constant vibrations.

m Place the scanner on a level surface.
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2

Setting Up

Before you begin this chapter, make sure that you have everything you’ll need
to start scanning. To be sure you have the required hardware and software,
refer to the pages in the front section of this guide that list the supported
hardware and software for the ScanJet Plus scanner.

Although a mouse is not required, we recommend that you use one. The same
is true about using a 20MDb or larger hard disk. Because the HP ScanJet Plus
scanner is a high resolution 8-bit scanner, it can create large files. For example,
a 5 X 7 inch photograph scanned at a resolution of of 300 dots per inch and
8-bits per pixel requires over 3Mb of disk space.

To use your new HP ScanJet Plus scanner, you’ll need to:
m Install the scanning software in your computer system.

m Set the switches on the interface card to a usable setting for your
computer system.

m Insert the scanner interface card into an expansion slot in your
computer.

m Connect the scanner to your computer with the interface cable provided
in the interface kit.

m Turn on power to the scanner and your computer system.
m Test the installation of the scanner in your computer system.

This chapter shows you how to do each task in the best order for the easiest
installation. If you have installed an interface card before, you may want to
skim parts of this chapter. However, be sure to run the software installation
program before installing the interface card because the program provides a
listing of the correct settings for the switches on the interface card.
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Installing the Software
To start the installation program:
1. Insert the ScanJet Plus Installation Disk into Drive A.
2. Type:
A:
3. Type:
SJSETUP

To install only the scanner test program without installing Scanning
Gallery Plus, type: SISETUP /S.

4. Follow the instructions that appear on the screen. If you need help,
refer to the Software Installation Help booklet in the front pocket of the
manual.

Setting the Switches

When the installation program is done, follow the steps below to set the
configuration switches on the interface card to the setting suggested by the
installation program.

1. Remove the interface card from its protective anti-static bag.

Caution The interface card, like most electronic components, is sensitive
to static electricity. When removing the interface card from the
anti-static bag, hold it by the top edge.

2. Find the switches on the interface card.
If you need help finding the switches on the card, see figure 1-5.
3. Remove the plastic cover from the switches, if the cover is attached.

4. With a pencil or your fingers, set the switches to the positions
suggested for your system in the installation program. See figure 2-1.
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Figure 2-1. Examples of Switch Settings
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Installing the Interface Card

In this section, you’ll install the interface card in your computer.

Preparing Your Computer

To prepare your computer for the interface card:

1. Turn off your computer.
2. Unplug the computer system power cords from electrical outlets.

Warning Unplug all power cords from your computer system before
installing the interface card.

3. Remove the top cover of your computer. (You may need to refer to
your computer user’s manual.) See figure 2-2.

Figure 2-2. Removing the Cover

4. Choose any empty card slot, but preferably one with a short connector
socket. See figure 2-3.
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Connector Socket

Figure 2-3. Accessory Card Slots

5. Remove the slot cover from the back of your computer by removing the
screw which holds the slot cover in place. See figure 2-4.

Figure 2-4. Removing the Slot Cover Screw

Save the screw—you will use it to secure the interface card in this slot.
Also, save the slot cover in case you ever remove the interface card.
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Putting the Interface Card in the Socket
To insert the interface card in your computer:

1. Position the interface card in your computer as shown in figure 2-5.

Figure 2-5. Installing the Interface Card

If you are having difficulty fitting the card in the slot, you may need to
adjust the position of an adjacent slot cover or support bracket to allow
more room for the card.

2. Insert the interface card into the connector socket and press the card
down firmly.

Make sure the plug-in connector is seated into the connector socket.
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3. With the slot cover screw, secure the support bracket of the interface
card to the back panel of the computer, as shown in figure 2-6.

Support
Bracket

Figure 2-6. Replacing the Slot Cover Screw

4. Replace the computer top cover.
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Connecting the Scanner to Your Computer

In this section, you’ll connect the scanner to your computer with the
interface cable. Then, you’ll turn on the scanner and computer, and test your
installation.

Connecting the Interface Cable
To connect the ScanJet Plus scanner to your computer:

1. Attach the smaller end of the interface cable to the connector on the
scanner interface card that you installed. See figure 2-7.

Figure 2-7. Connecting the Interface Cable to the Computer

2. Tighten the screws on the cable.

3. Attach the other end of the interface cable to the connector on the back
of the scanner by pushing the wire loop connecters into the holders on
the interface cable.

See figure 2-8.
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Figure 2-8. Connecting the Interface Cable to the Scanner

4. Remove the screw located to the right of the scanner connector, insert
the screw into the loop end of the ground wire, and replace the screw in
the scanner.

See the inset figure 2-8.
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Turning on the Equipment

In this section, you’ll turn on power to the scanner and your computer system.

Turning on the Scanner
To turn on power to the scanner:

1. Attach the power cord to the scanner. See figure 2-9.

Figure 2-9. Connecting the Power Cord to the Scanner.

2. Plug the scanner power cord into an electrical outlet.

Caution Make sure the mirror assembly is unlocked before the scanner is
turned on. Refer to “Unlocking the Scanner” in chapter 1 for
instructions. Damage to the scanner can occur if the scanner is
turned on before the mirror assembly is unlocked.

3. Turn on the scanner power switch. See figure 2-10. The power indicator
on the front side of the scanner should be lit.
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Figure 2-10. Turning On the Scanner.

Turning on Your Computer

To restart your computer system:
1. Plug your computer power cord into an electrical outlet.
2. Turn on any peripheral devices in your computer system.
3. Turn on your computer power switch.

(If you have a separate switch for your computer monitor, turn it on
too.)

If your screen begins showing its usual start-up messages, and soon displays its
expected system prompt, your installation is probably successful.

If your screen displays error messages or fails to display its usual system
prompt or start-up messages within a minute, you may have a problem with
the installation of the scanner. Refer to appendix A for help.
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Testing Your Installation

Now you are ready to test whether the adapter and the scanner have been
correctly installed.

Starting the Scantest Program

You'll use the Scantest program to test your installation and your scanner. The
program can be used any time to test the scanner should you ever think it is
broken or performance is diminished. For convenience, the program can be run
from Scanning Gallery Plus or from Microsoft Windows. The Scantest program
can also test an automatic document feeder (ADF), if you have one attached to
your scanner.

To run Scantest, find the installation choice from the left column of the table
below that applies to your situation and follow the instructions across from it
in the right column. Then, follow the instructions on your computer display.

Installation Choices Instructions for Running Scantest
1. With Microsoft Windows 2.1 1. Type: CD \SCANGAL

1
installed. 2. Type: WIN

3. Double-click SCANTEST .EXE
1

2

2. With a run-time version of
Windows installed.

. Type: CD \SCANGAL
. Type: SCANGAL

3. Scanning Gallery Plus has two windows: the
Scanner Window and the Image Editor Window.
From the Scanner Window:

(a) Click the File menu.

(b) Click Run Scantest.
3. With the SISETUP /S 1. Type: CD \SCANTEST
option chosen. 9. Type: SCANTEST
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Here are some notes to help you with the table and the Scantest program:
m The instructions in the table assume the default selections.

m The instructions assume you are starting from the root directory of the
drive that you chose in the installation program.

m If you choose Installation Choice 1 from the left column of the table,
the instructions assume that your AUTOEXEC.BAT file includes a
path to the directory of your Windows files.

m If you choose Installation Choice 2 from the left column of the table,
you will run the Scantest program from Scanning Gallery Plus. If you
need additional instructions for starting or using Scanning Gallery Plus,
refer to the first sections of chapter 3.

Using the Scantest Program

When the Scantest program begins, you should see a window like this one:

==/ SCANTEST

HP SCANNER TEST

Run Comprehensive Test —— Tests the performance of the scanner.
This test takes about three minutes to run and requires the Test
Target which was shipped in an envelope in the back pocket of the
user s guide.

Run Minimal Test —- Runs a subset of the Comprehensive Test which
does not require the use of the Test Target.

Run ADF Test -- Tests the optional automatic document feeder (ADF).
( Run Comprehensive Test ) ( Run Minimal Test )
( Run ADF Test ) ( Exit )
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Choosing One of the Tests

The Scantest program has three different tests. In most cases, choose Run
Comprehensive Test to test the scanner. If you have an automatic document
feeder with your scanner, run the ADF test too.

If you select the Comprehensive test, you’ll need to use the Test Target in the
back pocket of this guide. When removing the Test Target from the protective
envelope, handle it by the edges because fingerprints on the surface of the
target can cause the scanner to send inaccurate information to the Scantest
program.

Using the Test Target

When placing the Test Target on the copyboard glass, place it squarely against
the scaled frame of the copyboard with the image of the kitten against the
glass. The V on the back of the Test Target should be placed adjacent to the
orange V mark on the copyboard. See figure 2-11.

Also, when you are done with the target, be sure to place it back in the
envelope. If you should lose the target, you can select Run Minimal Test to
determine whether the scanner is performing correctly.

If your installation fails a test, messages on your screen will direct you to
instructions in this guide to correct the problem. If a problem persists, call the
dealer or the Hewlett-Packard sales office where you purchased the scanner.

After Completing the Test

Although the Scantest program checks the scanner for possible problems, the
best test is your first scan.

If you are ready to learn how to scan, begin reading the next chapter,
“Learning Scanning Gallery Plus.” Or, if you want to try using the software
now, use the Quick Reference Guide for a quick overview. For detailed
reference information about Scanning Gallery Plus, refer to chapter 4.
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Figure 2-11. Placing the Test Target on the Copyboard
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Learning Scanning Gallery Plus

Scanning Gallery Plus runs under a windowing system in addition to your
computer operating system. To move around within windows and Scanning
Gallery Plus, we recommend that you use a mouse. The three sessions in this
chapter include instructions for using a mouse. See appendix B for keyboard
instructions.

In this session you will:
m Start Scanning Gallery Plus.
m Practice using a mouse.
m Identify the Scanning Gallery Plus windows.
m Scan line art.
m Scan a picture with shades of gray.

m Print an image.

Computer
. Museum
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Starting Scanning Gallery Plus

You can start Scanning Gallery Plus from Microsoft Windows version 2.1 or
from the run-time version of Microsoft Windows.

To start Scanning Gallery Plus with Microsoft Windows:
At the DOS prompt (C>), type:
WIN SCANGAL

If this does not start Scanning Gallery Plus, then do the following:
1. Type:
CD\WINDOWS
2. Type:
WIN

3. Move the pointer to SCANGAL and quickly press and release the left
mouse button twice.

4. Move the pointer to SCANGAL.EXE and quickly press and release the
left mouse button twice to open Scanning Gallery Plus.

To start Scanning Gallery Plus with the run-time version of Microsoft
Windows:

1. At the DOS prompt (C>), type:
CD\SCANGAL

2. Type:
SCANGAL
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The Scanner and Image Editor Windows

When you open Scanning Gallery Plus, two Windows are displayed. The larger
window is the Image Editor which is used to edit scanned images. The smaller
window (on the right) is the Scanner window which you use to scan images,
then save to a file on a disk.

Usually, the Scanner window and the Image Editor window are displayed at the
same time. Move the pointer to the window that you want to use and click the
mouse button. That window is “active” and comes to the front of the display.

For example, to use the Image Editor window, move the pointer anywhere on
the window and click. The Scanner window is now behind the Image Editor
window (you can see just the bottom of the Scanner window). Move the
pointer on the portion of the Scanner window that you see and click to make it
the active window. If you don’t see the Scanner window you can click Scanner
in the Scan menu of the Image Editor window and the Scanner window will
toggle to the front. You can also click on the up arrow in the top right box to
bring both windows back onto the screen.

Maximize Box

Meontrol Menu Bar Title Bar— Minimize Box—
C= age Edito : \ KK |

File Edit \§can 'View Segtings Help
AN e anne
R\ File Scan® Settings Help t
Pointer
¥
=

Scrolling Arrows
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Using a Mouse

If you are not familiar with using a mouse, we suggest that you do the
following short exercise. This exercise is designed to quickly acquaint you with
the basic concepts of using a mouse.

If you know how to use a mouse, go on to “Selecting a Command.”
The Pointer

When you start Scanning Gallery Plus, notice that a “pointer”—usually in the
form of an arrow—appears on the screen. This pointer indicates your position.
You move the pointer around the screen to select commands and manipulate
the size, position, and status of the window.

Moving the Pointer
In this exercise you will practice moving the pointer with the mouse.

1. Place the palm of your hand over the mouse with your forefinger and
middle finger resting lightly on the mouse buttons. Now, move the
mouse to your right.

Notice how the pointer also moves to the right.

2. Move the mouse upward. The pointer moves toward the top of your
screen as you move the mouse.

If you run out of room on your desk top while moving the mouse,
simply lift up the mouse and place it back down where you have more
room. Then you can begin moving it again.
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Here is some terminology related to working with a mouse. We refer to only
the “left” mouse button because Scanning Gallery Plus uses only the left
mouse button. If your mouse has only one button, that button acts as the
“left” button.

Mouse Terminology

Term Action

Point Move the mouse until the
pointer is where you want it.

Press Hold down the left mouse
button.
Click Quickly press and release the

left mouse button. (Usually
used to select an item.)

Drag Hold down the left mouse
button while moving the
mouse.

Double-click | Click the left mouse button
twice in rapid succession.
(Usually used to open an
item.)

Release Let go of the mouse button.
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Selecting a Command
If your scanner is not on, turn it on now.

1. Click File on the Scanner window.

l_[_ Image Editor

File Edit Scan View oy

ile | Scan Settinas Help

Run Soantest...

Exit
fipout Scanner...

2. Click About Scanner ...

Image Editor

Scan Settings Help

Soanning Gallery Plus
Version 9/22/88
Soanner Model Number: 91934
Scanner Firmware Datecode: 2826
® Copyright Hewlett-Packard Co., 196886
Portions @ Copyright Miorosoft Corporation,
19683-1988. All Rights Reserved.

3. Click OK.

3-6 Learning Scanning Gallery Plus



Review

You have learned to use the mouse and to maneuver within the Scanning
Gallery Plus windows. These exercises have prepared you for scanning an
image and working with the Image Editor in Scanning Gallery Plus.

The next two sessions use terminology relating to choosing a menu, selecting
a command, or selecting a button in a dialog box. The following table defines
each task.

Term Action
Choose menu Move pointer to menu name and click mouse button
Select command from menu Move pointer to a command and click mouse button
Click OK on dialog box Move pointer to 0K and click mouse button
Click Cancel in dialog box Move pointer to Cancel and click mouse button
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Scanning Line Art

In this session you use the Scanner window to scan line art and the Image
Editor window to make changes to the line art you scanned.

The tasks that you will accomplish in this session are:
m Preview Scan an image.
m Select area for an Image Scan.
m Select a final size.
m Scan the final image.
n Edit the image.

m Print the image.
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Preview Scan
Preview Scan allows you to scan an image, then select an area from that image
as your final image.
Remove the sample line drawing on the previous page.
To Preview Scan:
1. Turn on the scanner. The switch is on the back side of the scanner.
2. If you have not started Scanning Gallery Plus, start it now.

If you need help starting Scanning Gallery Plus, see “Starting Scanning
Gallery Plus” at the beginning of this chapter.

3. Lift the copyboard cover and place the line drawing face down as shown
in the following example.

y4
|uglobed !
A
i
b} re==
AT
! A XY ‘\
{ [ Y \
{ -3 \
! \
lr--“ A
g
—~
Document
Set Mark

Setting a Document on the Copyboard Glass

When you place the drawing in the scanner, be sure that it is placed
squarely on the copyboard glass. If it is not, the image will be crooked
on your screen. Do not remove the drawing from the scanner until you

complete all scans.
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4. Choose Preview Scan from the Scan menu. (This command is in the
Scan menu in the Scanner window.)

=

£dit Socan View Segrings H
i

Scanner

Preview Scan... Ctrl+p
Crrli+l

5. The Preview Scan dialog box is displayed.

Selectimage  Contrast adjustment not Move to adjust
typetoscan "\ available for ineart "\ ‘_image intensity

Image Editor \ \ IRAKY |

Seztings [ \
/ ‘E{g file Fcan Segrings Help |\

Presview So
nage Type
[(J6xiginal Tncludesi

8ray or Color
Soanned As:

Lighten
COBYRAST: Sev

Line Arxt Soften Sharpen
Change firay... Negative Image

' oK ] ance Help )

Select for
negative image

If you are using a ScanJet scanner (not the ScanJet Plus scanner), the
Intensity levels are displayed as Darken or Lighten buttons. Also, the
contrast adjustment is not available.
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6. Click OK to begin scanning,.

The scanner begins scanning your image. The pointer changes to an
hourglass and changes back to a pointer when the scan is complete.

A scaled-down image is displayed in the Scanner window.

7. Click OK in the prompt box.

Image Editor

Scan Segtings Help

To scan only a portion of vour
image, press vour mouse button
and drag to select an ares.

Then use Image Scan.
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Using the Selection Box

Now that a scanned image is shown in the work area, select a portion of the
image by making a selection box.

To make a selection box:

1. Move the pointer to the position shown in the following screen.

Selection box starts here ~
=] Jimage Editor IRAE |

File Edit $Socan VYiew Segtind : Scanner
i o File Scan Seitings Helo

2. Drag the mouse down and to the right. As you move the mouse, the
selection box appears and follows the movement of the pointer.

3-12 Learning Scanning Gallery Plus



3. When the box surrounds the area that you want for the Image Scan,
release the mouse button.

If you move the pointer outside the selection box and click, the box
disappears. Begin again from step 1 to start the selection box.

=

File Edit focan Yiew Segtings =

Scanner

File Scan Settings Help

You can adjust the size of the selection box or move the selection box to
include or exclude areas.

Adjusting the Size of the Selection Box

Place the pointer on a side handle of the selection box. Press the mouse button
and move the mouse. The size of the box changes as you move the mouse.
When you place the pointer on a corner handle, the size of the box changes in
two directions.

Moving the Selection Box

Place the pointer inside the selection box. Press the mouse button and move
the mouse in any direction. The box moves as you move the mouse.

Learning Scanning Gallery Plus 3-13



Image Scan

Now you’ll do a high-resolution scan of the area enclosed by the selection box.

1. Choose Image Scan from the Scan menu.

The Image Scan dialog box is displayed.

Eile Editr Soan Yiew Settings

e M P e e o

Image Scan Settings Help

| rImage Type————— INTENSITY: Sex

@ray or Coler CONTRAST:  S@y
Soanned As)
Line Art Soften Sharpea LY

[l fegative Inage

O nirror Imase

(m] Original Inocludes Derken Lishten B

i [Final Size
MIDTH: 6.32 in HEIGHT: 6.77 in

200 4 180x 200
( 308 dpi) ( 308 dpi) -

X proportional Soaling

( Lanoel j

4

elp

2. Now select the size you want for the final image. Click on the scroll bar
arrows until the height and width dimensions are approximately equal
to the ones shown in the following illustration. You also can adjust the
height and width by dragging the scroll box (the rectangle inside the

scroll bar) to a new position.

The Proportional Scaling box allows you to choose between

proportional scaling and non-proportional scaling. When the box is

checked, proportional scaling is selected.

When proportional scaling is selected, the height and width dimensions
maintain proportion when either is changed. When non-proportional
scaling is selected, height and width can be changed independently.
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Click here
10 decrease size_\

Click here
to increase size

| S

File

BB

HAREREBE

[Image Type

O ogiginal Includes
@ray or Color

Soanned #As:
Llne Art

Edit Scan View Settings
% 38 BEBBEBBHUSUBHERY

Image Scan

1mage Editor | JIINA AR IE |

Segtings Help

NTENSITY: 3@x%

Darken Lighten
LDONFRAS F1 Sov

Soften Sharpen
[0 Negative Imas

Clnirror 1mage

[[Final Size

YIDTH:  2.44 in

4

114%
( 3ee dpi)

EIGHT:

x Proportional Soaling
X

?2.71 in

4 200

114x%
C 300 dpi)

' Lancel |

Proportional Scaling is checked

elp

3. Click Scan. The Save Image dialog box is displayed.

Image Editor

Image Type

O Oxiginal Includes
Gray or Color

[

Scanned s
Line Artc

Final Size

Settings

Help

NTENSITY: 35@x%

Darken Lighten
CONYRAS T'x 54y

Soften Sharpen
] Negative Image
Dﬂirror Imnage

1004
¢ 3808 dpi)
(X proportional Scalins

WIDTH2 6.32 in HEIGHT, 6.27 in
(=] ] [=b}
4 200 4 100% 200

C 300 dpl)

G

( Cancel

)

elp

4. Type the name of the file.
5.

Click 0K to begin the Image Scan.

When the scan is complete, the image file is displayed in the Image
Editor and is saved as a .TIF file on your hard disk.

Learning Scanning Gallery Plus 3-15



Closing the Scanner Window

Now that you have a copy of the image in the Image Editor window and on the
disk, you are going to close the Scanner window.

To close the Scanner window:
1. Click the Control menu box in the Scanner window.
Control Menu box

el Image Editor — IMAGE.TIF
File Edit Scan View Segttings

Restore RLCIFS
Hove Ale+F?
Size QRLLHFDH
Hipieize QRLTFY
Haximize ALTIFLA ¢

2. Click Close.

Image Editor - IMAGE.TIF
File Edit Soan View Segtings Help
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Editing the Image

Once you have scanned an image, you may find certain areas on the image that
you want to cut or copy, then paste into another area. Or, you may want to
keep just a portion of an image. You perform these operations in the Image
Editor window. In the next exercise, you’re going to cut out a portion of the
image and paste it into another area.

Changing the View

When the image is placed in the Image Editor window, it is displayed in Detail
View. To work on the whole image, select Full View.

To change the view:

1. Choose Full View from the View menu.

Image Editor - IMAGE.TIF
File Edit Scan m Segtings Help

fetail Yiew
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To edit an image:

1. Move the pointer to the area shown in the following screen.

[ & [O@]

Image Editor - IMAGE.TIF
File Segtings Help

Move pointer here —/

2. Drag the selection box to enclose the area shown in the following screen.

The selection box works the same in the Image Editor as it does when
you select an area for a Image Scan in the Scanner window.

Image Editor - IMAGE.TIF

Selection box—""
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3. Choose Cut from the Edit menu.

Image Editor - IMAGE.TIF [ 3 3%
| File [ Edit | Soan Yiew Segttings Help
Yndo/Reda ALt +BkSo -

Iy
Cyt Shift+Del =
Q Ctrl¢ins WA G~ -
o ™

Del e

Shlifrelns

When you cut or copy a portion of an image, that portion is placed
into the Clipboard. The Clipboard is used to hold information being
copied or moved. When you do a Paste operation, the portion in the
Clipboard is pasted to the area that you selected. It also remains in the
Clipboard until you cut or copy again.

4. Move the pointer to where the image is to be pasted and click.

Image Editor - IMAGE.TIF [ & 13
Editr Scan Yiew Segtings Help
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5. Choose Paste from the Edit menu.

= Image Editor - IMAGE.TIF
Edit | §oan VYiew Segtings Help
Undo ~ Cut ALlr+BkSp 7

| 5 [90]

Shifr+Ded
Caoy Crri¢lins
Ded

Shifr+ilns

When you select Paste, the portion of the image that you cut in step 3
is pasted from the tip of the pointer, down and to the right. The pasted
image is surrounded by a dotted-line box called a floating paste box.

Image Editor - IMAGE.TIF

N Floating paste box
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Moving the floating paste box

Move this box to place the pasted image exactly where you want it on the
image in the Image Editor window. When you move it, it changes to a filled
box. You can move it as often as you like until you have the area exactly where
you want it.

To move the floating paste box:
1. Click inside the floating paste box.

2. Move the mouse and the floating paste box moves. The pointer changes
to an hourglass while waiting for the filled box to come up.

Image Editor - IMAGE.TIF
File Edit Soan Yiew Settings Help
i

3. Release the mouse button when the box is where you want it.
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4. Repeat steps 1 through 3 until the image is exactly where you want it.

5. Click outside the floating paste box. The image area is anchored and
the floating paste box is gone.

Image Editor - IMAGE.TIF
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Saving the Image

Finally, when the image is exactly as you want it, save it to the disk once
again. You can save it under the same name you used for the Image Scan, or
you can give the image a new name.

To save to the same file name:
1. Choose Save from the File menu.

The file is automatically saved to the name that you typed for the final scan.

Image Editor - IMAGE.TIF
File [ Edit Scan VYiew Settings Help
pen. ..

Save -ee

Print...
HP DPireot Print...

Conyert To...

Run Image Editor... —a o L. ;T
Run Control... 4

Exit g H %
Apout Image Editor... Soig
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Printing the Image
To see what the image looks like on paper, print it.
To print a selected portion of the image:

1. Make a selection box around the baby tiger.

2. Select Print from the File menu. (If you have a Hewlett-Packard
printer you can choose the HP Direct Print command for faster

printing.)

Image Editor - IMAGE.TIF

3. From the Print or HP Direct Print dialog box, click Selected Portion
of Image.

4. Click OK to begin printing.
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To print the entire image:
1. Choose Print from the File menu.

2. Select A1l of Image in the printer dialog box. To print large images on
300 dpi laser printers, additional memory in the printer may be needed.

— Image Editor - IMAGE.TIF
File | Edit Scan View Settings Help

Open... L

Bave

Save fis... 44;2;::

Print... Ctrle+P
HP Direct Prant...

™

Conyert To...

Run Image Editor...
Run Control...

3. Click OK to begin printing.
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Summary

Here are the steps for scanning and editing line art with Scanning Gallery Plus:

Scanner Window

© ® N g N

Place a drawing face down on the copyboard glass.
Choose Preview Scan from Scan menu.

Click 0K to begin Preview Scan.

Make a selection box.

Choose Image Scan from Scan menu.

Click Scan.

Name the image.

Click 0K to begin the Image Scan.

Close the Scanner window.

Image Editor Window

Choose Full View from View menu.

Select an area to cut.

Choose Cut from Edit menu.

Select an area to paste to.

Choose Paste from Edit menu.

Move the floating paste box to correctly place the cut area of image.
Move pointer out of the floating paste box and click to anchor area.
Choose Save from File menu to update image file.

Print the image.
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Scanning a Picture

The last session explained how to scan line art. In this session you will scan a
picture—an image with shades of gray.

In this session you will:
m Select an image area.
m Size the image.
m Change the dither pattern.
m Edit the image.

m Print the image.
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Scanning the Picture
To Preview Scan:

1. If the Scanner window is not open, choose Scanner from the Scan menu

in the Image Editor window.
2. Lift the copyboard cover and place the picture of the tiger face down.

3. Choose Preview Scan from the Scan menu in the Scanner window.

The Preview Scan dialog box appears.
4. Click Original Includes Gray or Color.

= [9]
uc Edit Scan View Segtings
File $Scan Segtings Help

Image Tvpe
R0xiginal Tnoludes!
@ray or Color
Soanned Ass
Coarse Fatting Dither

Preview Soan
NTYENSITY:

Darken

CONTRAST:

Softren

[ Negsative Image

S0x

Lighten
SOx

Sharpen

(’ane.l )

(__uoln )

—

5. Click OK to begin scanning.
6. Click 0K in the prompt box.
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Photography by Steve Castillo






Selecting the Image Area

After completing the Preview Scan, select an area of the image in the work
area for your final image.

To select an Image Area:

1. Use the selection box to select the area shown in the following screen.

Handles < \

| = Imave Editor
File Edit Socan Yiew Segtings

If you need help, see “Using the Selection Box” in this chapter.
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2. Choose Image Scan from the Scan menu.

The Image Scan dialog box is displayed on your screen.

Image Editor

NTENSITY:

I0x

rInage Type

j }
Xioyiginal Includes] Darken Lighten

Gray or Color CONTRAST: sex%
Scanned As:
Coarse Fatting Dither | Soften Sharpen

O tesseive inese

O pirror Image

rFinal Size
MHIDTHs 4.29 in HEIGHT: 4.99 in

4 73% 200 4 % 208
( 398 dpi) ( 380 dpi)
X proportional Soaling

)

( Soan (anopl) ( Help )

Segttings Help

3
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Changing the Dither Pattern

Dithering allows printers and computer displays to produce images that
appear to have continuous shades of gray. These images look like ordinary
photographs.

There are four different types of dither patterns. You are going to change from
the default pattern, coarse fatting dither, to Bayer dither. See “Dithering” in
chapter 4 for additional information about dither patterns.

To change the dither pattern:
1. Click Change Gray ... in the Image Scan dialog box.
2. Click Bayer dither.

Click here to display the
/ Gray/Color dialog box

Image Editor

I I - -~ - - -

i n Settings Help

8ray/Color
Enoligina Includes d Create dlthered image using:s
8ray of Color QO coarse Fattlng dither
Soanned #s» | OEatting dither
Fayring Dither j gisﬁz;‘ii;;:;
. &gnuou Line dither

Create grayscale image usings

rFinal Size QO 4 bit Graysoale
WIDTHS 4.294in  HEIGNT: 4.98 S0 uiy arayscale

?3% 200
C 3008 dpi)

Xl Proportional Soaling

( Cancel ) .:. )

ﬂ ettt 3 Graylcobr dlalm mx

3. Click 0K to return to the Image Scan dialog box.

If you have a ScanJet scanner (not the ScanJet Plus scanner) 8-bit grayscale
will not be displayed in the Gray/Color dialog box. This is displayed only with
the ScanJet Plus scanner.
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Sizing the Image

The width and height of the image are displayed in the Image Scan dialog box.
These dimensions show the image size that you selected for the Image Scan.

Adjust the size of the image with the Width and Height scroll bars. To ensure
that the width and height are proportional, the Proportional Scaling box
should be checked.

If your exact dimensions cannot be displayed, use the dimensions that come the
closest to what you want.

To change the size:

1. Place the pointer as shown in the illustration below. Click on the scroll
box arrows until the height and width dimensions are approximately
equal to those in the illustration.

Click here Click here_
to decrease size_\ / to increase size

Image Fditor

ew Seftings
e

!NTENS!TVI 30%

mnx_.l’.ln.l Includes Darken Lighten
Gray or Colorx CONTRAST: sex

Scanned Asi:
Oayer Dither Soften Sharpen

D temavive 1nes

{ D HNirror Imnage

| rFinal Size
MIDTH: 6.231n  HEIGNTs  7.251n

4 109% 200 4 109% 2
C 308 dpi) C 380 dpi)

& Proportional Scaling
Y

ﬁ.ne.l ) ( Help

Proportional Scaling is checked
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Scanning the image

You have selected the image area to scan, the dither pattern, and the final size.
Now you are ready for the Image Scan.

To begin the Image Scan:
1. Click Scan in the Image Scan dialog box.
2. Type TIGER in the Save Image dialog box.
3. Click OK to begin the scan.

Closing the Scanner Window

Now you are going to work in the Image Editor window. You can move the
Scanner window out of the way or close it.

To close the Scanner window:
1. Choose Close from the Scanner Control menu box in the scanner

window.

Control Menu box

| Sl Image Edivor - TIGER.TIF
File Edit Scan View Segtings

: Scanner
Restore  Aiverd |Heo I
Move ALT+F? .
Size PireFg
Mipintze Bl e¢F9
Maximize RiveFad

ALt +FAa
L R
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Viewing the image

When the image is displayed in the Image Editor window, it is displayed in
detail view. To work with the entire image, change it to full view.

To change the view:

1. Select Full View from the View menu.

Image Editor - TIGER.TIF

=]

File Edit Soan | Yiew |
full View
$recify DethWijl View
Detail VUiew
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Editing the Image

To make changes to the image, use the Edit menu. You can cut, copy, paste, or
crop the image. For this exercise, you will crop the image.

When you crop an image, you select only the portion of an image that you
want to keep.

To crop an image:

1. Move the pointer to the area shown in the following screen.

Move pointer here

Image Editor - TIGER.TIF
iew Segtings MHelp
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2. Use the selection box to select the area that you want to keep.

Image Editor GER.TIF
tin 1p

Remember, you can adjust or move the selection box if the area is not
exactly what you want. See “Using the Selection Box” in this chapter.

3. Choose Crop from the Edit menu.
The image is cropped. Everything outside of the selection box is

deleted.

= Image Editor - TIGER.TIF
File Edit Soan Help
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Printing an Image
In this final exercise you will print the image.
To print an image:

1. Choose Print from the File menu. (If you have a Hewlett-Packard
printer you can choose the HP Direct Print command for faster
printing.)

The HP Direct Print dialog box is displayed. You have two choices.
You can print the entire image or just a portion. For this exercise, you
will print the entire image.

image Editor - TIGER.TIF
HP Direot Print
Print firea

® All of Image
O Selected Qrea of Image

Number of copies to print:
Printer

2. Click OK to begin printing.
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Exiting Scanning Gallery Plus

When you finish using Scanning Gallery Plus, exit from the program.
1. Select Save to save the current changes.

2. Select Exit from the File menu.

File | Edit Scan VYiew Soxéln's Help
Qpen...
Save
Save fAiS...

Print... Crrl+P
HP Direot Print...

Conyert VTo...

Run Image Editor...
Run Control...

Ahout age Editor

L

3-38 Learning Scanning Gallery Plus



Summary
Here is a summary of the steps for scanning and editing a picture containing

shades of gray.

Scanner Window

Open the Scanner window.

Choose Preview Scan from Scan menu.
Select Original Includes Gray or Color.
Click OK to begin a Preview Scan.

Make a selection box.

Change dither pattern.

Size the image.

Choose Image Scan from Scan menu.

© P NS s W

Close Scanner window.

Image Editor Window

Change the view in Image Editor window.

Make a selection box around the area of the image to keep.
Crop the image.

Save the image.

Print the image.

A O

Exit from Scanning Gallery Plus.

End of Learning Sessions

After doing the exercises in this chapter, you are ready to scan and edit
images. For further information, refer to chapter 4, “Scanning Gallery Plus
Reference.”
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Scanning Gallery Plus Reference

This chapter is the reference to Scanning Gallery Plus. In it you’ll find
information about the commands in the Scanner Window and the Image Editor
window, definitions in the dialog boxes, and tips for scanning your images.

You can learn about resolution, dithering, and grayscale in this chapter, as well
as how to choose the proper settings in Scanning Gallery Plus and how to use
the Help feature.

Computer
" ;&MUSB um
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The Scanner Window

When Scanning Gallery Plus is started, the Scanner window and the Image
Editor window are displayed at the same time. Click in a window to make it
“active” and it comes to the front of the display.

For example, to use the Image Editor window, click anywhere on the window.
The Scanner window is now behind the Image Editor window. You can see just
the bottom of the Scanner window. Move the pointer to the portion of the
Scanner window that you see and click to make it the active window. If you
don’t see the Scanner window, you can toggle it (make it active) by clicking on
the Scanner command under the Scan menu.

Image Editor

can View Settings Help

Scanner
File Scan Settings Help

You scan images in the Scanner window. In this chapter you’ll find
descriptions, commands, and dialog boxes that are associated with scanning an
image.

The menus appear in the order that they appear in the Scanner window.
Dialog Boxes

Dialog boxes provide choices for scanning images. You select options and make
changes to settings in a dialog box. When the dialog box reflects the choices
and settings that you want, click a button to start a process.
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File Menu

The commands listed in the File menu are Convert To, Run Scantest, Run
[application], and About Scanner.

Convert To

This command is used to convert your current image file to a different file type.
Scanning Gallery Plus creates Tag Image Format File (TIFF) files. Currently,
the other file types that you can convert to are MSPaint, PC PaintBrush,
GEM, and Encapsulated Postscript.

The Convert To command is grayed out in the Scanner window until you do an
Image Scan.

To Convert an Image file:
1. Do an Image Scan.
2. Choose Convert To from the File menu.
3. Select a file type from the Conversion list box.
4. Type the name for the converted file in the Convert To edit box.
5. Click OK.
Convert Dialog Box

BC Paintbrush(B & W)
PC Paintbrush(4 Clr)
PC Paintbrush(16 Cir)

c to
File name: D \SCANGAL
[EVEL.mSP ]

O Delete original file

' gl( ) ( Canoel ) uoln )

Convert to The name of the converted file. You type this name in the
Filename box.

Conversion This is the type of file you are converting to.

Delete original file When you don’t want to keep the original image file, select
this box.
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Run Scantest

This command is used to test whether the interface card and the scanner have
been correctly installed.

When you are in Scanning Gallery Plus, you select this command from the File
menu. Follow the instructions on the screen to run the Installation Test.

See “Testing Your Installation” in chapter 2 for more information.
Run [application]

This command allows you to run other applications from within Scanning
Gallery Plus. To use this command, Microsoft Windows version 2.1 must be
installed.

The applications are set up in the Settings menu with the Specify Applications
command. See “Specify Applications” in this chapter, for information about
setting up applications in the File menu.

To run an application:

1. Choose Run [application] from the File menu.

About Scanner

The About Scanner dialog box lists the application name, the software version
number, the scanner model number, and the scanner firmware date code.

- Soanning Gallery Plus
a'e Version R.63. 00
Soanner Model Number: 9193A
Soanner Firmware Dateocode: 2838
® Copyright Hewlett—Paokard Co., 1988
Portions @ Copyright Miorosoft Corporation,
1983-1988. All Rights Reserved.

cCED
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Scan Menu

In the Scan menu you choose the type of scan: Preview Scan, Image Scan, or
Text Scan.

The Text Scan command is available only if you have Microsoft Windows 2.1
and ReadRight OCR installed, and ReadRight has been specified under the
Settings menu.

Preview Scan

Choose the Preview Scan command to scan your image. Then you can select
an area from this image as your final image by making a selection box.

When you choose Preview Scan, you see a dialog box in which you select the
image type, intensity level, contrast level, or a negative image.

The scanned image is displayed in the Scanner window work area. This image
is a scaled down likeness of the original image.

To Preview Scan an image:
1. Choose Preview Scan from the Scan menu.
2. Select the setting that reflects the type of image you are scanning.

3. Click OK.

Preview Scan Dialog Box

Preview Soan
Inage Type NTENSITY: 38x

ROxiginel Inoiudes! | parken Lighten

8ray or Color CONTRAST: sex
Soanned As:

Coarse Fatting Dither | Soften Sharpen

[] Mesative Image
' ox ' [ Lancel ) elp

Original Includes Gray or Color To determine if you should select this option
for your image, decide if your image is line art or a picture containing shades of
gray.
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Line art usually consists of lines and shapes that can be drawn by hand. Most
graphs, line drawings, charts, text, and hand-drawn pictures fall into this
category.

Photographs are more complicated than line art. They have different levels of
shading. In this category are black and white photographs, color photographs,
shaded drawings, and magazine pictures.

Example of Line Art
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Scanned As This information box shows the current selection: line art, a
dither pattern, or grayscale.

If you are not using the HP ScanJet Plus scanner, but are using the HP
ScanJet scanner, 8-bit grayscale is not available.

Change Gray The Original Includes Gray or Color box must be selected to
use the Change Gray button. When you select Change Gray, the Gray/Color
dialog box is displayed. Here you can choose to create a dithered image using
one of four dither patterns or grayscale, either 4-bit or 8-bit.

For information about dithering and grayscale, see “Gray/Color Dialog Box” in
this chapter.
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Intensity The intensity range is used to darken or lighten the original image.
The intensity values range from 0% (darken) to 100% (lighten).

25% 50% 75%

If you are using the HP ScanJet scanner (not the HP ScanJet Plus scanner),
three intensity values are offered: Lighten, Normal, or Darken.
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Contrast The contrast range is used to soften or sharpen the contrast level
of the original image. The contrast values range from 0% (soften) to 100%
(sharpen).

The Contrast scroll bar is grayed out when the image type is line art.

If you are using the ScanJet scanner (not the ScanJet Plus scanner), the
Contrast scroll bar is not displayed.

25% 50% 75%

Negative Image When you want the scanned image to be a negative of the
original image, choose this option.
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Selection Box

The selection box is used to select an area on the image for your final scan. To
use the selection box, move the pointer to a place on the image in the work
area. Press and hold the mouse button and drag the mouse down and to the
right. A box forms as you move the mouse. Release the mouse button and the
box remains on the image area.

Sizing the selection box

Place the pointer on a handle on the selection box. Press the mouse button
and move the mouse to the left or the right. The size of the box changes as you
move the mouse. Place the pointer on a corner handle and the size of the box
changes in two directions. Release the mouse button when you finish sizing the
box.

Moving the selection box

Place the pointer inside the selection box. Press the mouse button and move
the mouse in any direction. The box moves as you move the mouse. Release
the mouse button when you finish moving the box.
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Image Scan

The Image Scan command creates the final image, places it in the Image Editor
window and saves it to a file on disk.

Do a Preview Scan before an Image Scan if you don’t want the entire image for
your final image. After doing a Preview Scan, make a selection box around the
area that you want to scan.

If you want to change the resolution or choose a different paper size, refer to
“Settings Menu” in this chapter.

To Image Scan:

1. Use the selection box to select an area on the image in the work area to
scan.

Select the width and height for the image.
Select the intensity for the image.

Select the contrast for the image.

oA e

Click Scan.
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Image Sean Dialog Box

[Image Type—— gN‘I’ENSl'I’V- Sex

IXlo;uxnu Inocludes Darken Lighten

6ray or Color CONIRASTs  3ox%

Soanned Asa
Bayer Dither Soften Sharpen

Ctsacive Inese

[Opirror Image

(Final Size
NIDTHa 4.39 in HEIGHTs 6.39 in

4 163% 200 4 163x% 200
¢ 3600 dpl) ¢ 308 dpi)
= Prapartional Soaling

( iSoan ) ( Lancel ) elp

Image Type

Original Includes Gray or Color To determine if you should select this option
for your image, decide if your image is line art or a picture containing shades of
gray.

Line art usually consists of lines and shapes that can be drawn by hand. Most
graphs, line drawing, charts, text, and hand-drawn pictures fall into this
category.

Pictures are more complicated than line art; they have different levels of
shading. In this category are black and white photographs, color photographs,
shaded drawings, and magazine pictures.

Scanned As This shows the type of image you are scanning: line art, dither
pattern, 4-bit grayscale or 8-bit grayscale.

Change Gray The Original Includes Gray or Color check box must be selected
to use the Change Gray button. When you select Change Gray, the Gray/Color
dialog box is displayed. Here you can choose to create a dithered image using
one of four dither patterns or a grayscale image using either 4-bit or 8-bit
grayscale.

If you are using the HP ScanJet scanner (not the HP ScanJet Plus scanner),
8-bit grayscale is not available.

For information about dithering and grayscale, see “Gray/Color Dialog Box” in
this chapter.
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Intensity The intensity range is used to darken or lighten the original image.
The intensity values range from 0% (darken) to 100% (lighten).

If you are using the HP ScanJet scanner (not the HP ScanJet Plus scanner),
three intensity values are offered: Lighten, Normal, or Darken.

Contrast The contrast range is used to soften or sharpen the contrast level
of the original image. The contrast values range from 0% (soften) to 100%
(sharpen).

The Contrast scroll bar is grayed out when Line Art is the image type.

If you are using the HP ScanJet scanner (not the HP ScanJet Plus scanner),
the Contrast scroll bar is not displayed.

Negative Image When you want the scanned image to be a negative of
the original image, choose this option. When you choose this option for the
Preview Scan, it will automatically be chosen for the Image Scan.

This is an example of negative image:
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Mirror Image When you want the scanned image to be a mirror image of the
original image, choose this option.

If you are using the HP ScanJet scanner (not the HP ScanJet Plus scanner),
the Mirror Image box is not available.

This is an example of a mirror image:

Final Size This is the size for your final image. Scale the image before you
begin your Image Scan.

Final Size
HIDTHs 8.30 in HEIGHT: 11.00 in

4 100% 200 4 100x 200
¢ 300 dpi) ( 390 dpi)

(X proportional Soaling

When the Proportional Scaling box is selected, the width and the height
change uniformly.

When the Proportional Scaling box is not selected, you change the width and
height individually; however, non-proportional scaling will result in distortion
of the image.
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The scale range for the Width and Height scroll bars depends on the resolution
selected. Different sets of minimum and maximum scale readings are displayed
for different resolution settings. The resolution should be set to match the
resolution of the printer you are using, except when using grayscale and/or
sending to a high-resolution device. Refer to the resolutions under the Settings
Menu. Then, when the image size is 100%, the printed image will be the same
size as the original scanned image. See “Resolution” in this chapter for more
information.

Gray/Color Dialog Box

@ray/Color
Create dithered image using:
®iCoarse Fatting dither
O Eatting dither
O Bayer dither
ogort.l.oa.l. Lino dither
Create graysoale image using:
QO 4 bit eraysocale
O 8 bitr eraysoale

l (1 ' lgnnoo.l.l elp

The Original Includes Gray or Color box must be selected before you can use
the Gray/Color dialog box.

The scanner supports four different types of dither patterns: two fatting
patterns, the Bayer pattern, and the vertical line pattern. For more
information about dithering see “Dithering” in this chapter.

The HP ScanJet Plus scanner also supports two types of grayscale. See
“Grayscale” in this chapter.

If you are using the HP ScanJet scanner (not the HP ScanJet Plus scanner),
only 4-bit grayscale is supported.

To select a dither pattern or grayscale:
1. Click Change Gray in the Preview Scan or Image Scan dialog box.

2. Select one of the four dither patterns or one of the two grayscale
options.

3. Click OK.
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Dithering

Dithering is an image processing technique that allows printers and computer
displays to produce images that appear to have continuous shades of gray.
Dithering makes it possible for printers and displays to produce images that
closely simulate photographs.

Dithering should be used if your application does not support grayscale.

With dithering, the image quality may be poor when sizing the image with an
application other than Scanning Gallery Plus. If you plan to scale the image in
another application, use grayscale instead of dithering.

When to Choose Dithering

You should not dither line art. Do not select the Original Includes Gray or
Color box before starting a Preview Scan or an Image Scan.

You should dither photographs. The Original Includes Gray or Color box
should be selected before starting a Preview Scan or an Image Scan. When you
select the Change Gray button, the Gray/Color dialog box is displayed for you
to select from the list of dither patterns.

Dithering Side Effects

Dithering may have some adverse effects. If you scan and redither a halftone or
dithered picture, for example, you will probably notice repeating interference
patterns.

To alleviate this effect, try changing the dither pattern, try scaling the image,
or scanning the image as line art.

Image distortion may also occur if you size an image after it has been dithered.
To avoid this problem, size the image in the Image Scan dialog box in Scanning
Gallery Plus rather than another application.
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Selecting a Dither Pattern

You can select four dither patterns in Scanning Gallery Plus. Generally, the
best pattern is coarse fatting. Experiment with these patterns to understand
how they work while trying different intensity and contrast settings to achieve

optimum results.

Bayer Vertical line

Coarse Fatting Fatting
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Grayscale

Grayscale gives shades of gray without using a dither pattern. If you plan

to resize the picture with other software, you should choose grayscale. First
verify that your application software supports grayscale. An advantage of
choosing grayscale is that the quality of the image is retained when sizing. If
you are using the HP ScanJet scanner (not the HP ScanJet Plus scanner), 8-bit
Grayscale is not available.

To select grayscale:
1. Click Change Gray in the Preview Scan or Image Scan dialog box.
2. Select a grayscale option.

3. Click OK.

An 8-Bit Grayscale Image Printed at 1270 dpi
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Text Scan

This command is used for creating text files. You can scan pages of text and
save them to a file you create, or join them to an existing file. Microsoft
Windows version 2.1 and a version of ReadRight OCR later than 1.30 must be

installed to use this command. The Text Scan command does not work with
Microsoft Windows\386.

The Text Scan command appears only if you have specified the executable file

name in the Specify ReadRight OCR dialog box. Refer to “Specify ReadRight
OCR?” in this chapter.

To scan text pages:
1. Choose Text Scan from the Scan menu.

2. Select the appropriate choices from the Text Scan dialog box.
3. Click Scan.

Text Scan Dialog Box

= dexcsean |
r8aye Text

@ Place text in a new file
O fippend text to an exlsting file

[Jscan A1l Pages in JoOERSIIVE S0%
& ag!
Oosuneatr Fgeder k.n u-h
FILE FORMAT: LANGUAGE
ASCII DP Fnglish
ASCII WP
ASCIT WYSIWVE [] [ ]
VORD PERFECT
ROSTAR

4 +

( Joan ) (gnnoo.l ) elp
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Save text Type the file name to create for the document you are scanning.
Include the entire path name if you use a different directory or a different drive

and directory. You can create a new file name or type the name of an existing
file.

Select Place text in a new file to save the scanned text to this file name.
Select Append text to an existing file to join text to that file.

Scan All Pages in Document Feeder Select this box to scan all pages in the
ADF document tray. If the box is not selected and pages are ready to be
scanned in the ADF document tray, only one page will be scanned.

Intensity The intensity range is used to darken or lighten the original image.
The intensity values range from 0% (darken) to 100% (lighten).

If you are using the HP ScanJet scanner (not the HP ScanJet Plus scanner),
three intensity values are offered: Lighten, Normal, or Darken.

File Format Select a format that matches your word processor from one of the
file formats displayed. These file formats are supported by ReadRight. Refer to
your ReadRight user manual for more information on file formats.

Language Select a language in this box. These languages are supported by
ReadRight; however, ReadRight does not translate English documents to other
languages.

Also, refer to chapter 5 “Using Scanning Gallery with Microsoft Windows and
ReadRight.”
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Settings Menu

The commands in the Settings menu are Resolution, Paper Size, and Prompt.
If Microsoft Windows 2.1 is installed, Specify Applications and Specify
ReadRight OCR are also available.

Before you begin an Image Scan, change the current settings of Resolution and
Paper Size. If you don’t make these changes before the Image Scan, the current
settings are used to scan the image.

To run other applications from Scanning Gallery Plus, set them up in the
Specify Applications dialog box and run the application with the appropriate
run command in the File menu. To create text files from scanned images, set
up the path and file name of the OCR ReadRight executable file in the Specify
ReadRight OCR dialog box.

Resolution

Resolution is specified in dots per inch (dpi) and tells the scanner how many
image samples to read per inch both horizontally and vertically. Three
resolutions and one custom resolution are available to choose from. After a
resolution is selected, it will be used for all scans until you change it. The
resolution you should use depends on the type of image you are scanning and
the resolution of your printer. '

75dpi 150 dpi 300 dpi
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Line art or dithered scans for 300 dpi or less printers

The resolution you select should be the same as the resolution of your printer.
If the scan resolution does not match the printer resolution, then either the
Width and Height values in the Image Scan dialog box will be incorrect, or
your image will be rescaled before printing which may cause interference
patterns with dithered images.

If you have an HP LaserJet printer you should use 75, 150, or 300 dpi. The
following table shows the approximate image size and print quality for an 8 x
10 inch line art or dithered scan.

Scan 8 x 10 inch LaserJet
Resolution | Image Size | Image Quality

300 dpi 900 Kbytes | best

150 dpi 225 Kbytes | medium
75 dpi 56 Kbytes [low

Grayscale TIFF scans for 300 dpi or less printers

Grayscale files are usually printed with 53-line/inch halftone screens on 300-dpi
printers. A scan resolution of 75 dpi is usually best for this size of screen.
Doubling the resolution to 150 dpi may yield a slight image improvement at the
cost of quadrupling the file size and print time. The TIFF format insures that
the Width and Height values in the Image Scan dialog box will be correct even
though the scan resolution does not match the printer resolution. You do not
need to worry about interference patterns unless you are scanning a previously
halftoned or dithered image.

Line art scans for greater than 300 dpi printers or phototypesetters

Because the resolution of these printers is greater than the optical resolution of
the scanner, always scan line art with 300 dpi and 100% scaling for maximum
image quality. Even though the optical resolution of the scanner is 300 dpi,
you can create crisp, higher resolution images by reducing the image from
within your publishing application. If you are printing on a 1270 dpi Linotronic
printer and reduce your image by half, the printed resolution will be around
600 dpi. If you reduce your image to one quarter size, the printed resolution
will be around 1200 dpi. Interference patterns are not a problem with line art.
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Dithered scans for greater than 300 dpi printers or phototypesetters

The printer resolution should be a multiple of the scan resolution to avoid
interference patterns. Avoid rescaling a dithered image from your publishing
program. The maximum selectable scan resolutions are 1500 dpi for HP
ScanJet Plus scanner and 600 dpi for HP ScanJet scanner. See the following
table for examples of how to select a scan resolution if you are using a 635,
1270, or 2540 dpi Linotronic printer:

Divide Printer 2540 dpi printer 1270 dpi printer 635 dpi printer
Resolution | Scan dpi Max Size | Scan dpi Max Size | Scan dpi Max Size
1 **2540 n/a *1270 47% *635 94%
2 *1270 47% *635 94% 318 188%
3 *847 70% 423 141% 212 283%
4 *635 94% 318 188% 159 3717%
5 508 118% 254 236% 127 472%

**Too large for the HP ScanJet scanner or the HP ScanJet Plus scanner
* Too large for the HP ScanJet scanner

Whatever resolution you select, remember that maximum detail will be
achieved when the image is maximum size. Use grayscale instead of a dither
pattern when your publishing application supports grayscale TIFF files.
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Grayscale TIFF scans for greater than 300 dpi printers or phototypesetters

The scan resolution should be greater than or equal to the desired halftone
screen size in lines/inch times the square root of two. Use the following table

as a reference for selecting a grayscale resolution:

Desired Screen Minimum Scan 8x10 inch 8x10 inch
Size in lines Resolution 8-bit gray 4-bit gray
(dpi) Image Size Image Size

200 283 6.4 Mbytes 3.2 Mbytes

150 212 3.6 Mbytes 1.8 Mbytes

133 188 2.8 Mbytes 1.4 Mbytes

120 170 2.3 Mbytes 1.2 Mbytes

100 142 1.6 Mbytes 800 Kbytes

90 127 1.3Mbytes 650 Kbytes

80 113 1.0 Mbytes 510 Kbytes

60 85 580 Kbytes 290 Kbytes

Most newspaper photos are printed with 60 to 100-line screens. Most magazine

photos are printed with 120 or 133-line screens. High-quality brochures are
usually printed with 150-line screens.

To change the resolution:

1. Choose Resolution from the Settings menu.

2. Select one of the three resolutions.

3. Click OK.

The resolution that you use for scanning is displayed in the Image Scan dialog

box.
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To set a Custom Resolution:
1. Choose Resolution from the Settings menu.
2. Select Custom.
3. Use the scroll bars to set the horizontal and vertical resolutions.

4. Click OK.

Resolution Dialog Box

Reselutien

O 23 soi 358 ¢l

O 1360 do1 O tysten

Custon
HOR1ZONTAL: 3e@ dpi

12 13ee
YERTICAL: 200 dpi
12 154e@

‘ -Ld ' |Snn..l' olp

The Resolution dialog box provides three available resolutions and the ability
to customize the resolution for your printer.

Resolution Three resolutions are available: 75 dpi, 150 dpi, and 300 dpi.
When one of these resolutions is selected, the Custom scroll bar is not
available.

Custom For both horizontal and vertical settings the minimum resolution is
12 dpi and the maximum resolution is 1500 dpi.

If you are using the HP ScanlJet scanner (not the HP ScanJet Plus scanner),
the minimum resolution for both horizontal and vertical settings is 38 dpi and
the maximum resolution is 600 dpi.

The horizontal and vertical settings can be set independently of each other.
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Paper Size

The Paper size command defines the maximum dimensions of the paper that is
to be scanned during a Preview Scan, an Image Scan, or a Text Scan. If you
installed an automatic document feeder (ADF) on your scanner, you can scan
legal or 12-inch paper sizes. See “Using the ADF” in appendix D for more
information.

When you change the paper size after you Preview Scan an image, you must
rescan the image.

To choose a paper size:
1. Choose Paper Size from the Settings menu.
2. Select a paper size.

3. Click OK.

Paper Size Dialog Box

Paper 8ize
@US [etter Sixe (8.5 % 11 in))
O a4 (210 X 297 nm)

l ox ) ‘ﬁnncol' ( holn J

Paper Size When you select the paper size, it should match the dimensions of
the image that is to be scanned.

US Letter Size is the paper size that is available the first time you use Scanning
Gallery Plus.
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Specify Applications

This command is used to specify other applications that you would like to use
within Scanning Gallery Plus. You can add up to five applications. These
applications are available from the File menu.

When you run a windows application from Scanning Gallery Plus, the
applications window is brought to the front of the screen and becomes active.
You can size the window so you can also see the Scanning Gallery Plus window
in the background. This means you can switch between Scanning Gallery Plus
and the other application by clicking the window you want to work in.

When you run a non-windows application, the application fills the entire screen
and suspends the operation of Scanning Gallery Plus. When you exit from the
application, you return to Scanning Gallery Plus.

The Specify Applications command appears only if you have Microsoft
Windows 2.1 installed.

To add applications:
1. Choose Specify Applications from the Settings menu.

2. Type the path and name of the file to be executed in the Application
Path Name box.

3. Type in the Menu Command Label box the name that you want to
appear in the File menu.

4. Click Add.
To add more applications repeat steps 2 through 4.
5. Click Done.

Computer

- Museum
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Specify Applications Dialog Box

Speocify Appllcations

Application Path Name: E ]

Menu Command Label: [Application &1 ]
Menu Command Labels
4

Application Path Name This lists the path and name of the file to be
executed. For example, to add an application called “yourapp” you would
enter:

C:\WINDOWS\YOURAPP.EXE

Menu Command Label This lists the name you want to appear in the File
menu. For example:

Yourapp ...

When the name is entered in the File Menu it is preceded by Run and looks like
this:

Run Yourapp ...
You choose this command to run the application.

When the application path name and menu command label are entered, click
Add to add the application to the Menu Command Label list box.

4-28 Scanning Gallery Plus Reference



Menu Commands Label list box This is a list of applications you can run
from within Scanning Gallery Plus.

When you add a label to this box you can place an & in front of a desired
character. That character will be underlined when it is displayed in the File
menu. This is a direct-access method for choosing a command. With this
method you can select any of the menus on the menu bar by using the Alt key
with the underlined letter in the menu name. When the menu drops down from
the menu bar, press the letter that is underlined in the command’s name to
immediately start the command.

When the maximum number of applications (5) are listed in this box, the Add
button is grayed out and you cannot add another application.

To delete an application from this box, select the application you want to
delete and click Delete.
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Specify ReadRight OCR

This command allows you to specify the path and file name of your ReadRight
OCR executable file.

The command is available only if you have Microsoft Windows\286 and
ReadRight OCR installed. The Specify ReadRight OCR command does not
work with Microsoft Windows\386.

ReadRight must be purchased separately. It is not included with Scanning
Gallery Plus.

Refer to “Text Scan” in this chapter for using ReadRight OCR.

The ReadRight application provides the required PIF file on the application
disks. The file must be copied into your ReadRight OCR directory. The PIF
file uses the default directory of C:\OCR. If your ReadRight files are in a
directory other than \OCR, you will need to change the settings in the RR.PIF
file.

To specify ReadRight OCR:
1. Choose Specify ReadRight OCR from the Settings menu.

2. Type the ReadRight executable path and file name, RR.EXE, in the
Application Path Name box.

3. Click OK.
ReadRight cannot be run from the Windows MS-DOS Executive.
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Specify ReadRight OCR Dialog Box

fApplication Parh Name: [[(BNTAINTI

=D

Speoify ReadRightr OCR

Application Path Name When you enter the path and file name of the
ReadRight executable file and select OK, the Text Scan command appears in
the Scan menu. See “Text Scan” in this chapter for information about how to

use the command.
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Prompt

When you do a Preview Scan, the Prompt box appears to indicate what to do
next. If you don’t want it to appear, select it. Prompt works like a toggle, you
choose it to turn it off, or choose it again to turn it back on.

When the Prompt box is on, a checkmark appears next to the word Prompts.

To scan only a portion of vour
image, press vour mouse button
and drag to seleot an area.

Then use Image Soan.

Cx>) Gl
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Help Menu

The Help menu contains two commands: Help Index and Screen/Menu Help.

Help Index

The Help Index command presents an index of topics. When you select a topic
and click OK, the help information for that topic is presented. You can also
double-click a topic to display the help information for that topic.

Image Scanner - Help

Seleot a topio from the index or type

Mouse Terminology
Scanning an Image
Selecting a Command
About Help

About Scanner

Client Area

Close Scanner Window
Control Menu

Convert To

Screen/Menu Help

The Screen/Menu Help command gives you help on items that you see on your

display. When you select Screen/Menu Help, the pointer changes to a question

mark. You can move the pointer to an item such as a menu, a menu command,

or any part of the window (such as the Client area, Title Bar, or the Scroll

Bars). Notice that the top of the pointer must be on the item that you select.
Scanner

Socan Segtings Helo
Convert To...

Run Soangtest...
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To move the pointer with a mouse:

1. Move the mouse until the top of the pointer is on an item (the title bar,
for example).

2. Click to see the Help for what you selected.

The Help command provides Help for all the commands in the Scanner and
Image Editor windows. You can use Help from a window or a dialog box
associated with a window.

To choose Help on the Scanner window:
1. Click Help on the Scanner window.
2. Click Help Index.
You can also press the F1 key to get a list of Help topics.
The Help index for the Scanner window appears on your screen.
3. Click Convert To.
4. Click OK.

If there is more than one screen of information, click the down arrow
in the Scroll Bar (on the right of the Help screen) to read more Help
information.

5. Click Index to return to the Scanner window index.
To select another topic, repeat steps 3 and 4.
6. Click Done to return to the Scanner window.

If you are in the Help Index, click Cancel to return to the Scanner
window.
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The Image Editor Window

The Image Editor enables you to edit an image that you scanned. The image
can be one that you just scanned, or an image that you saved to a disk. You
can cut, clear, copy, and paste parts of an image or you can crop to keep a
selected portion of that image.

Image Editor
File Edit Scan View Settings Help

The following is a description of the menus, commands, and dialog boxes for
each of these selections in the order that they appear on the Image Editor
window.
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File Menu

The File menu is used to open, save, print, and convert your image files. You
can also run another image editor and use the Control Panel to install printers
and change control options in Windows.

Open

This command is used to retrieve a file that you want to edit, print, or view.
When you open a file the image is displayed in detail view.

To open a file:
1. Choose Open from the File menu.
2. Select a file name.
3. Click OK.

Open Dialog Box

Eile names ]

D \SCANGAL

=)

File name This box displays the name of the image file you want to use. You
can type the image file name or you can select a name from the list box.

File name list box You can select a name from the list of files. If the file is in
another drive, directories for the drive are displayed after you select the drive.
If you select the directory where the picture is, a list of TIFF files is displayed.

When the file name is not in view, use the arrows or the scroll bar to scroll
until you find the file name.

When you select an image file, the name is displayed in the File name box.
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Save

When you choose the Save command, the current image is saved to the current
file name and directory. When you make changes to an image, choosing the
Save command automatically saves it back to that file.

When you choose the Save command, the pointer changes to an hourglass.
When the image is saved, the hourglass changes back to a pointer.

To save an image:
1. Choose Save from the File menu.
Save As

You choose the Save As command to save the current image to a new file name
and/or directory.

To save to a new file name:
1. Choose Save As from the File menu.
2. Type a name for the image in the file name box.
3. Click OK.

Save As Dialog Box

ve file as: D3 \SCANGBAL

—]
( ['L3 ) (ianool' ( Help )

Save file as This box displays the name of the image you are currently saving.
When you want to save the image to a different directory, include the directory
path with the name.
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Print

When you want a printed copy of an image, you choose the Print command.
You can print the entire image or just a selected portion.

You can also go directly to the Print dialog box when you press the Ctrl and P
keys.

If you have not installed a printer, refer to “Adding and Removing Printers” in
appendix B for instructions.

To print an image:
1. Choose Print from the File menu.

2. Type the number of copies to print, if more than one, in the Number of
copies to print box.

3. Select a printer if more than one is in the Printer list box.
4. Click OK.
To print a selected area of an image:
1. Use the selection box to select an area to print.
2. Choose Print from the File menu.
3. Select Selected Area of Image box.
4. Click OK.
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Print Dialog Box

Print

Print Area
@ Ail of Image
O Selected Area of Iwage

Number of ooples to print |1 I
Printer

[ erayscale Draft Print
( Printer Settings... )
( Lancel ) ( Eo.ln )

Print Area Select A11 of Image to print the entire image. Select Selected
Area of Image to print part of an image.

Number of Copies to print Type the numbers of copies you want to print if
more than one.

Printer The printers you installed are displayed in this list box.

Grayscale Draft Print This applies only to grayscale images. When you
choose Grayscale Draft Print, the image is printed faster; however, it may be of
slightly lower quality.

Scanning Gallery Plus Reference 4-39



Printer Settings This opens the dialog box for the printer highlighted in the
Printer list box so you can change settings. If you are printing for the first
time, the printer may be installed with a default resolution that doesn’t match
your printer. For example, the default printer setting for the HP LaserJet
printer is 75 dpi. Be sure to change the setting to match the printer resolution.

HP Direct Print

The HP Direct Print command speeds up printing when used with the HP
printers listed in the Supported Configurations list in the front section of
this guide. Do not use HP Direct Print if you will be printing from Scanning
Gallery Plus and other Windows applications.

For information on the differences between Print and HP Direct Print, refer to
the following table.

Major Differences Between Print ... and HP Direct Print . ..

Action Print HP Direct Print
speed is slower than HP Direct is faster than Print
Print
image size can print images larger than |will print only one page of a
one page multi-page image
image position centers image on the page puts image in the upper left

corner of the page

resolution prints the proper size automatically picks the
image regardless of printer | printer resolution to be as
resolution close as possible to the

image resolution; will change
the size of the image if the
printer resolution doesn’t
match the image resolution

memory and disk space [requires more than HP requires less than Print
Direct Print
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HP Print Dialog Box

HP Direotr Print
Print firea
@ All of Insge
Q Seleoted Area of lmage

Number of oopies to prints E
Printer

O orayscale Oraft Print

@ (;nnaoll ( Heln )

Print Area Select A1l of Image to print the entire image. Select Selected
Area of Image to print part of an image.

Number of Copies to print Type the number of copies you want to print if
more than one.

Printer The printers you installed are listed in this list box.
Grayscale Draft Print Applies only to grayscale images. When you choose

Grayscale Draft Print, the image will be printed faster; however, it may be of
slightly lower quality.
Convert To

The Convert to command is used to convert your current image file to a
different file type. Currently, the other file types that you can convert to are
MSPaint, PC PaintBrush, GEM, and Encapsulated PostScript.

To convert an image file:
1. Choose Convert To from the File menu.
2. Select a file type from the Conversion list box.

3. Type the name for the converted file in the Convert To edit box.
4. Click OK.
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Convert To Dialog Box

PC Paintbrush(B & W)
PC Paintbrush(4 Clr)
:g"l’nlntbtush(lt Clir)

c t to
Flle namnes D \SCANGAL
|EVEL_msP ]

EPS

[JDelete original file

‘ L3 ' ( Lancel ] elp

Convert To This lists the name of the converted file. You can type this name
in the Convert To edit box.

Conversion This is the type of file you are converting to.

Run Image Editor

The Run Image Editor command allows you to open another Image Editor
window.

To open another Image Editor window:

1. Choose Run Image Editor from the File menu.

= [31%)
File Edit Scan View Sextings Nelp

Image Editor
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To size a window:

1. Click the left border of the window. The pointer becomes a two-headed

arrow.

2. Drag the border to the right until the window fills half the screen.

3. Release the mouse button.

Run Control

When you choose this command, the Control Panel opens and you can adjust

Microsoft Windows system settings. You can set the time and date, add

printers, change baud rates, and specify screen colors. For information about

the Control Panel see “Control Panel” in appendix B.

To run the Control Panel:

1. Choose Run Control ...

from the File menu.

Jo|

Image Editor - JUNGLE.VIF

,51 Edivr goan VYiew Segtings Help

Control Panel
Installation Setup Preferences

e

i ]

Cursor
Slow

Blink

|

2. Choose Close from the Control Panel Menu box to return to Scanning

Gallery.

Scanning Gallery Plus Reference 4-43



Run {application]

This command allows you to run other applications from within Scanning
Gallery Plus. To use this command, Microsoft Windows 2.1 must be installed.

The applications are set up in the Settings menu with the Specify Applications
command. See “Specify Applications” in this chapter to set up applications in
the File menu.

To run an application:
1. Choose Run [application] from the File menu.
About Image Editor

The About Image Editor box lists the application name, software version
number, and copyright information.

Scanning Gallery Plus
i Verslon A.93.00

@ Copyright Hewlett-Packard Co., 19886
Portions © Copyright Miorosoft Corporation,
19683-19688. All Rights Reserved.
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Edit Menu

Edit is used to edit the current image. You can cut, copy, and paste portions of
the image. You can discard unwanted portions of an image by cropping, and
you can clear the image from the Image Editor work area.

Undo/Redo

When you cut a portion of an image, then decide you really did not want to,
choose Undo to restore the cut portion. Undo works only immediately after a
procedure,

Redo reinstates the last action. For example, if you perform a cut, then chose
Undo to undo the cut, Redo would perform the cut operation again. You can
undo/redo one time for each procedure.

The Undo/Redo command also indicates the command that you use to edit

your image. For example, when you use the Cut command, Undo indicates
Undo—Cut (Redo—Cut).

To use the Undo command:

1. Perform a Cut, Crop, Clear, or Paste operation.

2. Choose Edit, then choose Undo to cancel the last action.
To use Redo:

1. Choose Redo to reinstate the action.

Cut

Use the Cut command to delete unwanted portions of an image. When used
with the Paste command, you can cut a portion of the image and paste it
into another area on the image or to a different image file. In effect, you have
moved part of the image from one location to another through the cut and
paste process.

The portion that you cut is moved to the Clipboard. It remains in the
Clipboard until you do another Cut or Copy procedure. The area that is cut
is replaced with the background color that you can choose from the Settings
menu. See “Background Color” in this chapter.
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To cut a portion from an image:
1. Use the selection box to select the area that you want to cut.
2. Choose Cut from the Edit menu.

The portion that you selected is cut from the image and placed on
the Clipboard. It is replaced by a background color selected with the
Background Color command in the Settings menu.

Clipboard

You use the Clipboard to hold information being copied or moved. You can
move or copy information from one place in a window to another. You can also
move or copy information from one window to another window.

When you use the Cut or Copy command, you put information on the
Clipboard. When you use the Paste command you insert the information
from the Clipboard into the image. You can paste the same information from
the Clipboard as many times as you want. The information remains on the
Clipboard until you do another Cut or Copy procedure.

Copy

The Copy command is used to copy portions of an image, then paste to
another area on the image or to a different image file. See “Paste ” in this
chapter. The Copy command works the same as the Cut command, except
that the area that you copy is left untouched.

To Copy a portion of an image:
1. Use the selection box to select the area that you want to copy.
2. Choose Copy from the Edit menu.
The selected area is copied and placed on the Clipboard.

Clear

The Clear command allows you to delete selected portions of an image without
putting the portion in the Clipboard.
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Paste

When you use the Cut or the Copy command, the image is placed on the
Clipboard. You insert from the Clipboard to your image with the Paste
command. There are two methods of pasting: paste to a point and paste to an
area.

When you paste to a point you can use the floating paste box to adjust the
image until it is in the exact position.

To paste to a point:

After doing a Cut or Copy procedure:
1. Point to the place where you want the image to be pasted and click.
2. Choose Paste from the Edit menu.

The image is pasted from the point where you clicked, starting from the
top left corner.

You cannot increase the size of an image; any portion of a pasted image
that falls outside the original image is deleted.

Floating paste box

When you paste an image from the Clipboard, the image area is surrounded
by a floating paste box. This box allows you to move the image until it is
positioned exactly where you want it. The image in the box disappears while
the box is moving and reappears when you release the mouse button.

When you don’t select a point before you choose Paste, the image in the
floating paste box appears in the center of the Image Editor window.

To move the floating paste box:
1. Move the pointer inside the box.
2. Drag the box.
3. Release the mouse button when the image is where you want it.
4. Click outside the box to anchor the pasted image area.

The area can also be anchored by executing a command in the File,
Edit or View menus, image scrolling, or sizing the window.

Scanning Gallery Plus Reference 4-47



To paste to an area:

1. Click at the corner of an area. Use the selection box to define the area
you want to paste to.

2. Choose Paste from the Edit menu.

The image is pasted into the area you defined with the selection box.
When you define an area to paste to, the image in the Clipboard is scaled so
that it will fit into that area. The proportions of the width to the height are
maintained.
Crop
The Crop command is used to discard unwanted portions of the current image.
To Crop an image:

1. Use the selection box to select the portion of the image that you want
to save.

2. Choose Crop from the Edit menu.

Only the area that you selected remains.

Select All

Choose the Select All command before editing the current image. The image
must be in full view before you use the Select All command.

To select all:
1. Make sure you are in full view.

2. Choose Select All from the Edit menu.
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Scan Menu
The Scan menu is used to open the Scanner window, or to move it to the front
if the Scanner window is behind another window.
Scanner
To open the Scanner Window:
1. Choose Scanner from the Scan menu.

The Scanner window is displayed in the position it was when you last
used it.
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View Menu

When an image is displayed in the Image Editor window, you can view it three
ways: Full View, Detailed View, and Specify Detail View.

View Description
Full View Displays the entire image.
Detail View Displays a closer view of a particular area on the

image. When an image is first displayed, it is
displayed in detail view.

Specify Detail View Displays an area you have specified to see in

detail.

To change the view:

1.

Choose Full View from the View menu.

Specify Detail View

The Specify Detail View command allows you to select any area on your image
to see in Detail View. When you select the Specify Detail View command, a
highlighted box appears on the Full View. You move this box around to select
an area that you want to see in Detail View.

To specify a detailed view:

1.

Choose Specify Detail View from the View menu.

2. Click inside the box.

3. Drag the box to the area you want to see.

4.

5. To display the view, either double-click in the highlighted box or use

Release the mouse button.

the Detail View command.
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Settings Menu

In the Settings menu you can choose to compress your image file, choose a
background color for the cut portion of an image, or choose the Auto Maximize
command. If Microsoft Windows 2.1 is installed, Specify Applications and
Specify ReadRight OCR are also available.

Compression

When you need to conserve space on your disk, you should choose the
Compression command. Compressing a file will conserve disk space;
however, the file will take a little longer to open than a file that has not been
compressed.

To determine if an image file has been compressed, look at Compression in
the Settings menu. When a checkmark is displayed next to Compression, the
image file is compressed.

Some applications are unable to accept compressed images (usually images that
have been scanned as Gray/Color); don’t compress images that you intend to
place in such applications. Refer to the manual for your application to verify
whether the application accepts compressed images.

If the open file is a grayscale file, compression is grayed out.
To Compress a file:
1. Choose Compression from the Settings menu.

When you select the Compression command, a checkmark is displayed next to
the word Compression. Each time you save an image it will be compressed.
When you don’t want to compress an image file, choose Compression again to
turn it off (the checkmark disappears).

When you want the image file compressed, select the Compression command
before you save your image.
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Background Color

This command allows you to choose black or white for the background color of
the area left blank by the Cut or Clear command.

You must choose the color before you use the Cut or Clear command.
To choose a Background Color:

1. Choose Background Color from the Settings menu.

2. Click a color.

3. Click OK.
Background Color Dialog Box

Background Color
Seleot the background color to use for out or olear:

®{hite)
O plack

( oK ) (ganoce1)

Auto Maximize

This command causes the Image Editor window to automatically fill the screen
when you select the Full View or Specify Detail View commands. When the
Image Editor window shares the screen with the Scanner window, choosing this
command causes the Image Editor window to take up the entire screen.

To use Auto Maximize:

1. Choose Auto Maximize from the Settings menu.
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Specify Applications

This command is used to specify other applications that you would like to use
within Scanning Gallery Plus. These applications are available from the File
menu. You can add up to five applications.

When you run a windows application from Scanning Gallery Plus, the
applications window is brought to the front of the screen and becomes active.
You can size the window so you can also see the Scanning Gallery Plus window
in the background. This means you can switch between Scanning Gallery Plus
and the other application by clicking on the window you want to work in.

When you run a non-windows application, the application fills the entire screen
and suspends the operation of Scanning Gallery Plus. When you exit from the
application, you return to Scanning Gallery Plus.

The Specify Applications command appears only if you have Microsoft
Windows 2.1 installed.

To add applications:
1. Choose Specify Applications from the Settings menu.

2. Type the path and name of the file to be executed in the Application
Path Name box.

3. Type the name that you want to appear in the File menu in the Menu
Command Label box.

4. Click Add.
5. Click Done.

Specify Applications Dialog Box

Speocify Applications

#l Application Path Mames E ]
il Benu Command Label: L._pp.l..l.olt.lon a1 |

Menuy Command Labeis
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Application Path Name This is the path and name of the file to be executed.
For example, to add an application you would enter:

C:\WINDOWS\YOURAPP .EXE

Menu Command Label This is the name you want to appear in the File
menu. For example:

Yourapp ...

When the name is entered in the File Menu it is preceded by Run and looks
like this:

Run Yourapp ...
You choose this command to run the application.

When the application path name and menu command label are entered, click
Add to add the application to the Menu Command Label list box.

Menu Command Labels list box This is a list of applications you can run
from within Scanning Gallery Plus.

When you add a label to this box you can place an & in front of a desired
character. That character will be underlined when it is displayed in the File
menu. This is a direct-access method for choosing a command. With this
method you can select any of the menus on the menu bar by using the Alt key
with the underlined letter in the menu name. When the menu drops down from
the menu bar, press the letter that is underlined in the command’s name to
immediately start the command.

When the maximum number of applications exist in this box, the Add button
is grayed out and you cannot add another application.

To delete an application from this box, select the application you want to
delete and click Delete.
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Using Scanning Gallery Plus with Other
Applications

As well as improving the looks and effectiveness of your documents, a scanner
can help make your office more efficient. To get the maximum benefit from
your HP ScanJet Plus scanner you’ll need to combine it with software packages
available in the marketplace. For example, your scanner can help you:

m Add scanned images to desktop published documents.

m Capture images that can be edited and enhanced with Paint
applications.

m Scan text and convert it to a file on your hard disk that you can read
with your word processor.

m Archive images in a hard disk library.

m Capture images of pages which you can send via telephone data lines to
destinations worldwide.

In this chapter, you’ll find suggestions and step-by-step instructions for using
the scanner and your existing computer system with popular software packages
to give you the solutions you need.

Because scanners have become an essential part of many graphics and
publishing solutions, the number of application packages that can use scanned
data has increased rapidly. As the capabilities of the application packages
improve with the scanning technology, new versions are introduced. Many
versions, especially older versions, have quirks and peculiarities that reduce
compatibility with other application packages.

To deal with every incompatibility would require a book, not a single chapter.
This chapter helps you use some popular application packages with the HP
ScanJet Plus scanner and deals with some typical situations. To solve problems
with packages not listed here, you will have to call or write the software
manufacturer.
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Desktop Publishing and Word Processing Applications

This section provides instructions for using page-composition and word
processing packages with the HP ScanJet Plus scanner.

Using Scanning Gallery Plus with WordPerfect

You'll find that WordPerfect, version 5.0, and Scanning Gallery Plus work
well together to merge a scanned black-and-white image (line art) with text.
However, if you are merging an image scanned with 8-bit grayscale, you’ll find
the results to be unsatisfactory.

To fix the problem, ask for an update from WordPerfect Corporation. Until a
new version of WordPerfect is released that can use 8-bit grayscale, choose a
dither pattern, not grayscale, in Scanning Gallery Plus.

To scan the image:
1. Determine the desired image size.
2. Run Scanning Gallery Plus.
Refer to chapters 3 and 4 if you need help.
3. Select the desired resolution under the Settings menu.

For line art or dither images, set the resolution equal to that of your
printer. If 8-bit grayscale scanning becomes supported, choose a
scanning resolution of 75 dpi for images that will be printed at 300 dpi.

4. Do a Preview Scan from the Scan menu.

If the image to be scanned is a photograph, be sure the Original
Includes Gray or Color box is selected in the Preview Scan dialog box.
Then, if you need to change dither patterns, click Change Gray ... and
select a new dither pattern.

5. Make a selection box around the area you wish to use in your
document.
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. Do an Image Scan from the Scan menu.

Adjust the scaling scroll bar to the desired image dimensions.

Record the dimensions of the scanned image from the height and width
fields.

. Click on Scan.

9. Exit the program or edit the image in the Image Editor.

After editing the image, save the image and exit the program.

To merge the image with the document:

1.

[

> o R @

Run WordPerfect 5.0.

. Place the cursor where you would like the top left corner of your image

to be placed.

. Press the Alt and F9 keys at the same time for graphics menu.

. Select 1 for Figure box.

Select 1 to Create.
Type the file name of the scanned image.

If the box size is different than the dimensions shown in Scanning
Gallery Plus, then you will need the update from WordPerfect even
for dithered images. Without the update, WordPerfect will scale your
dithered images, causing interference patterns in the printed output.

Additional Information

When printing documents with dithered images, select high quality graphics
on the printer command page.

Using With Other Applications 5-3



Using Scanning Gallery Plus with PageMaker

You'll get excellent results with PageMaker version 3.0 and Scanning Gallery
Plus when adding line art or photographs to a document. For photographs,
color images, and shaded images, scan with 8-bit grayscale for best results.

The steps below describe how to scan either a line art image or a photograph
using Scanning Gallery Plus and place it into a PageMaker document to be
printed on a 300 dpi printer.

To scan the image:

1.
2.

Run Scanning Gallery Plus.
Set the scanning resolution from the Settings menu.

For a line art or dither image, set the scanning resolution equal to
your printer resolution. If you want to create a grayscale file, select a
scanning resolution of 75 dpi.

. Do a Preview Scan from the Scan menu.

If the image to be scanned is a photograph, make sure the box next to
“Original Includes Gray or Color” in the Preview Scan dialog box is
checked. To change the grayscale or dither pattern, click on the Change
Gray ... button in the Preview Scan dialog box.

. Make a selection box that encloses the area of the picture you want to

use in your document.

. Do an Image Scan from the Scan menu.
. Adjust the desired image size with the scaling scroll bars.

. Click on Scan.

Record the file name for later use in PageMaker.

. Edit the image in the Image Editor, if you wish.

. Save the image and minimize Scanning Gallery Plus after editing

the image. (Refer to appendix B for help with Microsoft Windows
commands.)
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To merge the image with the document:

1.
2.
3.

Run PageMaker.
Open the document.
Select Place from the File menu in PageMaker.

Change the path in the Place File dialog box to the drive and directory
where the image file is saved. (If you chose the default, the file is in
C:\SCANGAL.)

. Select the image you scanned.

. Move the Place icon to the location in your document where the top left

corner of the image should appear and click the mouse button.

Keep the mouse in one place when you place the image, otherwise
PageMaker attempts to scale the image.

Additional Information

Here are some additional suggestions for using Scanning Gallery Plus with
PageMaker.

m An excellent way to use Scanning Gallery Plus with PageMaker is to

open only the Scanner window by clicking on SCANMAIN.EXE instead of
SCANGAL.EXE when starting Scanning Gallery Plus. Run PageMaker on
top of the Scanner window. When you want to scan an image, enable
the Scanner window and scan an image. Then, return to the PageMaker
window and place the image in your document.

For best results, scale dithered images in Scanning Gallery Plus, not
PageMaker. If you scale a dithered image with PageMaker, bands

or stripes may appear in the image, though that can be prevented if
you press and hold the Shift and Control keys down while scaling in
PageMaker, causing it to scale by factors. That means the image can
be scaled by multiples of the original image size, called “built-in sizes”
in the PageMaker User Manual. The image will snap to these built-in
sizes when the Shift and Control keys are held down.
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m Scan photographs with 4- or 8-bit grayscale, not a dither pattern, if
you are using a scanning resolution that does not match your printer
resolution. Otherwise, bands or stripes may appear in a scanned dither
image.

m Do not use Copy or Paste in the Scanning Gallery Image Editor
window to transfer images via the Clipboard to PageMaker. Using the
Clipboard may cause image quality to be reduced.

m When working with a photograph or an image containing shades of
gray, scan the image using 8-bit grayscale. Then scale the image in
PageMaker to fit the space available. However, if you want to scan with
a dither image rather than grayscale, scan the image to little larger
size than you will need for your PageMaker document. Then, place
the image in PageMaker, and crop it to fit exactly in the PageMaker
column. Cropping, unlike scaling, retains the image integrity.

m When using Scanning Gallery Plus, Microsoft Paint, and PageMaker in
combination, or Scanning Gallery Plus, PC PaintBrush, and PageMaker
together, you’ll need to do these additional steps after placing a PCX or
MSP image file into your PageMaker document:

1. Select the image using the Pointer tool.
2. Hold down the Control and Shift keys.

3. Point to one of corners of the image and depress the mouse
button.

A box should appear around the image.

4. Drag the mouse until the box is as small as possible. As you
move the box, it will snap to smaller boxes.

5. Release the mouse button when the box is as small as possible.
The size of the box now should be the same size as the image
you selected in Scanning Gallery Plus.

This procedure reverses the image enlargement that happens
when importing Microsoft Paint and PC PaintBrush files.
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Using Scanning Gallery Plus with Ventura Publisher

Ventura Publisher and Scanning Gallery Plus work well together to add
black-and-white images (line art) to a document. However, only Ventura
Publisher version 1.1 and later work well with scanned dither and grayscale
images. Even those versions may need a software update from Xerox
Corporation to work correctly. You can achieve the best results with Ventura
Publisher version 2.0 which uses scanned image files directly from Scanning
Gallery Plus in the TIFF image file format.

However, even with Ventura Publisher version 2.0, you may notice reduced
image quality with scanned grayscale images if you purchased an early version.
If 8-bit grayscale images appear dark and have a contoured appearance, you’ll
need an update from Ventura Publisher. If you need to scan in the mean time,
scan photographs and images containing gray using a dither pattern instead of
grayscale.

To prepare the document:

1. Run Ventura Publisher.

2. Load the text file.

3. Add new frames for your scanned images.

4. Record the frame dimensions.

You'll need to scan your images to those dimensions.

To scan the image:

1. Run Scanning Gallery Plus.

2. Select the desired scanning resolution.

If you are scanning using grayscale, 75 dpi provides good results for
images that will be printed at 300 dpi. If you are doing a dither or

line art scan, choose a scanning resolution that matches your printer
resolution. For more information refer to “Resolution” in chapter 4.
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3. Do a Preview Scan from the Scan menu.

If the image to be scanned is a photograph or contains gray, be sure
the Original Includes Gray or Color box is selected. Click on Change
Gray ... to select a different grayscale or dither pattern.

4. Make a selection box enclosing the area that you wish to scan.
5. Do an Image Scan.

a. Adjust the scaling scroll bars to the desired image dimensions
for the frames in Ventura Publisher.

b. Click Scan.

Record the file name of the image. If you are using an early
version of Ventura Publisher, convert from TIFF to GEM.

6. Edit the image in the Image Editor, if you want.
To merge the image with the document:

1. Run Ventura Publisher.

2. Enable Frame Setting.

3. Select Load Text/Picture ... under the File menu.

4. From the dialog box,
a. Select Image as the type of file.
b. Select TIFF (or, for early versions, GEM) as the format .

Select Several if you want to import more than one file.

c. Select OK.

5. Enter the drive and directory of your scanned images.

6. Select the files which you wish to import.

7. Place the images in their respective frames by:
a. Selecting a frame.

b. Selecting the file name of the scanned image that goes in the
frame.
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Additional Information

Ventura Publisher scales the image to fill the frame unless By Scale Factors
is selected in the Sizing & Scaling picture settings. When adding scanned

dither images to a document, make sure the By Scale Factors picture setting
is selected. Scanned grayscale and black-and-white files maintain good image

quality with any picture setting.
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Graphics Applications

This section has instructions for using Scanning Gallery Plus with some
popular paint programs.

Using Scanning Gallery with PC PaintBrush and Related Packages

The instructions in this section are intended for these versions of the
application packages:

m PC PaintBrush, Version 3.51

n PC PaintBrush Plus, Version 1.03

m PC PaintBrush for Microsoft Windows, Version 1.05
m Publisher’s PaintBrush, Version 1.52

The steps below describe how to scan an image with Scanning Gallery Plus and
edit it with one of the above PaintBrush programs from ZSoft Corporation.
When the name PaintBrush is used in this section, it refers to any of the above
application packages.

To scan the image:
1. Run Scanning Gallery Plus.
Refer to chapter 3 and 4 if you need help.
2. Set the scanning resolution.

Scanning at different resolutions will change the size of images printed
from PaintBrush.

3. Do a Preview Scan from the Scan menu.

If the image to be scanned is a photograph, make sure the Original
Includes Gray or Color box has been checked. Make sure a dither
pattern is selected if the image is a photograph.
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4. Make a selection box.
5. Adjust the image scaling to the desired value.

PaintBrush printed output will be different from the indicated image
dimensions in Scanning Gallery Plus unless the scanning resolution is
the same as the printing resolution.

6. Select Scan.

Record the file name of the scanned image.

7. Select Convert To from the File menu in the Editor window. There are
three PaintBrush file conversion programs available in the Conversion
dialog box:

» PC PaintBrush (B & W)
m PC PaintBrush (4-Clr)
s PC PaintBrush (16-Clr)

Select one of these converters. If you are using PC PaintBrush for
Microsoft Windows, use the PC PaintBrush (B & W) converter.
Otherwise, the converter you should use depends on how you installed
PaintBrush with the ZSoft PCINSTAL program.

If you want to find how PaintBrush is configured, run the PCINSTAL
program. The current PaintBrush configuration is displayed in the
PaintBrush System Install Menu. Make a note of your configured
display adapter type and press the Escape key to exit the program
without changing the current configuration.

8. Select OK to convert the file.
9. Exit from Scanning Gallery Plus and Microsoft Windows.

If you are using PC PaintBrush for Microsoft Windows, minimize
Scanning Gallery Plus instead of exiting the program.
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To edit the image:
1. Run PaintBrush from the DOS prompt.
2. Select Load from ... from the Page menu in PaintBrush.
If you are using PC PaintBrush for Microsoft Windows, select Open ..

3. Change the path in the Load from ... dialog box to the drive and
directory specified for your image file.

4. Select the scanned image from the list of files.

Additional Information

If you need to edit large images in PaintBrush and you do not want to
purchase more memory, read the next paragraphs.

PaintBrush can drive a multicolor display adapter as a black-and-white display
adapter to achieve increased image capacity. Therefore, if you have configured
PaintBrush for a multicolor display, you may want to reconfigure PaintBrush to
run only two colors when editing larger images.

For example, if PaintBrush is configured to run on IBM Enhanced Card High
Res 16-Color, reconfigure to IBM Enhanced Card High Res B/W. (Use the
PCINSTAL program.) That change allows you to load larger black-and-white
images into PaintBrush. This procedire works well for scanned images from
Scanning Gallery Plus because the file converter creates black-and-white
images.

The first time that you reconfigure PaintBrush, you may need to use your
ZSoft distribution diskettes. However, subsequent changes between the two
configurations may be performed quickly without your PaintBrush distribution
diskettes.
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Here are some other tips:

m Use a dither pattern rather than grayscale to scan images that will be
edited and printed in PaintBrush.

m The PaintBrush file format stores image dimensions only in pixels, not
in inches. Therefore, the size of the PaintBrush image will depend on
your printer resolution. For example, an image scanned at 150 dpi
in Scanning Gallery Plus will be half as wide and half as high when
printed by PaintBrush on a 300 dpi printer.

m If only a portion of an image is available after it has been loaded into
PaintBrush, then PaintBrush probably does not have enough memory
to load the image. This problem may be solved by installing more
memory in your computer or by using the suggested procedure for
gaining memory for large images suggested in the previous section.

m If you attempt to load an image into PaintBrush and many different
colors appear, then PaintBrush probably does not have enough memory
to load the image. This problem may be solved by installing more
memory in your computer or by using the suggestions for gaining
additional memory for large images given in the previous section.

m If your image is any color other than black-and-white, you probably
need to select a different file converter when converting your image from
TIF to PCX format. Check how PaintBrush has been set up with your
system by using the PCINSTAL program, and then reconvert with the
appropriate converter in Scanning Gallery Plus.

m If the message “Not a Valid Picture” appears when you are loading
the image file, use a different file converter on your image. Check your
PaintBrush configuration using the PCINSTAL program and reconvert
your image. Then try loading the image file again.

m PaintBrush and Scanning Gallery Plus work well together with dither
and line art image files, not grayscale files. When converting from TIF
to a PaintBrush format, Scanning Gallery Plus dithers grayscale images.
This step takes extra time and does not allow you to select the dither
pattern. If you intend to edit a scanned image with PaintBrush, scan
the file with a dither pattern or with the Image Include Gray or Color
box unchecked.
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Using Scanning Gallery Plus with Microsoft Paint

Because Microsoft Paint is a windows-based application, you can easily move
images from Scanning Gallery Plus to Microsoft Paint for editing. In fact,
using the Specify Application command in Scanning Gallery Plus, you can
launch Microsoft Paint from Scanning Gallery Plus. However, you can have
difficulties printing scanned images from Microsoft Paint.

To scan the image:
1. Run Scanning Gallery Plus.
2. Set the scanning resolution.
3. Do a Preview Scan from the Scan menu.

If the image to be scanned is a photograph, make sure the box next to
Original Includes Gray or Color in the Preview Scan dialog box has
been checked. Photographs should be scanned as dithered images.

4. Make a selection box.
5. Do an Image Scan from the Scan menu.
Scale the image with the scaling scroll bars.
6. Select Scan.
Record the file name of the scanned image.
7. Select Convert To from the File menu in the Editor window.
8. Select the MSP file format.
To edit the image:
1. Open the MSP file in Microsoft Paint.
2. Edit the file.
3. Save the edited file.
4

. To print the image, transfer the file to PageMaker or another
application package.
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Additional Information

m Microsoft Paint and Scanning Gallery Plus work well together with
dither and line art image files. When converting from TIF to MSP
format, Scanning Gallery Plus dithers grayscale images. This step
takes extra time and does not allow you to select the dither pattern. If
you intend to edit a scanned image with Microsoft Paint, scan the file
with a dither pattern or with the Original Includes Gray or Color box
unchecked.

m If you are editing an MSP file more than 300 Kb, you may have
problems scrolling and zooming in Microsoft Paint. Files of that size
when used in Microsoft Paint may even cause a system error requiring
you to restart your system.

m Do not use the Clipboard to transfer image files larger than 60Kb.

m When an image is printed from Microsoft Paint, it is stretched or
compressed to completely fill a printed page. This distorts the
width-to-height ratio of the image and causes interference patterns in
dither images. Avoid printing scanned images from Microsoft Paint.

Although scanned images do not print correctly from Microsoft Paint, you

can edit scanned images with Microsoft Paint, and then print them from an
application that supports the MSP file format, such as PageMaker. However,
scanned dither files need to be reduced in PageMaker to the smallest possible
size by scale factor before printing. For more information, refer to the
PageMaker section of this chapter, or refer to your publishing application user’s
manual.
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Optical Character Recognition (OCR) Applications

Developments in OCR technology are occurring rapidly. Call your dealer or
Hewlett-Packard sales office for information about which OCR packages are
available.

This section gives instructions for scanning text with Scanning Gallery Plus
and ReadRight OCR, and for adding the scanned text to a WordPerfect
document.

Using Scanning Gallery Plus and ReadRight With WordPerfect

The instructions below assume that you are using Scanning Gallery Plus with
Microsoft Windows, version 2.1 or later. That combination allows you to scan
text with the Scan Text command from the Scan Menu in Scanning Gallery
Plus. If you are using the run-time version of Microsoft Windows that is
included with Scanning Gallery Plus, you can use ReadRight in the standard
way suggested by the ReadRight user’s guide. Only versions of ReadRight later
than 1.30 can be integrated with Scanning Gallery Plus.

Although ReadRight can be launched by Scanning Gallery Plus, ReadRight
must be purchased separately.

To scan the text:
1. Select a sheet of paper with text on it.
Refer to the ReadRight manual for a list of supported fonts.
2. Run Scanning Gallery Plus.

3. If you have not yet specified the directory of your ReadRight files,
choose Specify ReadRight OCR from the scanner settings menu.

Refer to chapter 4 if you need help.

Enter the path where your ReadRight program can be found. This
information is preserved by Scanning Gallery Plus so you will not need
to specify it again.

4. Do a Preview Scan of your text page, choosing line art as the image
type.
The Original Includes Gray or Color box should not be checked.
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Make a selection box around the area of text that you want to scan.
Select Text Scan.

Choose ASCII DP.

Click Scan.

© ®©® 3 o o

Record the name of your text file.
To merge the text with a document in Word Perfect:
1. Run Word Perfect.

You can exit Microsoft Windows and run Word Perfect or run it as a
PIF file in Windows.

2. Choose List Files.

3. Type the name of the drive and directory where the scanned file is
saved.

4. Select this text file from the list of files displayed.
5. Open the file by selecting Retrieve.

Your text file should now be displayed. To correct any mistakes that were
made during the conversion process, use the WordPerfect Speller (CTRL+F2).
To check the spelling of the entire file choose Document. Any misspelled words
will be highlighted. A list of alternate spellings will be displayed or you may
edit the word yourself. If the word is correct, skip it or add it to the dictionary.

Refer to the WordPerfect user’s guide to make any changes to the format of
your document and to print it.

Additional Information

m If character recognition accuracy is poor (more than 2-3 errors per
page), try adjusting the intensity settings in Preview Scan. Adjust the
intensity by increments of 10% until you get to the desired setting. If
recognition remains poor, make sure that your document is positioned
squarely on the scanner copyboard glass. Also, refer to the ReadRight
manual to make sure that you are scanning a font that ReadRight can
convert.
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m If the documents that you wish to scan have multiple columns or
non-text areas within them, you may have to do several scans. Draw a
selection box around the first column or area of text. Do a Text Scan
with a new file name. Then draw a selection box around the next
column or area and do a Text Scan adding the new text to the previous
file name. Continue with this step until you are done.

m If you wish to scan the text of a multiple-page document with OCR
software, place all the pages in the Automatic Document Feeder. Use
the selection box to frame the area you want to scan on all the pages.
Select Scan A1l Pages in Document Feeder in the Text Scan dialog
box. All the pages will be appended to this file name.

Refer to the following list for assistance in selecting the best Word Processor
type for your application.

Word Processor Type Notes
ASCII WP This format inserts a hard return after each line.
ASCII DP This format inserts a hard return after each paragraph.

This option gives good results in most situations.

ASCITI WYSIWYG This option maintains the original format of the
document you scanned. Use this option for documents
that have tables and columns that you wish to preserve.

WORDSTAR This option will create a text file in the WordStar file
format. Often, ASCII DP provides better results for
importing a text file into WordStar.

WORDPERFECT This option will create a text file in the WordPerfect file
format. Often, ASCII DP provides better results for
importing a text file into WordPerfect.
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Here are two common error messages and instructions for solving the problems.

Error

Solution

Initial Directory Not
Found

Not Enough Memory
To Run

Modify your PIF file. Run PIFEDIT (found in the
Windows directory). Open the ReadRight PIF

file (RR.PIF). Make sure that the Program Name

and Initial Directory fields contain the path where
ReadRight can be found. For more information on PIF
files refer to your Windows manual.

ReadRight does not have enough memory to run
properly. Clear as much memory as possible by

exiting all memory resident programs and deleting any
unessential device drivers from your CONFIG.SYS file.
Restart your system and try Text Scan again. If you
have expanded memory, make sure that it is configured
so that Windows can use it most efficiently. See the
Microsoft Windows guide for more information.
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Finding Help

This appendix contains information intended to help you with common scanner
concerns and questions, such as:

m Running the Scantest program.

m Manually installing the scanner driver.

m Ordering replacement parts.

m Finding software packages to use with the scanner.
m Scanning Gallery Plus error messages.

Remember, if you cannot find the help you need here, check with your dealer or
Hewlett-Packard sales office where you purchased the scanner. If they cannot
help you, call the Customer Assistance number listed in the front of this guide.

Don’t forget to check the index for cross-referenced entries that may direct you
to the information or solution you need.
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Testing the Scanner

Use the Scantest program to verify that your scanner is working correctly. If
you get an error message during start-up or while trying to scan, run Scantest
to identify the problem. The test can be used to:

m Test the installation of the scanner in your computer system.

m Verify that the scanner is performing like new.

Starting Scantest

If you have Microsoft Windows 2.1, you can run the Scantest program directly
from Microsoft Windows without using Scanning Gallery Plus. Refer to the
section of chapter 2 “Testing Your Installation.”

If you are using a run-time version of Microsoft Windows, you can run the
Scantest program from the File Menu in the Scanner window in Scanning
Gallery Plus. If you installed only the Scantest program without Scanning
Gallery Plus and you do not have Microsoft Windows, follow these steps:

1. Type: C:\SCANTEST
2. Type: SCANTEST

===l SCANTEST

HP SCANNER TEST

Run Comprehensive Test ——- Tests the performance of the scanner.
This test takes about three minutes to run and requires the Test
Target which was shipped in an envelope in the back pocket of the
user's guide.

Run Minimal Test —— Runs a subset of the Comprehensive Test which
does not require the use of the Test Target.

Run ADF Test -- Tests the optional automatic document feedexr (ADF).
( Run Comprehensive Testg) (7 Run Minimal Test )
( Run ADF Test ) ( Exit )
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Running a Test

The Scantest program has three different tests:
# Run Comprehensive Test
m Run Minimal Test
s Run ADF Test

In most instances, you should choose the comprehensive test because it does
the best job of testing the scanner. If you run the comprehensive test, you'll
need to use the Test Target in the back pocket of this user’s guide. When
removing the Test Target from the protective envelope, carefully handle the
Test Target by the edges because if fingerprints are scanned from the Test
Target during the test scan, inaccurate information will be sent to the test
program.

Also, be sure to put the Test Target back in the protective envelope when you
are done using it. If you should lose the target, you can run the minimal test

instead of the comprehensive test to determine if the scanner is performing as
it should.

The ADF test is designed to test an automatic document feeder, if you have
one attached to the scanner.

If the Scantest program detects a failure in the scanner, refer to appendix C,
“Maintenance, Warranty and Specifications.”
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Problems or Questions?

See the following table to find suggestions for solving some typical problems

and questions.

Problem
or
Question

Suggestion

How do I change my CONFIG.SYS file
manually and not use the installation
program to install the scanner driver?

Refer to “Manual Installation of the
Scanner Driver” in this appendix.

I think my scanner has failed, or, I think
the quality of my scanned images has
deteriorated. How can I test my scanner?

Refer to “Testing the Scanner” in this
appendix.

Where can I find more information about
the run-time Windows features?

Refer to “Using the Control Panel” in
appendix B.

What if paper jams the automatic
document feeder or I have other
problems with the ADF?

Refer to “Installing the Automatic
Document Feeder” in appendix D.

How can I change the color of my
Scanning Gallery Plus screen?

Refer to appendix B.

Where can I learn about OCR software?

Refer to “Finding Software Packages”
in this appendix. If you are interested
in using ReadRight OCR, refer to the
index for page numbers that discuss
using ReadRight and the HP ScanJet
Plus scanner.

How can I use the scanner with my
desktop publishing software package?

Refer to chapter 5.
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Problem
or
Question

Suggestion

How can I let Hewlett-Packard know
about my suggestions and comments?

Use the reader comment card at the back
of this guide to send your suggestions
and comments. Your suggestions are
appreciated.

I need to replace an ADF Mylar guide.

Refer to appendix D.

The installation program indicates
that I do not have any addresses in
my computer system available for the
scanner. What should I do?

You’ll have to remove a device from your
computer system to make room for the
scanner.

The installation program did not
recommend any switch settings.

Either the installation program has
failed or you have installed the interface
card prior to running the installation
program. (Remove the card and run the
installation program again.)

After installing the interface card, my
computer (or one of my peripheral
devices) does not work.

It is possible that you have an addressing
conflict with the scanner. Set the
interface switches to the setting
recommended by the installation
program. You may need to remove the
interface card and run the installation
program again.

The Scantest program indicates that I
have a problem with my scanner. What
should I do?

Refer to appendix C to find the warranty
and service information that you need. If
the problem is a broken lamp or other
easily replaceable part, instructions for
replacing it are in this user’s guide.

I would like to learn about
Hewlett-Packard maintenance and service
prograrms.

Refer to appendix C.
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Manual Installation of the Scanner Driver

Using the installation program is the easiest way to install the scanner software
on your system. However, if you have a special configuration, you may want to
manually install the software to ensure the CONFIG.SYS file remains the way
you want it.

To manually install the driver:
1. Copy your current CONFIG.SYS to another file, such as CONFIG.SAV.
2. Using a text editor, add the following lines to your CONFIG.SYS file:

DEVICE=SJDRIVER.SYS
BUFFERS=20
FILES=99

3. Resave your CONFIG.SYS file.
4. Insert the ScanJet Plus Installation Disk into Drive A.

5. Copy the SJDRIVER.SYS file from the ScanJet Plus Installation Disk
to the root directory of Drive C.

You can also manually install the Scanning Gallery Plus files, however, you
cannot copy the run-time version of Windows required to make it run. If you
have Microsoft Windows version 2.1, the option remains.

To copy the Scanning Gallery Plus files:

1. Create a subdirectory on your hard disk for the Scanning Gallery Plus
files.

2. Insert the ScanJet Plus Installation Disk in Drive A.
3. From the subdirectory on the hard disk that you just created, type:
COPY A:*x.*

You will also have to add the information from the CONVERT.TXT file to the
WIN.INI file.
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Ordering Replacement Items

Although some of the items below can be ordered only by your dealer or
Hewlett-Packard service representative, the items are listed here to help you

in obtaining them. Order items for your system by contacting your sales
representative or the Hewlett-Packard dealer where you purchased the scanner.

Description HP Part Number
ScanJet Plus User’s Guide 88295-90199
Interface Kit for Vectra and IBM XT\AT 88295A
Computers
Interface cable 5180-0010
Automatic document feeder 88195A
Mylar guide 5180-0024

Power cord*

See footnote *

Test Target 09195-87799
Lamp Access Door 5180-0029
Scanner lamp 5180-0023
Scanner copyboard cover 5180-0028

* Power cord numbers are dependent on your location. Please consult your

sales representative if you need to order a power cord.

If your question is not answered in this user’s guide, you may get assistance
from your dealer, Hewlett-Packard, or your own organization. Appendix C
contains a list of Hewlett-Packard worldwide sales and support offices.
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Finding Software Packages for the Scanner

New software packages are being developed and will be introduced by software
companies after this user’s guide has been printed. Check with your sales

representative to find which packages are available today.

Software
Packages Description Address
PageMaker PageMaker desktop publishing software Aldus Corp.
V1.0- integrates text and graphics, allowing PC 411 First Ave. South
V-3.0 users to design, edit, and produce high-quality, Suite 200
printed communications in an office setting. Seattle, WA 98104
(206) 622-5500
Lotus Manuscript is an advanced word processing Lotus Development
Manuscript program that has all the advantages of Corp.
Release 2  full-featured word processors with the design 55 Cambridge Parkway
and typesetting capabilities of desktop Cambridge, MA 02142
publishing programs. (617) 577-8500
Ventura Ventura Publisher is a professional page-layout Ventura Software Inc.
Publisher system that lets you combine text with images. 675 Jarvis Dr., Suite C
Images can be scanned and merged with text =~ Morgan Hill, CA 95037
on the composed page. (408) 779-5000
LePrint LePrint is a typesetting publishing package LeBaugh Software
3.0 that offers a range of type styles with sizes 10824 Saw Mill Road
from two points to over ten inches tall. It Omaha, NE 68154
accepts scanned images from the HP ScanJet  (402) 334-4820
Plus scanner.
GEM GEM Desktop Publisher is an icon-based, Digital Research
Desktop  WYSIWYG, menu-driven, page-layout 60 Garden Court
Publisher program. It imports text and graphics from a  Monterey, CA 93942
V1.0 variety of word-processing packages. It runs (408) 646-6464
under the GEM operating environment.
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Software

Packages Description Address
GemScan GemScan allows the integration of scanned Digital Research
images into text and graphics created under 60 Garden Court
the GEM collection software. GemScan scans a Monterey, CA 93942
selected image and formats it. (408) 646-6464
WordPer- WordPerfect is an advanced WSYWIG WordPerfect Corp.

fect 5.0 word processing package. Version 5.0 allows 1555 North Technology
scanned images to be incorporated within your Way

document. In addition, scanned images can Orem, UT 84057
be scaled, moved, and rotated to meet your (801) 225-5000
specifications.
Polaris Polaris Labelmaker creates any style or size Polaris Software
Label- label printable by a LaserJet printer. TIFF 613 West Valley
maker scanned images can also be imported. Parkway, Suite 323
V2.0 Escondido, CA 92025
(619) 743-7800
Polaris Printmerge is a general purpose formatting Polaris Software
Print- program. Text created from a wide range of 613 West Valley
merge word processing packages can be formatted Parkway, Suite 323
V3.10 using Printmerge commands. Scanned images  Escondido, CA 92025
can also be merged with the text. (619) 743-7800
First First Publisher is a desktop publishing Software Publishing

Publisher package that allows users to merge text and Corp., P.O. Box 7210
1.0, 2.0 graphics. Text may be imported directly from 1901 Landings Drive

word processing packages or created in First Mountain View, CA
Publisher. (415) 962-8910
ScanPro  ScanPro is a scanning and vectorizing utility American Small
that scans images and then converts them into  Business Computers
either AutoCAD DXF or PRODESIGN IP 118 South Mill St.
formats. Pryor, OK 74361

(918) 825-4844

FormScan FormScan can scan forms, edit them, and GDI
merge information from data base applications. 20-C Pimentel Ct.
Novato, CA 94947
(415) 382-6600
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Software
Packages

Description

Address

Pageview

Pageview is a page preview and graphics
integration program for Microsoft Word.
Images can be scanned, saved on the
Clipboard, and incorporated into documents.

Microsoft Corporation
16011 NE 36th Way
P.O. Box 97017
Redmond, WA 98073
(206) 882-8089

COPYCAT COPYCAT combines the HP ScanJet Plus and

HP LaserJet into an intelligent copy machine.
Binary as well as dither modes can be printed
from a variety of resolutions.

Janus Associates
46 Chestnut St.
Boston, MA 02108
(617) 720-5085

recognition capable of converting typewritten,
typeset, laser, and dot-matrix printing into
formats for word processors, spreadsheets,
desktop publishing packages, and database
applications.

Halo Halo is a graphics programming kit that allows Media Cybernetics
v2.27 users to create graphic images on a PC. Halo 8484 Georgia Ave

is written in assembler language and supports  Suite 200

over 15 high-level programming languages. It  Silver Spring, MD

provides programmers access to a library of 20910

over 190 graphic subroutines. (301) 495-3305
Polaris Polaris RAM Resident Printmerge is a Polaris Software
RAM RAM-resident utility that can add TIFF 613 West Valley
Resident  images created by the ScanJet Plus Scanner Parkway
Print- to documents. Extensive page-formatting Suite 323
merge functions are also included. Escondido, CA 92025
V2.10 (619) 743-7800
Polaris ScanControl is a RAM-resident utility that Polaris Software
Scan- controls the ScanJet Plus Scanner directly 613 West Valley
Control from a pop-up menu. ScanControl can be Parkway Suite 323
V1.0 invoked from inside word processing programs, Escondido, CA 92025

allowing images to be scanned and later placed (619) 743-7800

in documents.
TrueScan TrueScan provides complete document Calera Recognition

Systems

2500 Augustine Drive
Santa Clara, CA 95054
(800) 544-7051
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Software

Packages Description Address

ReadRight ReadRight allows users to convert a scanned OCR Systems
image of alphanumeric characters into a Contact Local
computer-readable format (ASCII, for Hewlett-Packard
example). Sales Office

Halo DPE Halo DPE Publishing Edition allows the Media Cybernetics Inc.

Publishing merging of image and ASCII text in a 8484 Georgia Ave

Edition single document. Text can be created with Suite 200
word-processing applications and merged into  Silver Spring, MD 20919
the software through the use of icon menus. (301) 495-3305

PC Paint- PC PaintBrush+ is designed for the user who  Z-Soft

Brush+ does not need the full support of a desktop 450 Franklin Road
publishing solution. It supports scanned images Suite 100
such as logos and diagrams, and allows the Marietta, GA 30067
merging of graphic art with text. (404) 428-0008

Publisher’s Publisher’s PaintBrush is a paint package Z-Soft

Paint- designed for desktop publishing. You can 450 Franklin Road

Brush produce pictures of high resolution. It Suite 100
allows scanned images such as art, logos, Marietta, GA 30067
and diagrams to be merged with text into a (404) 428-0008
composed page.

GammaFax GammaFax is a menu driven facsimile GammalLink

4.0 package with extensive logging features. 2542 Embarcadero Way
ASCII-to-ASKII file transfer and a CAD-FAX  Palo Alto, CA 94303
option are available. GammaFax runs in (415) 856-7421
background mode at 9600 baud.

Polaris Polaris Pack Rat is a personal information Polaris Software

Pack Rat management program that runs under 613 West Valley

Microsoft Windows. Text and scanned images

can be combined to produce custom databases.

Parkway Suite 323
Escondido, CA 92025
(619) 743-7800
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Scanning Gallery Plus Error Messages

The error messages for Scanning Gallery Plus are divided into two parts: the
Scanner window messages and the Image Editor window messages.

image Editor Error Messages

# Message

Cause

Remedy

106 Cannot paste in Full View.

107 Cannot open the Clipboard.

108 Cannot paste from the
Clipboard.

109 Image has been corrupted.
112 Unable to complete the

editing function.

120 No Converters were found.

121 Could not convert the file.

201 Could not open image file.
File not found.

Attempting to paste
while in Full View.
Paste data is not from
Scanning Gallery Plus.

A Windows problem
prevents the Windows
Clipboard from being
accessed.

The paste operation
cannot succeed because
data was lost.

The editing operation
was partially completed

when an error occurred.

Not enough memory to
finish editing.

The converter files are
not present.

Not enough memory to
convert the file.

This file does not exist.

When pasting data from
another source, use
Detail View.

Close Scanning Gallery
Plus and Microsoft
Windows, then open
them again.

Try the Cut or Copy
and paste procedure
again.

If other windows, dialog
boxes, or applications
are open, close them.

If other windows, dialog
boxes, or applications
are open, close them.

Re-install Scanning
Gallery Plus. See this
guide for instructions.

If other windows, dialog
boxes, or applications
are open, close them.

Check the name of the
image file you are trying
to open.
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# Message

Cause

Remedy

202 Could not open image file.

File is not a TIFF file.

203 Could not open image file.
File is an unsupported TIFF

file.

204 Not enough memory to
complete the operation.

208 Incorrect file name.

209 Can not open Scanner
window.

210 Can not open the Control

Panel.

211 A temporary work file has

been deleted.
214 Not enough disk space

on drive to complete the

operation.

215 Too many files open.

The file you opened is
not a TIFF file.

The TIFF file you tried
to open was made by
another application and
Scanning Gallery Plus
cannot read this file.

There was not enough
memory to complete
this operation.

The file name you
entered is not a valid
MS-DOS file name.

Not enough memory
to open the Scanner
window.

Not enough memory to
open the Control Panel.

A work file in the temp
directory was deleted.

There was not enough
disk space to complete
the operation.

Too many files are open
at the same time.

Select a TIFF file.

Select a file in the
supported TIFF file
format.

If other windows, dialog
boxes, or applications
are open, close them.

Type the correct file
name.

If other windows, dialog
boxes, or applications
are open, close them.
Then, try opening the
Scanner window again.

If other windows, dialog
boxes, or applications
are open, close them.
Then, try opening the
Control Panel again.

Open the image file
again.

Delete any unnecessary
files to increase disk
space.

Close other files, dialog
boxes, or applications.

Computer

 Museum
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# Message

Cause

Remedy

216 Could not find library,
RGLIB.RGL.

217 Corrupted library file,
RGLIB.RGL.

218 No printer selected.

219 Printer does not support
raster graphies.

222 Printer not installed.

223 Error opening printer device
driver.

224 Unable to set up cancel box.

The image library file,
RGLIB.RGL does not
exist.

The image library file,
RGLIB.RGL has been
corrupted.

A printer in the Print
dialog box was not
selected.

The printer you have
selected can not print
raster images.

No printers have been
installed.

The driver program for
the selected printer
could not be loaded.

An error prevented
Scanning Gallery Plus
from creating a cancel
box.

Reinstall Scanning
Gallery Plus. See the
ScanJet Plus User’s
Guide for installation
instructions.

Reinstall Scanning
Gallery Plus. See the
ScanJet Plus User’s
Guide for installation
instructions.

Select a printer in the
Print dialog box. If a
printer is not listed, see
“Adding and Removing
Printers” in appendix
B in the ScanJet Plus
User’s Guide.

Select a printer that can
print raster images.

To install a printer, see
“Adding and Removing
Printers” in appendix
B in the ScanJet Plus
User’s Guide.

You must reinstall the
printer. To install a
printer, see “Adding
and Removing Printers”
in appendix B in the
ScanJet Plus User’s
Guide.

Close Scanning Gallery
Plus and open it again.
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# Message

Cause

Remedy

225 Print failed.

226 Incorrect number of copies
requested.

228 Incorrect path name.

231 Cannot open another Image
Editor.

232 Incorrect drive entered.

233 Cannot create file in (file
name).

234 Cannot write the file to
disk.

235 Cannot compress the image
file.

236 Cannot uncompress the
image file.

An error occurred while
the image was being
printed.

An incorrect number of
coples was entered in
the the Copies box.

The file name you

entered is not an
MS-DOS file.

Not enough memory to
open another Image
Editor.

The drive you entered
is incorrect or does not
exist.

The directory you
entered does not exist.

Not enough disk space.

You may be out of disk
space.

There may be a problem
with your disk.

An error prevented
compressing the image.

An error prevented
compressing the image.

Check printer
connections or check if
printer is out of paper.

Enter a number from
one or greater in the
Copies box.

Type the correct file
name and path name.

If other windows, dialog
boxes, or applications
are open, close them.
Then, try opening the
Image Editor again.

Type the correct drive.

Type the correct
directory name.

Delete any unnecessary
files to increase disk
space.

Delete any unnecessary
files to increase disk
space.

Check the disk that you
are trying to write to.

Do not save the image
compressed.

This file cannot be
uncompressed by
Scanning Gallery Plus
and cannot be opened.
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# Message

Cause

Remedy

237 Cannot print in landscape
orientation.

238 Corrupted converter file.

239 File size could not be
reduced. Compression
ended.

240 Cannot uncompress file.
Unknown compression
method.

242 Not enough disk space to
complete the operation.

252 Specify Applications dialog
box could not be opened.

253 Unable to add application
information.

The selected printer has
been set to landscape
orientation, but does
not support this
orientation for printing
graphics.

A converter file has
been corrupted.

The image can not be
made smaller.

The image has been
compressed by a
compression method not
recognized by Scanning
Gallery Plus.

Not enough disk space
available.

Not enough memory to
open the dialog box.

An error prevented
Scanning Gallery Plus
from adding the user
specified application
information.

Open the Printer
Settings dialog box for
the selected printer and
change the orientation
to portrait.

Reinstall Scanning
Gallery Plus. See the
ScanJet Plus User’s
Guide for installation
instructions.

Uncompress the image
before you open it in
Scanning Gallery Plus.

Delete any unnecessary
files to increase disk
space,

If other windows, dialog
boxes, or applications
are open, close them.
Then, try opening the
dialog box again.

Try the command again.
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# Message

Cause

Remedy

254 Specify Applications dialog

box contains incorrect

information and will be

closed.

255 File not found.

257 Unable to delete application

information.

258 File name not entered.

259 Inactive Specify

Applications dialog box

could not be changed.

260 Menu Command Label can

not be blank.

261 Application could not be

opened.

Information was
changed in the dialog
box without being saved
to disk. The dialog box
must be closed.

The file name you
entered cannot be found
by Scanning Gallery
Plus.

An error prevented
Scanning Gallery Plus
from deleting the user
specified application
information.

A file name was not
entered.

More than one Specify
Applications dialog is
open. When you change
information in one, the
other dialog box can not
be changed.

You tried to add
application information
with a blank menu
command label.

The application you
selected could not be

" opened.

Delete any unnecessary
files to increase disk
space. Then reopen the
dialog box.

Type the correct file
name.

Try the command again.

Type in the file name.

Close a dialog box so
that only one is open.
It is recommended

that only one Specify
Applications dialog box
be open.

Enter a menu command
label in the Specify
Applications dialog box.

Check the Specify
Applications dialog box
to see if the executable
file still exists.

If other windows, dialog
boxes, or applications
are open, close them.
Then, try selecting the
application again.
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Scanner Window Error Messages

# Message Cause Remedy
601 Using default scanner The Scanner windows
values. opened with default

dialog box settings.

602 Will write over existing file. The file you are saving
to exists and will be
written over.

603 Grayscale compression not  Scanning Gallery Plus
supported. cannot compress a
grayscale image.

604 Scanner must be installed to The scanner is not Install your scanner.
change paper size. installed. See the ScanJet Plus
User’s Guide for
installation instructions.

605 Scanner must be on to The scanner is not Turn on the scanner. If
change paper size. turned on. it does not go on, check
the power connections.

606 Using default scanner values A new scanner was
for settings not compatible installed that is not
with current scanner. compatible with the

selections for the old
scanner.

607 Proportional Scaling can Because of the current

not be selected under the vertical and horizontal
current width and height resolution, the width
settings. and height scale

ranges will not permit
proportional scaling.

610 File does not exist. Create  The file name you Choose OK if you want
i? entered does not exist.  Scanning Gallery Plus
to create it for you.

611 Using default format and The file, RRINFO.DAT Reinstall Scanning

language settings. does not exist, or is Gallery Plus. See the
corrupted. ScanJet Plus User’s
Guide for installation
instructions.
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# Message

Cause

Remedy

612 Scan paper in the
Automatic Document
Feeder.

701 Scanner driver not installed.

702 Scanner device not
responding.

703 Not enough disk space to
complete the operation.

704 Not enough memory to
complete the operation.

705 Incorrect file name.

710 Could not find library,
RGLIB.RGL.

Paper is in the
Automatic Document
Feeder, but the Scan All
Pages in Document
Feeder box was not
selected.

The device driver for
the scanner is not
installed.

The scanner device is
off.

The scanner is not
connected.

The scanner has a
hardware problem.

Not enough disk space
available.

There was not enough
memory to complete
this operation.

The file name you
entered is not a valid

MS-DOS file name.

The image library file,
RGLIB.RGL does not
exist.

Select the Scan All
Pages in Document
Feeder box from the
Text Scan dialog box.

Reinstall Scanning
Gallery Plus. See the
ScanJet Plus User’s
Guide for installation
instructions.

Turn on the scanner.

Check the scanner
connections.

Choose “Run
Scantest..” from the
File menu in the
Scanner Window.
Refer to “Testing Your
Installation” in chapter
2.

Delete any unnecessary
files to increase disk
space.

If other windows, dialog
boxes, or applications
are open, close them.
Then, try it again.

Type the correct file
name.

Re-install Scanning
Gallery Plus. Refer to
the ScanJet Plus User’s
Guide.
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# Message

Cause

Remedy

711 Corrupted lLibrary file,
RGLIB.RGL.

719 File size could not be
reduced. Compression
terminated.

721 The Scanner window is
already open.

722 The Automatic Document
Feeder (ADF) is not ready.

723 Could not load the
converter.

724 Could not convert the file.

729 Incorrect Path Name.

730 Preview scan file deleted.
Do another preview scan.

714 No file converters installed.

The image library file,
RGLIB.RGL has been
corrupted.

The converter files are
not present.

The image can not be
made smaller.

The Scanner window
was already open when
you tried to open it.

The Automatic
Document Feeder is not
ready for the scanning
process to begin.

Not enough memory to
load the converter file.

Not enough memory to
convert the file.

The file name you
entered is not an

MS-DOS file.

The temporary preview

scan image file has been
deleted.

Reinstall Scanning
Gallery Plus. See the
ScanJet Plus User’s
Guide for installation
instructions.

Reinstall Scanning
Gallery Plus. See the
ScanJet Plus User’s
Guide for installation
instructions.

Make sure that the
Automatic Document
Feeder is on and
properly connected.

If other windows, dialog
boxes, or applications
are open, close them.
Then, try the process
again.

If other windows, dialog
boxes, or applications
are open, close them.
Then try the convert
process again.

Type the correct file
name and path name.

Do another preview
scan.
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# Message

Cause

Remedy

731 Cannot find executable
application file.

732 File name not entered.

734 Cannot write to file.

736 Specify Applications dialog
box could not be opened.

737 Unable to add application
information.

738 Specify Applications dialog
box contains incorrect
information and will be
closed.

739 File not found.

741 Unable to delete application
information.

The application path
name originally specified
for the ReadRight
program is no longer
valid.

A file name was not
entered.

The disk you are writing
to is write protected.

Not enough memory to
open the dialog box.

An error prevented
Scanning Gallery Plus
from adding the user
specified application
information.

Information was
changed in the dialog
box without being saved
to disk. The dialog box
must be closed.

The file name you
entered cannot be found
by Scanning Gallery
Plus.

An error prevented
Scanning Gallery Plus
from deleting the user
specified application
information.

Use Specify ReadRight
OCR dialog box to
enter the application
path name.

Type in the file name.

Write to a disk that is
not write-protected.

If other windows, dialog
boxes, or applications
are open, close them.
Then try opening the
dialog box again.

Try the command again.

Delete any unnecessary
files to increase disk
space. Then reopen the
dialog box.

Type the correct file
name.

Try the command again.
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# Message

Cause

Remedy

742 File name not entered.

743 Inactive Specify
Applications dialog box
could not be changed.

744 Menu Command Label can
not be blank.

745 Application could not be
opened.

746 Unable to find
RRINFO.DAT file.

747 Could not open Scantest
application.

A file name was not
entered.

More than one Specify
Applications dialog is
open. When you change
information in one, the
other dialog box can not
be changed.

You have tried to add
application information
with a blank menu
command label.

The application you
selected could not be
opened.

The directory
containing your
RR.EXE file does
not contain the
RRINFO.DLAT file
which provides
information to run
ReadRight.

Not enough memory
to run the Scantest
program.

Type in the file name.

Close a dialog box so
that only one is open.
It is recommended

that only one Specify
Applications dialog box
be open.

Enter a menu command
label in the Specify
Applications dialog box.

Check the Specify
Applications dialog box
to see if the executable
file still exists.

If other windows, dialog
boxes, or applications
are open, close them.
Then, try selecting the
application again.

Make sure that the
RRINFO.DAT file exists
in the same directory as
the executable file which
you have specified.

If other windows, dialog
boxes, or applications
are open, close them.
Then, try the process
again.
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Learning Microsoft Windows and the
Keyboard

If you have never used Microsoft Windows before, terms like command menus,
dialog boxes, and icons will not be familiar to you. In the following exercises
you will use a mouse with Microsoft Windows, and also learn some of the
terminology.

Computer

~Museym
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Control Menu

The Control Menu commands are common to all Window applications. If a
command is grayed out (displayed in a lighter type) it cannot be used with the
current window.

Image Editor - JUNGLE.TIF
ARLCHF5  |w Segtings
AlLt+F?

Alt+F10

ALc+F4

To use a Control Menu command:
1. Click the Control Menu box.

2. Click a command.

Size

The sizes of most windows can be changed. For Scanning Gallery Plus, only
the Image Editor window size can be changed.

To change the size of the Image Editor window:
1. Choose Size from the Control Menu box.

2. Drag the four-headed arrow to the left window border. It changes to a
two-headed arrow.

3. With the two-headed arrow on the border, drag the window to change
its size.

4. Release the mouse button when the window is the desired size.
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Move

The Move command lets you move a window to another position on the screen.
When you finish using the Scanner or the Image Editor window, you can move
it out of the way by closing it (see “Close” in this chapter) or by using the
Move command.

To move the Scanner window with the Move command:
1. Choose Move from the Control Menu box.

2. Drag the four-headed arrow to the left window border. It changes to a
two-headed arrow.

3. Drag the two-headed arrow to move the window.

4. Release the mouse button when the window is in the desired position.

Quick Move
You can also quickly move any window:
1. Drag the Title bar. The Scanner window moves.

2. Release the mouse button when the window is in the desired position.
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Minimize
To remove the Image Editor window from the screen, but still keep it loaded

and ready to use, you can change it to an icon. When you want to use it again,
double-click the icon.

To minimize the Image Editor window:
1. Choose Minimize from the Control Menu box.

The Editor window changes to an icon.

Image Editor — JUNGLE.TIF

Quick Minimize
To quickly change the Image Editor to an icon:
Click the down arrow.
To restore the Image Editor window:
1. Double-click the Image Editor icon.

You can also click the up arrow in the upper right corner of the
window.
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Maximize

Use the Maximize command to enlarge the Image Editor window to its
maximize size.

To maximize the Image Editor window:

Choose Maximize from the Control Menu box.

Quick Maximize

1. Select the Image Editor window.

2. Click the Maximize box in the upper-right corner of the window.

Close

Choose the Close command to exit the Scanner window or the Image Editor
window. If both windows are displayed on the screen, when you close the
Scanner window the Image Editor window will remain until you close it as well.

To close a window:

Choose close from the Control menu box.
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Using the Keyboard

If you don’t have a mouse, you can use your keyboard with Scanning Gallery
Plus. This appendix is made up of keyboard tables that show you the
appropriate key combinations for performing tasks with Scanning Gallery Plus.

Open a Menu and Choose an Option

To open a menu in the Scanner window and choose an option:
1. Press Alt + T keys to open the Settings menu.
2. Press the S key to open the Paper Size dialog box.

To select an option from a dialog box, use the up arrow or the down
arrow keys to move to the option.

3. Tab to OK and press the Enter key to choose the option and close the
dialog box.

Dialog Boxes

Press ... To ...
Enter Carry out action in bold
border.
Esc Cancels the task.
Tab Move to next choice in dialog
box.

Shift + Tab | Move to previous choice(s) in
dialog box.

spacebar Carries out the currently
selected action.

To cancel a dialog box, tab to Cancel and press spacebar.
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Selecting an Area

The following table shows the keys to use when:
m Selecting an area for an image scan (Scanner window).
m Selecting an area to cut (Image Editor window).

® Selecting an area to crop (Image Editor window).

Select Keys: Image Editor and Scanner

Press ... To Select an Area

Ctrl 4 cursor keys Moves the pointer faster in the
appropriate direction.

Shift 4+ cursor keys Anchors a position, then
expands the selection box in
the appropriate direction.

Shift Ctrl 4+ cursor Anchors a position, then

keys expands the selection box
faster in the appropriate
direction.

Esc Removes the selection box

from the area. Allows you to
select a new area.
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Keyboard Combinations

The following tables show the keyboard combinations to use when working
with the Scanner window and the Image Editor window.

Scanner Window

Scanner Window Key Combinations

Press ... To Open ...
Alt + spacebar Control menu
Alt + F File menu
Alt + S Scan menu
Alt+ T Settings menu
Alt + H Help menu commands
Ctrl + P Preview Scan
Ctrl + 1 Image Scan
Ctrl+ T Text Scan
F1 Help Topics

Once a menu is opened, press the underlined key in a command to begin
the command. For example, in the File menu the “b” in the About Scanner
command is underlined. You press the “b” on your keyboard to begin the
command.
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Image Editor Window

Image Editor Window Key Combinations

Press ...

To ...

Alt + spacebar

Open Control menu

Alt + F Open File menu

Alt + E Open Edit menu

Alt + S Open Scan menu

Alt +V Open View menu

Alt + T Open Settings menu

Alt +H Open Help Menu Commands
Ctrl + P Print

F1 Open Help Topics

Alt + backspace Undo

Shift + Del Cut

Ctrl + Insert Copy

Shift + Ins Paste

Del Clear

Pg Up Scroll up (Detail View)
Pg Dn Scroll down (Detail View)
Ctrl + Pg Up Scroll left (Detail View)
Ctrl + Pg Dn Scroll right (Detail View)

Once a menu is opened, press the underlined key in the command to begin the
command. For example, in the File menu the “b” in the About Image Editor
command is underlined. You press the “b” on your keyboard to begin the
command.

Learning Microsoft Windows and the Keyboard B-9



Control Panel

You use the Control Panel to adjust Microsoft Windows system settings such
as the date and time, printer assignments, and baud rates for communications
devices. You can also use the Control Panel to specify screen colors.

The Control Panel lets you adjust these settings quickly and easily without
running the Setup program again. Many of the changes you make in the
Control Panel are reflected in the WIN.INTI file.

Control Panel
Installatrion Setup Preferences

(i ] [Pt ]

Cursor Blink Oouble Cliock
Slow Fasv Slow Fast

! [RE3
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Starting Control Panel
Here’s how to start Control Panel:
m Select Run Control from the File menu in the Image Editor window.

When you start the Control Panel, it creates a window containing four sections:
Time, Date, Cursor Blink, and Double Click.

] [t ]

Cursor Blink Double Cliok
8low Fast Slow Fast

Changing the Time

You can use the Control Panel to change the system time. The time you set
from Control Panel will be reflected in any applications (such as Clock or
Calendar) that use the system time.

To change the time using the keyboard:

1. Press the Tab key to move to the Time section.

Time
{ 1:42126 AM

Date
[ /22799

Cursor Blink Double Cliok
Slow Fast S8low Fast
N WS | [ )

2. Use the right or left arrow key to select the part of the time (hours,
minutes, or seconds ) that you want to change.

3. Press the up key to increase the number; press the down key to decrease
the number.
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The system time changes when you move to another section or quit Control
Panel.

To change the time using a mouse:

1. Click the part of the time (hours, minutes, or seconds) that you want to
change.

2. Click the up arrow to increase the number or the down arrow to
decrease the number.

The system time changes when you click outside the Time section or quit
Control Panel.

Changing the Date

Some applications, like Notepad, use the system date. You change the date the
same way that you change the time:

To change the date using the keyboard:

1. Press the Tab key to move to the Date section.
I-T::ZIZG AM I [n;;;zno

Cursor Blink Double Cllok
Slow Fast Slow Fast

2. Use the right or left arrow key to select the part of the date (month,
day, or year) that you want to change.

3. Press the up arrow key to increase the number; press the down arrow
key to decrease the number.
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The system date changes when you move to another section or quit Control
Panel.

To change the date using a mouse:

1. Click the part of the date (month, day, or year) that you want to
change.

2. Click the up arrow to increase the number or the down arrow to
decrease the number.

The system date changes when you click outside the Date section or quit
Control Panel.

Changing the Cursor-Blink Rate

Some applications have an underscore (cursor) or insertion point that blinks.
The blink rate is the frequency at which the cursor flashes.

To change the cursor blink rate using the keyboard:
1. Press the Tab key to move to the Cursor Blink section.

[ ] [t ]

Cursor Blink Double Cliok
Slow Fast Slow Fast

2. Press the right or left key to scroll to the setting you want. The farther
right you scroll, the faster the blink rate. The vertical cursor within the
Cursor Blink section reflects the new setting.

To change the Cursor-blink rate using a mouse:
Click the right or left scroll arrow in the Cursor Blink section.

You can also change the cursor-blink rate by dragging the scroll box within the
scroll bar.
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Changing the Mouse Double-Click Rate

When you double-click the mouse button, Windows interprets your action by
the speed with which one click follows another. You can change the expected
speed by adjusting the setting in the Double Click section.

Mt | [t ]

Cursor Blink Double Ciick
Sliow Fast Slow Fast

To change the double-click rate using the mouse.

Click the right or left scroll arrow in the Double Click section. The
farther right you scroll, the faster the double-click rate.

You can also change the double-click rate by dragging the scroll box within the
scroll bar.

You can test the new double-click setting by double-clicking the Test button.
The button color will invert if Windows perceived the pressing of the mouse
button as a double-click.

Adding and Removing Printers

When you first set up Windows, you select the printer you’ll use with your
system. To change this selection, use the Installation menu’s Add New Printer
and Delete Printer commands.

Adding a Printer
To add a new printer to your system:

1. Select the Installation menu and choose the Add New Printer
command. A dialog box appears prompting you for the disk that
contains printer files.

2. Insert the disk that contains the printer files you want to install. (This
is one of the Scanning Gallery Plus Utilities disks for printer files that
are included with Windows.)
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7.

. Choose the OK button. A dialog box appears listing the printer files

available on the disk.

3] (Caga ) (Cancen)

Available Printers Printer File: HPPCL . DRV |

. Select the name of the printer that you want to add in the list box. The

name of the corresponding printer file appears in the Printer File text
box at the right.

. Choose the Add button.

. A dialog box appears prompting you to enter the drive or directory

you want to copy the printer to. Drive B or your Windows directory
appears in the text box. If you want to change this, type the drive or
directory you want in the text box. (The directory must already exist.)

If you do not specify a drive or directory, the file will be copied to the
disk in drive B if you have a two-drive system. The file will be copied
to your Windows directory if you have a hard-disk system.

Choose the Yes button.

Whenever you add a new printer your system, you must let Windows know
which port the printer is connected to. See the section called “Configuring
Your System?” later in this chapter for more information on this procedure.

Removing a Printer

To remove a printer from your system:

1.

Select the Installation menu and choose the Delete Printer command. A
dialog box appears listing the printers you have set up.

Delete Printer Printer File: HPPCL . DRV :
p exr et o AN

3] (Delete) (cCancel
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2. Select the name of the printer you want to remove in the list box. The
name of the corresponding printer file appears in the Printer File text
box.

3. Choose the Delete button.

4. A dialog box appears displaying the location of the printer file. If
necessary, type an alternate location for the file in the text box.

5. Choose the Yes button.

If other applications use the printer that appears in the Delete Printer dialog
box, that printer will not be deleted from the named directory; it will still be
available to the other printers.

Configuring Your System

You use commands from the Setup menu to change printer port assignments,
set the system default printer and specify its output modes, and set up serial
communications ports.

Connecting Printers

Windows needs to know which port your printer is connected to. You use the
Connections command to assign or change the port for your printer(s). For
example, if you decide to move your printer from port LPT1 to port LPT2, you
need to use Control Panel to change the printer connections setting.

To change printer connections:

1. Select the Setup menu and choose the Connection command. A dialog
box appears displaying a list of printers and a list of ports.

Printer Conneotion
PCyL s HD n +

LPT2:
LPT3s
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2. Select the name of the printer you want to change from the Printer list
box. The current port assignment for the selected printer is selected in
the Connection list box to the right.

3. Select the desired port from the Connection list box.

Setting Up Printers

Use the Setup menu’s Printer command to specify the system default printer
and set its output mode. Also use it to set a certain amount of time for
printing problems to be corrected before Windows sends you a message about
the problem.

The system default printer is the printer used by applications designed for
Windows. Printer output modes are printer-specific settings such as portrait
(normal page orientation), landscape (lengthwise page orientation), or color
for plotters. These options vary from printer to printer. If you have several
printers installed, you can use the Printer command to let Windows know
which printer you want to use.

The two Printer Timeouts settings let you adjust the amount of time Windows
waits before sending you messages about printer problems. The Device

Not Selected setting controls the amount of time Windows waits before
notifying you that a printer is off-line. The default setting is 15 seconds. The
Transmission Retry setting controls the amount of time Windows waits for
output characters to be received by a printer before notifying you that it
cannot print to the device. The default setting is 45 seconds.

Selecting Default Printer and Output Modes

To select a system default printer or change printer output modes:

1. Choose the Printer command from the Setup menu. A dialog box
appears listing all available printers and their port connections.

2. To select a default printer, move to the default Printer list box and
select the name of the printer that you want to serve as the default.

3. Choose the OK button. Another dialog box appears containing the
default mode settings for your printer.

4. If necessary, change the settings.
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5.

Choose the OK button.

To change the amount of time Windows waits before sending you messages
about printing problems:

1.

5.
6.

Choose the Printer command from the Setup menu. A dialog box
appears.

To change the Device Not Selected setting, move to that text box and
type the number of seconds you want Windows to wait before sending
you a message that the printer is off-line.

. To change the Transmission setting, move to that text box and type

the number of seconds you want Windows to wait before sending you a
message that it cannot print to the device.

. Choose the OK button. A dialog box appears showing the default

settings for your printer.
If necessary, change the settings.

Choose the OK button.

Setting Up a Communications Port

You use the Communications Port command to set up a serial communications
port. You would want to do this if you are setting up a communications device
or a serial printer.

If you are setting up a serial printer, check your printer’s manual to make sure
that the port settings you select are correct.

To choose a communications port:

1.

Select the Setup menu and choose the Communications Port command.
The Communications Setting dialog box appears displaying the
available serial ports and their port settings.
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Comsunications Settings

Porct ®icoriy] O conzs
Baud Rate:
word Lengch O4 Os O6¢ O7 @o

Paricy Oeven O 0dd @ Mone
Stop Bits ®1 O1.8 Oz
Handshake O Hardware @ Mone

2. Choose a port; the settings for that port appear.
3. Select the appropriate options.
4. Choose the OK button.
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Selecting Screen Colors

Use the Preferences menu’s Screen colors command to adjust the text and
background colors on your screen. The Screen Colors command also lets you
adjust the shades of gray on the screen. You can specify hue, brightness, and
amount of color for the following areas of your screen:

m Screen background
= Application workspace
m Window background
m Window text
m Menu bar
m Menu text
m Active (selected ) title bar
m Inactive (unselected) title bar
m Title bar text
m Active border
= Inactive border
m Window Frame (the border that surrounds the window)
m Scroll bars
To select screen colors:

1. Select the Preferences menu and choose the Screen Colors command.
The Screen Colors dialog box appears.

Soreen Colors Sample
Hande Bacliground
Gl “
Scroll Bars File Edit
Aotive Title Bar +

DO -

Window Text
s

Hue 4
Oright
Color [&] ] (ox ) (Reser ) (cancel)
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. In the list box, select the part of the screen or window for which you
want to adjust the color.

. To change the hue, move to the Hue scroll bar. Available colors are
shown in the color palette above the scroll bar. Scroll to the right or
to the left to choose a color. The Sample area simulates the Window
appearance. Use the right or left arrow key to change settings in small
increments. To move across the scroll bar more quickly, use the Page
Up or Page Down key. If you are using the mouse, you can click the
scroll arrows or drag the scroll box.

. To change the brightness, move to the Bright scroll bar. scroll to the
right to brighten the color (increase the amount of white). Scroll to the
left to darken the color.

If the Bright scroll box is at the extreme left of the scroll bar, the color
is black. If the scroll box is at the extreme right, the color is white.

. To change the color, move to the Color scroll bar. Scroll to the right
for a more vibrant, intense color. Scroll to the left for less intensity or
saturation.

If the Color scroll box is at the extreme left of the scroll bar,
adjustments to the Hue and Bright scroll bars will result only in black,
white, and shades of gray.

. When you have adjusted the screen colors to your satisfaction, choose
the OK button. If you have changed your mind and want to return
to the previous settings, choose the Reset button. This restores the
original settings but does not close the dialog box. To cancel the new
settings and close the dialog box, choose the Cancel button.

The Hue, Brightness, and Color controls are similar to those on a color TV;
adjust the controls until you have the effect you want.

You need to run the SJISETUP program again if you want to add or change
graphics cards or change the resolution of the graphics card you have already
set up. You cannot use the Control Panel to make these changes in your
system configuration. See the Software Installation Help in the front pocket of
this manual.
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Turning Off the Warning Beep

When you're using Windows, your computer sometimes beeps; for example,
this occurs if you press the wrong key. You can turn off the beep by using the
Warning Beep command from the Preferences menu.

You can tell if the Warning Beep feature is in effect by looking in the
Preferences menu. A checkmark appears by the Warning Beep command when
the feature is active.

To turn the beep on or off:

Select the Preferences menu and choose the Warning Beep command.

Changing Mouse Options

The Mouse command in the Preferences menu lets you change which mouse
button you press and adjust how fast the mouse pointer moves on the screen.

Windows generally uses only the left mouse button. You can switch usage from
the left mouse button to the right mouse button (and vice versa). With the
Mouse Acceleration setting, you can increase or decrease the speed at which
the pointer moves on the screen.

Switching Mouse Buttons
To switch mouse buttons:

1. Choose the OK button.

Mouse Options
OiLeft/right mouse buttons_swapped

Cox) (canea))

2. Set the Swap Left/Right Mouse Buttons option.
3. Choose the OK button.
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Adjusting the Pointer
To change the speed at which the mouse pointer moves across the screen:

1. Select the Preferences menu and choose the Mouse command. A dialog
box appears.

2. Choose the acceleration rate you want. The default is medium.

3. Choose the OK button.

Once you have set these options, they remain set until you change them.

Changing Country Settings

You can set variables (such as date, number, and time formats) for a particular
country by using the Country Settings command in the Preferences menu.

You can make changes to the following settings:
m Country
m Time format ( 12- or 24-hour)
» Trailing string (AM, PM, etc.)
m Time-separator symbol
m Date format (month-day-year, year-month-day, etc.)
m Date separator symbol
m Number-separator symbol
m number of significant digits
m List-separator symbol
m Leading zero

m Currency symbol
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B To change country setting:

1. Select the Preferences menu and choose the Country Settings command.
You will see the Country Settings dialog box.

Country Settings

. [(Time Format
Japan
Netherlands @12 hour 11439[AH ] 23:39[PH_]
elgium
France O 24 hour Separator: EI
[Date Format— | [Number Format
[, 14 1,4 YMD
® © o 1000: Deoimal digits: @
Separator: Decimals E
Lists = O Leading Zero

( Ok ) (lnsnt) (Cancel) I—::::::"t. Prefix O Suffix

2. In the country names list box, select the appropriate country name.

Notice that the country settings automatically change to correspond to
the country you select.

3. If you do not want to make any modifications to the country settings,
choose the OK button. The settings will be saved and will become your
default values. See the following section for information about changing
the settings. If you want to return to the original settings, choose the

Reset button.
Creating New Country Settings

If the country name you want is not shown in the list box, you can create your
own country settings.

To create new country settings:
Select Other Country in the country names list box.

The settings displayed are for your current country setting (for example, the
U.S.A. settings). You can change any of the settings.
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Changing The Time Format
To change the time format:

1. Move to the Time Format section.

Country Settings

[ Time Format
Jaman ena @® 12 hour 11¢39[an_| 23439 [Pn ]
ands
:;::::n QO 24 hour Separator: [E
[[Date Format———="""1 [Number Format
oy
® O ony © vmo 1000 Deoimal digitsa [Z
Separators Oecinals [] O Leadt z
Lists D eading Zero

( Dk J (lc-ct) (Canccl) I—::::::EI"; Prefix O Suffix |

2. Select the time format you want (12- or 24-hour). Notice that when you
switch to the 24-hour format, the AM/PM designations disappear.

3. Move to the trailing-string text boxes (shown as 11:59 and 23:59) and
type the appropriate trailing string (for example, AM).

4. Move to the Separator text box and type the time-separator character
you want (for example, : ).

Changing the Date Format
To change the date format:
1. Move to the Date Format section.

2. Select the date format you want (M stands for month, D for day, and Y
for year).

3. Move to the Separator text box and type the appropriate date separator
(for example, /).
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B Changing the Number Format
To change the number format:

1. Move to the Number Format section.

Country Settings

® 12 hour 22:39[anM ] 23:s9[PW ]

Tiwe Format
[O 24 hour Separator: E

Date Format~— ] [Number Format
noy YMD
® © o © 1600 Decimal digitss [Z]
Separators Decimal: B N 2
Liste [o] [Jtesdins Zero

o) Gz EameeD) [T @ preein O surrix |

2. Move to the 1000 text box and type the symbol used to separate the 1
from the 000.

3. Move to the Decimal digits text box and type the symbol used to
separate integers from decimals.

4. Move to the List text box and type the symbol used to separate items
in a list.

5. Move to the Decimal digits text box and type the number of decimal
digits you want to display.

6. Move to the Leading Zero check box. If you want a leading zero in front
of your decimal numbers, set this option.
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Changing the Currency Format computer. B

Musetim - =

To change the currency format:

1. Move to the Currency Format section.

Country Settings
U o 0.
Japan
Netherlands
Belgium
Franoe

Time Format
@12 hour 11:59[AN ] 22:59[Pn )
O 24 hour Separator: E:]

Date Format— ] [Number Formst
@ mv O omv Ovro 1068 Decimal digits: E]
Separator: Decimals E]

Lists J O Leadins Zero

( ok ) (meser ) (cancel) I’::::::"'. Prefix O Suffix |

2. In the Symbol text box, type the appropriate currency symbol.

3. Move to the Prefix or Suffix option button and select the option that
corresponds to your currency. If the currency symbol precedes the
number, select the Prefix option. If it follows the number, select the
Suffix option.

Saving Country Settings Changes

Once you have adjusted the country settings to your satisfaction, you can
save them by choosing the OK button in the Country Settings dialog box.
The settings you have indicated will become effective immediately, and your
WIN.INI file will be updated to reflect the changes.

If you decide to return to your original settings and keep the dialog box on
the screen, choose the Reset button. To cancel the new settings and return to
Control Panel main window, choose the Cancel button.

Quitting Control Panel

Once you have finished adjusting the different system settings, you may want
to quit the Control Panel.

To exit the Control Panel:

Click the Control Menu box and select Close.
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Maintenance, Warranty Information, and
Specifications

This section contains information about keeping your ScanJet Plus scanner
clean and replacing the light source. You'll also find warranty and service

information, and product specifications.
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Maintenance

Cleaning

To keep your ScanJet Plus scanner performing at its best, occasional cleaning
is recommended. To clean your scanner:

1. Turn off the power switch.
2. Unplug the scanner.

3. Using a soft cloth and a mild detergent, gently wipe the copyboard
glass, copyboard cover, and the exterior of the scanner. See figures
C-1 and C-2. Avoid spraying cleaning solution directly on the
copyboard glass because the spray could penetrate below the glass and
contaminate internal mirrors and lenses.

4. Dry with a clean cloth.

Figure C-1. Cleaning the Copyboard Glass
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Figure C-2. Cleaning the Copyboard Cover
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Replacing the Light Source

The ScanJet Plus scanner comes with a replaceable lamp capable of over
100,000 scans. When the lamp becomes dim or fails your host computer may
indicate an error. When the lamp needs replacing, follow these steps:

1. Turn off the scanner and the computer.

2. Remove the copyboard cover by sliding it toward the front of the
scanner. See figure C-3.

)

Figure C-3. Removing the Copyboard Cover
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3. Lift and remove the copyboard cover. See figure C-4.

Figure C-4. Removing the Copyboard Cover
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4. Disconnect the interface cable from the ScanJet Plus scanner. See figure

C-5.

Figure C-5. Disconnecting the Interface Cable
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5. To return the scanning unit to the correct position turn the scanner on.
See figure C-6.

|

Figure C-6. Turning On the Scanner
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6. When the scanning unit has returned to its home position, turn the
scanner off. See figure C-7.

Figure C~7. Turning Off the Scanner

7. Disconnect the power cord from the scanner. See figure C-8.

Figure C-8. Disconnecting the Power Cord
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8. Locate the lamp cover and remove it by gently sliding it up. See figure
C-9.

<>
oL

Figure C-9. Removing the Lamp Cover
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9. Unplug the lamp connector by depressing the side clip and pulling the
connector out of the socket. See figure C-10.

Figure C-10. Unplugging the Lamp Connector
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10. Gently remove the lamp holder by sliding it out of the scanner. See
figure C-11.

Figure C~11. Removing the Lamp Holder
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11. Remove the used lamp from the lamp holder. See figure C-12.

Figure C-12. Removing the Used Lamp
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12. Insert the new lamp into the lamp holder, making sure the clear portion
of the glass faces out from the lamp holder. See figure C-13.

Figure C-13. Inserting the New Lamp
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13. Insert the lamp holder as shown making sure the base of the holder fits
into the plastic guide. See figure C-14.

Figure C-14. Inserting the Lamp Holder
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14. Slide the lamp holder completely into the scanner. See figure C-15.

Figure C-15. Sliding In the Lamp Holder
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15. Plug in the lamp connector by depressing the side clip and plugging it
into the socket. See figure C-16.

Figure C-16. Plugging In the Lamp Connector
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16. Replace the lamp cover. See figure C-17.

Figure C-17. Replacing the Lamp Cover

17. Reconnect the scanner’s power cord, interface cable, and cover.

“Computer

Useyrm

Maintenance, Warranty Information, and Specifications C-17



One-Year Limited Hardware Warranty

Hewlett-Pazkard warrants this peripheral/accessory against defects in materials
and workmanship for a period of one year from receipt by the customer unless
an alternate warranty coverage is selected by the customer. Other warranty
options are available through the HP Sales Office. If Hewlett-Packard receives
notice of such defects during the warranty period, Hewlett-Packard will, at its
option, either repair or replace products which prove to be defective.

Should Hewlett-Packard be unable to repair or replace the product within a
reasonable amount of time, the customer’s alternate remedy shall be a refund
of the purchase price upon return of the product to Hewlett-Packard.

This warranty gives the customer specific legal rights. Other rights, which vary
from state to state or province to province, may be available.

Exclusions

The above warranty shall not apply to defects resulting from improper or
inadequate maintenance by the customer, customer-supplied software or
interfacing, unauthorized modification or misuse, operation outside of the
environmental specifications for the product, or improper site preparation and
maintenance.

This product has been sealed to detect unauthorized entry. Do not open the
scanner case ezcept to replace the lamp. If the seal is broken, the warranty may
be voided at Hewlett- Packard’s discretion.

Obtaining Warranty Service

To obtain warranty service, products must be returned to a service facility
designated by Hewlett-Packard. Hewlett-Packard may repair on-site at the
option of the customer. The customer is responsible for travel charges when
on-site repair is requested. Warranty service for products purchased as part of
a system will be subject to service in accordance with the system services.

Customers shall prepay shipping charges for products returned to
Hewlett-Packard for warranty service and Hewlett-Packard shall pay for return
of the products to the customer. However, customers shall pay all shipping
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charges, duties, and taxes for products returned to Hewlett-Packard from a
country other than the United States.

Warranty Limitations

HEWLETT-PACKARD MAKES NO OTHER WARRANTY, EITHER
EXPRESSED OR IMPLIED, WITH RESPECT TO THIS PRODUCT. ¢
HEWLETT-PACKARD SPECIFICALLY DISCLAIMS THE IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A

PARTICULAR PURPOSE.

In any state or province which does not allow the foregoing disclaimer, any
implied warranty of merchantability or fitness for a particular purpose imposed
by law in those states or provinces is limited to the one-year duration of the
written warranty.

Exclusive Remedies

THE REMEDIES PROVIDED HEREIN ARE THE CUSTOMER’S SOLE
AND EXCLUSIVE REMEDIES. IN NO EVENT SHALL HEWLETT-
PACKARD BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY.

In any state or province which does not allow the foregoing exclusion or
limitation of incidental or consequential damages, the customer may have other
remedies.

Hewlett-Packard offers complete service and maintenance worldwide.
Maintenance agreements are available for HP peripheral products. Advantages
of these agreements to the customer include a fixed annual cost, individualized
cost-effective contracts, and a choice of response times. Current rates can be
determined by contacting the local HP Sales Office.
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Obtaining Service from Hewlett-Packard in the United
States

If your ScanJet Plus scanner or ADF should fail, contact the dealer from whom
you purchased your scanner.

If you purchased your ScanJet Plus scanner from a Hewlett-Packard sales
representative, call our Customer Assistance Line for service options available
to you:

(208) 323 - 2551
Customer Assistance Phone Number

If you purchased your ScanJet Plus from a dealer, please contact them for
service information. Your dealer has resources available to help you maintain
your scanner at optimum performance.

C-20 Maintenance, Warranty Information, and Specifications



Obtaining Service from Hewlett-Packard Worldwide

Hewlett-Packard products are sold and supported worldwide through
Hewlett-Packard Sales and Service Offices and through dealers. There are more
than 240 Hewlett-Packard Sales and Service Offices worldwide. To locate the
nearest one, use your telephone directory, or call one of the Hewlett- Packard
offices listed here.

Argentina Chile

Buenos Aires HP Distributor:

Phone: 781-4059/69 Olympia (Chile)
Santiago

Australla Phone: 225-5044

North Ryde, N.S.W.

Phone: 888-4444 Denmark

Blackburn, Victoria * Birkeroed

Phone: 895-2895 Phone: 02/81-66-40

The Gap, Queensland El Salvador

Phone: 30-4133 HP Distributor
IPESA

Austria San Salvador

Vienna Phone: 503/26-6858

Phone: 0222/2500-0

Egypt

Belglum * Cairo
Supplies: (32/2)761-31-  Phone: 706440
1
Brussels Finland
Phone: (32/2)761-31-11 * Espoo
Phone: (358/0)887-2581
Brazil
Alphaville, Barueri France
Phone: 011/421-1311 Supplies: 6/828-32-84
* Rennes
Canada Phone: 99/51-42-44
Software Assistance: |
1-800/267-6115 Toulous

(in English and French)
Supplies: 514/697-4232
Edmonton, Alberta
Phone: 403/4B6-6666

Richmond, British
Columbia
Phone: 604/27(0-2277

Mississauga, Ontario
Phone: 416/678-9430

Phone: 61/40-11-12

German Federsi
Republic
Boeblingen

Phone: 07031/645-0

Guatemala

HP Distributor:
IPESA
Guatemala City
Phone: 316627

Hong Kong
Wanchai
Phone: 5/200922

Cernusco Sul Naviglio
Phone: 02/923691

Japan

Yokogawa-Hewlett-

Packard Ltd.
* Osaka

Phone: 06/304-6021
* Sagamihara

Phone: 0427/59-1311
* Tokyo

Phone: 03/331-6111

Korea
* Seoul
Phone: 784-4666

Malaysis
Kuala Lumpur
Phone: 2986555

Mexico
* Mexico, D.F.
Phone: 5-40-62-28
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The Netherlands
Supplies: 020/47-06-39

Amstelveen
Phone: 020/547-6911

New Zealand
Auckland
Phone: 605-651

Norway
Qesteraas
Phone: 0047/2/24-60-90

Puerto Rico
Hato Rey
Phone: 809/754-7800

Saudi Arabla

HP Distributor:
Modern Electronics
Jeddah

Phone: 644-96-28

Singapore
Singapore
Phone: 473-1788

South Africa
Supplies: 802-5111
53-7954

Sandton, Transvaal
Phone: 802-5111

Spain

H.P. Espaiiola, S.A.
Carretera Nacional
Vi, Km, 16,400

Las Rozas (Madrid)
Phone: 637 00 11

Sweden
Spanga
Phone: 08/750-2000

Switzeriend *
Supplies: 057/31-22-84

or 31-22-80
Widen
Phone: 0041/57-31-21-11 .

Meyrin
Phone: 0041/22-83-11-11

Talwen
Taipei
Phone: 02/712-0404

United Kingdom
Supplies: 0734/79-2008

or0734/79-29059 °
Uxbridge, Middiesex
Phone: 895-720-20
Winnersh, Wokingham
Phone: 735/784774

United States

For assistance before
your purchase, t0 locate
an HP dealer, or to
obtain your local
Phone-in Software
Assistance number:
800/752-0900

Hardware maintenance
Information or Dealer
Repair Center locations: *
800/835-HPHP
Computer Supplies:
~AH states except
California, Alaska, and
Hawail:
800/538-8787
—in Californis, Alaska,

Fullerton, California
Phone: 714/999-6700
Los Angeles, California
Phone: 213/337-8000
Mountain View,
California

Phone: 415/694-2000
Santa Clara, California
Phone: 408/968-7000
Englewood, Colorado
Phone: 303/649-5000
Atanta, Georgia
Phone: 404/955-1500
Rolling Meadows, Illinois
Phone: 312/255-9800
Rockville, Maryland
Phone: 301/948-6370
Andover, Massachusetts
Phone; 617/682-1500
Novi, Michigan
Phone: 313/349-9200
St. Paul, Minnesota
Phone: 612/644-1100
Paramus, New Jersey
Phone: 201/265-5000
Valley Forge,
Pennsylvania

Phone: 215/666-9000
Richardson, Texas
Phone: 214/231-6101
Bellevue, Washington
Phone: 206/643-4000

Venezuela
Caracas
Phone: 582/239-4133

Full Field Repair Center
capabilities.
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Maintenance by Your Local Dealer

The HP dealer sites designated as Personal Computer Dealer Repair Centers
provide maintenance at their locations. Many also offer maintenance contracts
which include additional services such as pickup and delivery or loaner
equipment. For the nearest Dealer Repair Center in the U.S., call:

1- 800 - 835 - HPHP

In other countries, call your HP Sales and Service office, and ask for “Personal
Computer Dealer Sales.”
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Funkentstorung Deutschland Herstellerbescheinigung

Hiermit wird bescheinigt, da das Gerit HP 9195AB in Ubereinstimmung mit
den Bestimmungen von Postverfiigung 1046/84 funkenstort ist.

Der Deutschen Bundespost wurde das Inverkehrgringen dieses Gerites

angezeight und die Berechtigung zur Uberprufung der Serie auf Einhaltung der
Bestimmungen eingeraumt.

Wird das Gerat innerhalb einer Anlage betrieben,

m so muf bei Inanspruchnahme der Allgemeinen Genehmigung FTZ
1046/84 die gesamte Anlage der oben genannten Genehmigung
entsprechen.

m die mit einer FTZ-Serienprifnummer gekennzeichnet ist, und fir die
eine Betriebsgenehmigung vorliegt oder beantragt wird, so sind in der
Regel keine weiteren Schritte notwendig.

Electromagnetic Interference Regulations Manufacturer’s
Declaration

(English Translation) This is to certify that the HP 9195AB is in accordance
with the Radio Interference Requirements of Directive FTZ 1046/84. The

German Bundespost was notified that this equipment was put into circulation;
the right to check the series for compliance with the requirements was granted.

If this equipment is to be operated with a system

m and if the General License is being claimed, the complete system has to
comply with the General Licensing requirements.

m which has its own FTZ-Serial License, and for which an operating
license has been granted or requested, usually no further steps are
necessary.
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Microsoft Windows End User License Agreement

1.

Hewlett-Packard grants to you a personal, nontransferable, nonexclusive
sublicense to use the Software on a single central processing unit. You
may transfer the software to another CPU provided the use of the
software on the original CPU is terminated. You shall not use the
Software or related materials other than as provided in this Agreement.
You shall notify Hewlett-Packard if the capacity of the designated CPU
is changed.

. You may not copy the Software except as necessary to use the Software

on the designated CPU. All such copies shall be destroyed if you
transfer possession of the Software or if your license for the Software is
terminated. You agree to retain the copyright and proprietary notices
of Hewlett-Packard and its suppliers on all originals and copies of the
Software and related materials in the same form as affixed on the
materials, delivered to you by Hewlett-Packard.

. You agree that the Software and related materials, and all copyrights,

patent, trade secret and other intellectual and proprietary rights
therein, are and remain the valuable property of Hewlett-Packard and
its suppliers.

. You agree that you will not export the Software in any form from the

country where Software is furnished to you.

. You agree not to reverse compile or disassemable the software.

. HEWLETT-PACKARD’S SUPPLIERS SHALL NOT BE HELD

TO ANY LIABILITY FOR ANY DAMAGES SUFFERED OR
INCURRED BY YOU, INCLUDING BUT NOT LIMITED TO
GENERAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING
FROM OR IN CONNECTION WITH THE DELIVERY, USE OR
PERFORMANCE OF THE SOFTWARE.

Maintenance, Warranty Information, and Specifications C-25



Specifications

Scandet Plus Scanner

Scanner type

Flatbed

Maximum Document size

216 by 297 mm (8.5 by 11.7 in.)

Scanning element

Charge-coupled device

Light source

Fluorescent lamp

Interface

Bi-directional Centronics

Optical resolution

300 pixels per inch (ppi)

Selectable resolution

Variable from 12 to 1500 ppi

Scaling

4 to 200% in 1% increments at 300 ppi
resolution (scaling range varies for each
resolution)

Scanning modes

Line art, coarse fatting dither, fine fatting
dither, Bayer dither, vertical line dither, 4
and 8 bit grayscale

Scanning speed

10 seconds* (A4 size or letter size, line
art or dithered mode, 300 ppi)

Document feeder

Optional

AC line voltage

100/115V 50/60Hz (9195A),0r 220/240V
50Hz (9195AB)

Power consumption

40W maximum

Size 345 by 480 by 94 mm (13.6 by 18.9 x 3.7
in.)
Weight 7.5 kg (16.5 lbs)

Drop-out color

Yellow

* Add 4 seconds when lamp warm-up is necessary.
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Inclination Proper operation occurs when tilted
less than two degrees from horizontal

reference.

Automatic exposure Line art mode

Intensity control 255 levels in line art, dithered, and
grayscale modes

Contrast control 255 levels in dithered, and grayscale
modes

Other functions Independent axis scaling, negative image,

mirror image, downloadable dither and
tone maps, automatic lamp calibration

Power Considerations

Use the ScanJet Plus scanner within the following power range:
m AC power: + or - 10% of the rated power
= Supply frequency: 60 Hz (115 V) or 50 Hz (220/240 V)

Caution Install a voltage regulator or similar device if the power source
is unstable.

Environmental Considerations

To keep the ScanJet Plus scanner operating at its best, observe the following
environmental considerations:

m Use ScanJet Plus only within the following temperature and humidity
ranges:

0 Ambient temperature: 5°C - 40°C (41°F - 104°F)

o Ambient humidity: 10% - 90% (non-condensing) 5°C - 35°C
(41°F - 95°F)

10% - 60% (non-condensing) 35°C - 40°C (95°F - 104°F)

m Keep the ScanJet Plus scanner out of direct sunlight.
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m Install the ScanJet Plus scanner in locations free from constant

vibrations.

m Place the ScanJet Plus scanner on a flat, even surface.

c ADF

Maximum paper size

216 by 356 mm (8.5 by 14 in.)

Minimum paper size

182 by 257 mm (7.2 by 10.1 in.)

Maximum paper weight

135 g/m? (36 Ib. bond)

Minimum paper weight

60 g/m? (16 1b. bond)

Paper tray capacity

20 sheets

Size 343 by 526 by 72.5 mm (13.5 by 20.1 by
2.9 in.)
Weight 3 kg. (6.6 1bs.)
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Using the Automatic Document Feeder

Introduction

The automatic document feeder (ADF) is a powerful addition to your scanner
and makes it possible for you to quickly and easily scan multi-page documents.
In combination with an optical character recognition (OCR) software package
such as ReadRight, you can automatically scan up to 20 pages of text at one
time. (Launching ReadRight from within Scanning Gallery Plus is explained in
chapter 4.)

This appendix explains how to install and use the ADF, fix paper jams, remove
the ADF from the scanner, and replace a plastic piece of the ADF called a
Mylar Guide.
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Unpacking and Inspecting

Check for damage while unpacking the ADF. If you notice any damage, notify
the dealer or the HP sales office where you purchased the ADF and file a claim
with the carrier.

In the ADF box, you should find the following items:
m Automatic document feeder
m Warranty sheet
m Packing list
m Replacement Mylar guide
m Installation Guide

The above list is subject to change. Refer to the packing list for the most
accurate description of contents.

Identify the contents of the ADF box using the packing list. Parts of the ADF
are illustrated in figure D-1. Save the ADF’s box and packaging materials in
case you ever need to transport the ADF.
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Maximum Document
Level Mark

Quick Relerence Document Guide

Guide

Figure D-1. Identifying ADF Parts

The ADF’s Mylar guide is replaceable. Use the Mylar guide in the shipping
box as a replacement after the original guide becomes scratched or worn.

Using the Automatic Document Feeder D-3



Installing the ADF

To install the ADF on your ScanJet Plus scanner:
1. Turn off the ScanJet Plus scanner.
2. Unplug the power cord from the electrical outlet.

3. Slide the copyboard cover in the direction of the arrow in figure D-2
until it stops.

)

Figure D-2. Pushing Cover Forward
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4. Lift and remove the copyboard cover. Store the cover in a safe place.
See figure D-3.

N

Figure D-3. Removing the Cover
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5. Rotate the ADF metal rods until they are perpendicular to the ADF.
See figure D-4. If one or both rods will not rotate to that position,
do not try to force them. Instead, install the ADF with the rods in a
position horizontal to the ADF.

Figure D-4. Rotating the Metal Rods
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6. Secure the ADF by inserting its metal rods into the corresponding holes
on the scanner body. See figure D-5.

Figure D-5. Inserting the Metal Rods
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7. Attach the ADF connector cable by pushing it firmly all the way into
the ADF connector socket on the rear of the scanner. Reconnect the
power cord. See figure D-6.

Figure D-6. Attaching the ADF Connector Cable
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Using the ADF
Follow these steps to use the ADF:
1. Turn on the ScanJet Plus scanner.
2. Make sure the copyboard glass is free of paper.
3. Locate the document guide at the edge of the document tray. See figure

D-7.
—Z—™
[
]
A4
LTR/LGL

Figure D-7. ADF Document Guide
4. Place the originals face up on the document tray. Adjust the document
guide so that it touches the side of the paper stack.

5. Slide the paper stack forward as far as it will go into the ADF cover.
The stack of pages should be no higher than the maximum document
level mark. See figure D-8.
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Figure D-8. Placing Paper in the ADF

6. Perform a scan in the usual way. The ScanJet Plus scanner realizes
paper is in the ADF and automatically feeds paper onto the copyboard
glass.

The sizes of paper that can be stacked and fed by the ADF are listed below. If
a piece of paper is too small or large for the ADF, lift the ADF cover and use
the copyboard glass. Using a document smaller than the minimum size may
cause a paper jam.

Sizes Length Width
Maximum 356 mm (14 in.) 216 mm (8.5 in.)
Minimum 257 mm (10.1 in.) 182 mm (7.2 in.)

When using heavy or light-weight documents, scan them using the copyboard
glass instead of the ADF.
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Follow these guidelines and precautions while using the ADF:

m Make sure paper has been removed from the copyboard glass before
using the ADF.

m Straighten any curls or wrinkles from documents before setting them on
the document tray. If this is not possible, place them on the copyboard
glass.

m Remove staples, paper clips, and any other materials from documents.

m Avoid magazine pages, carbons, transparencies, or gummed-backed
documents in the ADF.

m Avoid documents with tears, perforations or punch holes.

m Stack documents no higher than the maximum document level marked
on the ADF’s document guide.
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Clearing Paper Jams

If the ADF jams while you are using it, fix the jam as follows:

m If the jam occurs at the start of scanning, lift the ADF cover and
remove the jammed paper. Close the cover securely. See figure D-9.

Figure D-9. Removing a Paper Jam at the Start of
Scanning
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m If the jam occurs at the end of scanning, raise the ADF cover and lift
up the document tray. Remove the jammed paper. Close the document
tray and the cover securely. See figure D-10.

Figure D-10. Removing a Paper Jam at the End of
Scanning
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m If the jam occurs inside the ADF, raise the ADF cover. Lift up the
ADF and open the feeder guide by lifting the metal frame. Remove the

jammed paper. Lower the metal frame and close the cover securely. See
figure D-11.

Figure D-11. Removing a Paper Jam Inside the ADF
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A quick reference guide to clearing paper jams is located on the ADF to the
right of the document tray. See figure D-12.

TN
<

Figure D-12. Quick Reference Guide to Clearing Paper
Jams
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Replacing the Mylar Guide

The ADF comes with a replaceable plastic sheet, a Mylar guide, which moves
documents through the ADF. After 10,000 scans, it usually needs replacing.

A replacement guide is shipped in the ADF box. If you need additional guides,
order HP part number 5180-0024 from your HP dealer or sales representative.

Caution Remove the Mylar guide only if you have another one available.
Removing the Mylar guide may damage it.

To replace the Mylar guide:
1. Raise the ADF from the scanner body.
2. Lift up the metal frame holding the Mylar guide.

3. To remove the guide, grasp the two metal clips which hold the guide in
place and push down as illustrated in figure D-13.

Figure D-13. Removing the Mylar Guide
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4. Remove the used guide. See figure D-14.

Figure D-14. Removing the Mylar Guide
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5. With the metal frame lifted, insert the new Mylar guide. Make sure
the new guide is placed behind the white plastic sheet. Attach the new

Mylar guide’s metal clips directly to the metal frame as illustrated in
figure D-15. Be sure to attach the clips securely.

Figure D-15. Installing the Mylar Guide
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Cleaning the ADF
Clean the ADF periodically as needed by following these steps:

1. Turn off the ScanJet Plus scanner.
2. Unplug the power cord.

3. Wipe off the exterior and underside of the ADF with a soft cloth and a
mild detergent. Dry with a clean, soft cloth. See figures D-16 and D-17.

Figure D-16. Cleaning the ADF
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Figure D-17. Cleaning the ADF

4. When the Mylar guide gets dirty or vertical black lines appear on the
printouts from the ADF, clean the Mylar guide gently with a clean, soft
cloth. See figure D-18.

Figure D-18. Cleaning the Mylar Guide

D-20 Using the Automatic Document Feeder



5. Clean the inside surface of the Mylar guide taking care not to let it
come out onto the white plastic sheet. See figure D-19.

Figure D-19. Cleaning the Mylar Guide
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Removing the ADF

Follow these instructions to remove the ADF from the ScanJet Plus scanner:
1. Unplug the scanner from the electrical outlet.

2. Disconnect the ADF connector cable from the ScanJet Plus scanner.
See figure D-20.

Figure D-20. Disconnecting the Connector Cable
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3. Remove the ADF. Store it in its original box to protect it. See figure
D-21.

Figure D-21. Removing the ADF

4. Replace the copyboard cover. See figure D-22.

Figure D-22. Replacing the Copyboard Cover
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Glossary

Address:
A number that identifies the memory location of
a peripheral device.

Addressing Conflict:
A problem that occurs when two adapters try to
use the same memory location.

ADF (automatic document feeder):
An optional scanner attachment that allows
automatic sheet feeding.

ADF Mylar Guide:
A clear, flexible part of the ADF that helps guide
paper through the ADF.

Cable:
Provides a connection between computers and
peripherals.

CONFIG.SYS:
A file which contains special DOS commands
which are executed when the computer is turned
on.

Disk:
A circular plate of magnetically coated material
used to store computer information. The diskette
is similar to a stereo record but it records data
instead of music.
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Glossary-2

Dithering:
A method of varying patterns of identically
shaped dots (a dither pattern) to simulate
grayscale. In a dither pattern, areas which are
black will have as many dots as possible, whereas
lighter areas will have fewer dots. The dots are
the same size. See Halftoning.

DPI (dots per inch):
A measurement of the resolution of a scanned
image.

Driver:
A program that allows the operating system to
communicate with a peripheral device.

Flexible Disk:
See Diskette.

Grayscale:
A measure of the grayness of any portion of a
picture. When a picture is scanned, the gray
level of each area is determined and sent to a
computer.

Halftoning:
A method of simulating grayscale by varying the
sizes of the dots printed. Black areas comprise
large black dots, while lighter areas comprise
smaller black dots.

Hardware:
The tangible parts of the computer system—the
computer and the peripheral devices.

Hard Disk:
A storage device; also called a “fixed” or
“Winchester” disk. A hard disk (as opposed to a
flexible disk) is made from rigid aluminum.



Image Sensor:
An optical sensor which converts light reflected
from a document into electrical signals.

Interface Cable:
The cable that connects the adapter to a
peripheral device.

Interface Card:
A printed circuit board inserted into your
computer that adds a new capability to your
computer.

Mylar Guide:
A plastic sheet on the ADF which guides paper
over the scanning bar.

OCR (optical character recognition):
A technology that can recognize letters from a
scanned image and convert them into characters
that are saved in a text file by the computer.
The resulting text file looks like one that was
typed from a keyboard.

Resolution:
A measure of how many dots per inch (dpi) or
pixels per inch (ppi) scanned or printed. The
higher the resolution, the higher the quality
of the picture. The resolution of the picture
is limited by the quality of the output device
(printer) and the input device (the scanner).

Scaling:
A method of enlarging or reducing the size of a
scanned image.

Scantest:
The user-confidence program provided to test
whether the scanner is configured properly and
scanning correctly.
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Mylar guide, replacing ... D-16-18

need for one ... 5-18

paper jams, clearing ... D-12-15
paper size ... D-9

parts, illustration ... D-2
precautions ... D-10
removing ... 1-8 D-22 D-24
scanning from ... 4-20

test ... 2-12

transporting ... D-2
unpacking ... D-2

warranty ... D-2

B background color ... 4-46, 4-52
bag, anti-static ... 2-2
baud rate, setting ... 4-43, B-10
Bayer dither see: dither patterns
beep, warning ... B-22
bold font, use in this guide ... vi
boot up see: start-up
box see: packaging material

Index-2



contents, adapter kit ... 1-3

contents, scanner ... 1-2
carbon paper, in automatic document feeder ... D-11
card slot ... 2-4

care see: cleaning
caution statements
locking the scanner ... 1-8
meaning of ... vi
replacing Mylar guide ... D-16
unlocking mirror ... 2-8
unlocking the scanner ... 1-6
change gray ... 4-7,4-12
cleaning
automatic document feeder ... D-19-21
copyboard cover C-2
copyboard glass ... C-2
scanner ... (-2
clicking with mouse ... vi, 3-5
clipboard ... 3-19, 4-45
background color ... 4-46
scaling ... 4-48
coarse fatting dither see: dither patterns
commands
about image editor ... 4-44
about scanner ... 4-4
add new printer ... B-14
auto maximize ... 4-52
background color ... 4-46, 4-52
clear ... 4-46
close ... B-5
compression ... 4-51
control menu ... B-2
convert to ... 4-3,4-41
copy ... 4-46
crop ... 3-35, 4-48
cut ... 4-45
executing with keyboard ... B-8
grayed out ... B-2
help index ... 4-33
HP direct print ... 3-24, 3-37, 4-40

Index-3
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Image Scan ... 4-11

in file menu ... 4-3

maximize ... B-5

minimize ... B-4

open ... 4-36

paper size ... 4-21,4-26

paste ... 4-4b

Preview Scan ... 4-5

print ... 4-38

prompt ... 4-21,4-32

resolution ... 4-21

run application ... 4-4

run control ... 4-43

run image editor ... 4-42

run scantest ... 4-4

run user specified app ... 4-44

save ... 4-37

save as ... 4-37

screen/menu ... 4-33

select all ... 4-48

selecting ... 3-5, 3-7

specify applications ... 4-21, 4-53

specify ReadRight OCR ... 4-21, 4-30

text scan ... 4-19

undo/redo ... 4-45

view ... 4-50

warning beep ... B-22
communications port

dialog box ... B-18

setting ... B-18
components see: parts
computers

types supported by scanner ... x
CONFIG.SYS ... A4
configuration

defined ... B-16

switch setting examples ... 2-3

switches, setting ... 1-6
connection see: installation
connector

interface, location ... 1-5



connector cable
automatic document feeder ... D-3, D-8
location ... D-3
container see: box -and- packaging material
contrast ... 3-10, 4-5, 4-13

line art ... 4-9

range ... 4-9
control panel

exiting ... B-27

features ... B-11

opening ... 4-43
steps ... 4-43, B-11
uses for ... 4-36, B-10

conventions, used in this guide ... vi
conversion list box ... 4-3
convert
image file, steps ... 4-41
convert to ... 4-3

copy ... 3-19, 4-46
copyboard cover

cleaning ... C-3
location ... 14
removal ... C-4, D-4
copyboard glass ... 1-4, D-9
damage ... 1-4
COPYCAT ... A-8
copyright information ... 4-44
corrections ... A-4

country settings ... B-23-24, B-24-27
cover, scanner see: copyboard cover
crop ... 335

using keyboard ... B-T

currency format, creating new country settings for ...

cursor, blink rate setting ... B-13
customer assistance phone number ... xiii
cut ... B-7

B-27

Index-5



D damage

automatic document feeder ... D-2
copyboard glass ... 1-4
scanner ... 1-2

date

setting ... 4-43, B-10, B-12
delete see: cut -and- undo
desktop publishing applications ... 5-2-9
device driver see: driver
device not selected setting ... B-17
diagnostic ... 2-12-15
dialog box
background color ... 4-52
buttons ... 4-2
cancel ... 4-2, B-6
communications port ... B-18
convert to ... 4-3, 4-42
country settings ... B-24
defined ... 4-2
gray/color ... 3-31, 412, 4-15
help with ... 4-2
Image Scan ... 3-14, 3-32, 412
open ... 4-36
paper size ... 4-26
Preview scan ... 4-5
print ... 4-38-39, 4-41
resolution ... 4-25
save as ... 4-37
save image ... 3-15
selecting a button ... 3-7
specify applications ... 4-28, 4-53
specify ReadRight OCR ... 4-31
start ... 42
text scan ... 4-19
using keyboard with ... B-6
dimensions ... 3-32, see also: specifications
disassembly, warning against ... 1-4
disk
hard, need for ... 2-1, see also: IBM Reference Diskette
space problems ... 4-51
dither patterns ... 4-7, 4-12
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Bayer ... 3-31, 417
changing ... 3-31, 4-12, 4-15
coarse fatting ... 3-31, 4-17
default ... 3-31
defined ... 4-16
distortion ... 4-16
fatting ... 4-18
halftoned images ... 4-16
intensity ... 4-17
line art ... 4-16
maximum resolution for scan ... 4-23
photographs ... 4-16
quality ... 4-16
rescaling image ... 4-23
selecting ... 4-17
side effects ... 4-16
sizing ... 4-16
steps using various printers ... 4-22
supported by scanner ... 4-15
types ... 417
using steps with various printers ... 4-23
vertical line ... 4-17
when to use ... 4-16
with applications other than Scanning Gallery Plus ... 4-16
document see: paper
document guide ... D-3, D-9

document set mark ... 1-4, 3-9
document tray, location ... D-3
dots per inch, resolution ... 4-21
dotted line box ... 4-47, see also: floating paste box
double-clicking with mouse ... vi, 3-5
dpi see: dots per inch
dragging with mouse ... vi, 3-5
driver ... 2-11
carand ... 2-11
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edit menu ... 445

electromagnetic interference
English translation ... C-24

German translation ... C-24
environment ... 1-10, C-27, see also: site
€ITOr messages

determining causes ... 2-12, A-2

lamp ... C-4

start-up ... 2-11-14

exit see: commands, close
expansion slot see: accessory, card slot

fatting dither see: dither patterns

file
compressed, problems with ... 4-51
format ... 4-20
menu ... 4-3,4-36

name for scanned image ... 3-15, 3-33
saving scanned text to ... 420
text, creating ... 4-19,4-21
final
scan ... 4-11
size of image ... 4-14
firmware data code ... 4-4

First Publisher ... A-8

fixed disk see: disk

flexible disk see: diskette

floating paste box ... 3-20-22, 4-47
floppy see: disk

fonts, used in this guide ... vi
FormScan ... A-8

frequency ... C-27

front view, scanner ... 1-4



Gamma Fax ... A-8
GEM Desktop Publisher ... A-8
GemScan ... A-8
glass see: copyboard glass
graphics applications ... 5-10-15
gray/color, compression restrictions ... 4-51
grayscale ... 3-31, 4-12, A-8, see also: picture
applications that support ... 5-2, 5-4, 5-7, 5-15
choosing ... 4-7
defined ... 4-18
example ... 4-18
problems editing from Microsoft Paint ... 5-14
quality ... 4-18
resolution ... 4-22
selecting ... 4-18
selecting resolution, table ... 4-24
sizing ... 4-18
supporting software ... 4-18
use with various printers ... 4-24
uses for ... 4-18
when to use ... 4-16, 4-23
green lever ... 1-6
ground wire, attaching ... 2-9
guide see: Mylar guide

Halo ... A-8
Halo DPE Publishing Edition ... A-8
hard disk see: disk

hardware
problems ... 2-12, A-2
supported ... x

height see: dimensions
height, scroll bar ... 3-32, 4-15

help
menu ... 4-33
hotline, HP customer help ... xiii

hourglass ... 3-11, 3-21, 4-37
HP direct print

versus print ... 4-40
HP direct print command ... 4-40
humidity, operating range scanner ... 1-10
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| image see: picture

copying, line art ... 3-19
cropping ... 3-35
cutting, line art ... 3-19

editing ... 317

naming ... 3-15, 3-33

pasting ... 3-19-22

printing picture ... 3-37

printing scanned line art ... 3-24
saving scanned ... 3-12, 3-23, 4-11
scaling ... 4-14

scanning pictures ... 3-33
selecting area ... 3-29
size ... 3-32

view ... 3-17,3-34
image editor window ... 3-3, 3-17-26, 4-35

minimizing ... B-4
opening ... 4-42

removing ... B-4

restoring ... B-4

uses for ... 4-35

using keyboard with ... B-9

Image Scan ... 3-14-16, 4-5, 4-11
change gray ... 4-12
contrast ... 4-13
dialog box ... 3-14, 3-32, 4-12
final size ... 4-14

intensity ... 4-13
mirror image ... 4-14
original includes gray or color ... 4-12
selecting area with keyboard ... B-7
selection box ... 3-12
steps ... 4-11
using after Preview Scan ... 4-11
image type ... 4-5-6,4-12
installation
adapter ... 2-3-6
automatic document feeder ... D-4
disk ... 22
guide ... 1-2,2-2 D-4
interface cable ... 2-8
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interface card ... 2-3

messages ... 2-11
problems ... 2-14
software ... 2-1
steps ... 2-1
test ... 2-11,2-13
intensity ... 3-10, 4-13
level ... 4-8
selecting ... 4-5
text scan ... 4-20
interface cable
connecting ... 2-8
disconnecting ... C-6
item number ... A-11

interface card
bracket ... 1-5,2-6
handling precautions ... 2-2
illustration ... 1-4
inserting in computers ... 2-3
slot cover ... 2-6
switch settings ... 2-2
interface connector, location ... 1-5
interface kit ... 1-3
interference, tv and radio ... 1v
italic font, use in this guide ... wvi

jams see: paper jams

keyboard
canceling dialog box with ... B-6
learning ... B-9
opening menu ... B-6
selecting area for image scan ... B-7
using to crop ... B-7
using to cut ... B-7
using with Scanning Gallery Plus ... B-6
with dialog box ... B-6
with image editor window ... B-9
with scanner window ... B-8
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lamp

computer error ... C-4
replacing ... C+H4
lamp cover
location ... 1-5
removal ... C-9
replacement ... C-17
language, for text scan ... 4-20

legal rights see: warranty
LePrint 3.0 ... A-8
lever, green release ... 1-6
light see: lamp
line art ... 4-12, see also: picture
applications that support ... 52, 5-4, 5-7, 5-15
contrast ... 4-13
contrast scroll bar ... 4-9
defined ... 4-5
how to scan ... 3-8, 3-26
original includes gray or color ... 4-12
steps using various ... 4-22,4-22
locking the scanner ... 1-8
Lotus Manuscript ... A-8

magazine pages, in automatic document feeder ... D-11
maintenance ... C-20

by user ... C-2

by your local dealer ... C-23
maximium document level mark ... D-9
maximum document level mark, location ... D-3
menu

choosing ... 3-7

control ... B-2

edit ... 3-35, 4-45-48

file ... 4-3-44

help ... 4-33-34

opening with keyboard ... B-6

preferences ... B-20

scan ... 4-5,4-49

settings ... 4-21-32, 4-51-54

setup ... B-17

view ... 3-34,4-50



messages
error ... xii, 2-11, 2-14, A-12-22

start-up ... 2-11
metal clips, Mylar guide ... D-16
metal frame, Mylar guide ... D-16
metal rods, automatic document feeder ... D-6
Microsoft Paint ... 5-14-15
image distortion ... 5-15
printing problems ... 5-15
‘problems editing grayscale images ... 5-14
problems printing scanned images ... 5-14
scrolling ... 5-15
steps to edit image with ... 5-14
steps to scan with ... 5-14
system error ... 5-15
zooming ... 5-15
Microsoft Windows
commands available with ... 4-21
learning ... B-1-27
license agreement ... C-25
need for ... 4-19, 427, 4-30, 4-44, 4-53, 5-16
run-time version ... 3-2
starting Scanning Gallery Plus from ... 3-2
system settings ... 4-43, B-10
mirror
image ... 414
internal ... 1-6
unlocking ... 2-10
model number for scanner ... 4-4
mouse
actions defined ... vi, 3-5
active button, changing ... B-22
buttons ... 3-4
double-click rate, changing ... B-14
double-click rate, testing ... B-14

need for ... 2-1, 3-1

options, changing ... B-22
pointer ... 3-4, B-22

practice with ... 3-4

types supported by scanner ... x
using the keyboard instead ... B-6



move
command ... B-3
Mylar guide ... D-2-24

N  negative image ... 4-5,4-13
number format, creating new country settings for ... B-26

O  OCR see: optical character recognition
on-off switch see: power, switch
open, dialog box ... 4-36
optical character recognition

applications ... 5-17

available packages ... 5-16

columns, problems scanning ... 5-18
multi-page scanning ... 5-18

poor scanned text quality ... 5-17

ReadRight ... 4-5, 4-19
ReadRight OCR ... 5-16

ReadRight, with a run-time version of Windows ... 5-17
ReadRight, with Microsoft Windows ... 5-17
ReadRight, steps to scan with ... 5-16

specify ReadRight OCR ... 4-30
software A-8

tables, problems scanning ... 5-18
WordPerfect ... 5-16
WordPerfect, steps to merge text with document ... 5-17

original includes gray or color box ... 3-28, 4-55 4-12, 4-15

P packaging material see: box
anti-static bag ... 2-2
saving ... 1-2
scanner ... 1-6
packing list, scanner ... 1-2
page composition see: word processing
PageMaker ... 5-6, A-8

scaling ... 5-5

steps to merge image with document ... 5-4

steps to scan with ... 5-4

using with Scanning Gallery Plus and Microsoft Paint ...
5-6

Index-14



using with Scanning Gallery Plus and PC PaintBrush ... 5-
6
PageView ... A-8
paper see: document
alignment with document set mark ... 3-9
automatic document feeder ... D-11
curls, wrinkles ... D-10
guide see: document guide
in the automatic document feeder ... D-10
jams, clearing ... D-12-15
-landscape orientation ... B-17
placement for scanning ... 3-9
portrait orientation ... B-17
recommendations ... D-10
size, automatic document feeder ... D-9
size, changing for Image Scan ... 4-11
size command ... 4-21, 4-26
size, default setting ... 4-21,4-26
size, dialog box ... 4-26
size, selecting ... 4-26
paper jams ... A-4
parts
automatic document feeder, illustration ... D-3
interface card illustration ... 1-5
scanner, illustration ... 1-4
paste ... 3-19-22, 4-46
command ... 4-45, 4-47
PC PaintBrush ... 5-10-13, A-8
color images ... 513
editing the image ... 5-11
file conversion programs ... 5-11
image size ... 5-13
large images, editing ... 5-12
steps to scan with ... 5-10
phone number see: customer assistance phone number
phototypsetters, resolution for ... 4-22
picture see: line art -and- image -and- grayscale
defined ... 4-6
how to scan ... 3-27-39
original includes gray or color ... 4-12
place text in a new file ... 4-20
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plastic piece see: Mylar guide

plotter colors, setting ... B-17
pointer
adjusting speed ... B-22
changed to hourglass ... 3-11, 3-21, 4-37
pointing with mouse ... vi, 3-5
Polaris Forms ... A-8

Polaris Labelmaker ... A-8

Polaris Pack Rat ... A-8

Polaris Printmerge ... A-8

Polaris RAM Resident Printmerge ... A-8
Polaris ScanControl ... A-8

power
cord ... 1-2
cord, attaching to scanner ... 2-10
cord receptacle, location ... 1-5
indicator, location ... 1-4
requirements ... 1-10
specifications ... C-27
switch, location ... 1-5

power up see: start-up

preferences memu ... B-20

pressing with mouse ... 3-5

Preview Scan
change gray ... 4-7

contrast control ... 4-8

dialog box ... 3-11, 4-5

intensity level ... 4-8

line art ... 3-9

negative image ... 4-9

original includes gray or color ... 4-6

picture ... 3-28

scanned as ... 4-7

steps ... 45

using before Image Scan ... 4-11
print

command ... 4-38

dialog box ... 4-38-39, 4-41

grayscale image ... 3-37

HP direct ... 3-24, 3-37, 3-40

image ... 3-24



number of copies ... 4-38
picture image ... 3-37
portion of image ... 4-38
steps ... 4-38
versus HP direct print ... 4-40
printer
adding new ... B-15
connecting ... B-16
default, setting ... B-16
output modes, setting ... B-17
port, changing ... B-16
removing ... B-15
resolution settings for ... 4-22
serial ... B-18
serial communication ports, setting ... B-16
timeouts setting ... B-17
printers, types supported by scanner ... xi
printing history ... iii
problems
applications ... 5-1
banding or striping with PageMaker ... 5-5
changing paper size after Preview Scan ... 4-26
configuration ... 2-10
compression ... 4-b1
crooked image on screen ... 3-9
detecting ... 2-11
disk space ... 4-51
editing grayscale images from Microsoft Paint ... 5-14
fitting interface card into slot ... 2-6
finding help ... xiii
hardware failure ... 2-12-15
image distortion with Microsoft Paint ... 5-15
image enlargement in PageMaker, PC PaintBrush, Microsoft
Paint ... 5-6
image quality, with Pagemaker ... 5-6
image quality with Ventura Publisher ... 5-7
installation ... 2-14
interference patterns ... 4-22
large image editing from PaintBrush applications ... 5-12
memory requirements with PC PaintBrush ... 5-13
memory requirements with Publisher’s PaintBrush ... 5-13

Index-17
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optical character recognition, columns ... 5-18
optical character recognition, tables ... 5-18

poor text quality with optical character recognition ...

printing from Microsoft Paint ... 5-14

quality of dithered images ... 4-16

resolution quality with grayscale ... 4-22

resolution quality with line art ... 4-21

scanner failure ... 2-12-15

scrolling with Microsoft Paint ... 5-15

selection box ... 3-13

start-up ... 2-11

solutions table ... A-8

system error, Microsoft Paint ... 5-15

width and height of scanned image ... 4-22

zooming with Microsoft Paint ... 5-15
program see: software -or- name of specific program
prompt, system ... 2-11

proportional scaling ... 3-32, 4-14, 4-48
Publisher’s PaintBrush ... 5-10-13, A-8
color images ... 5-13
editing the image ... 5-11
file conversion program ... 5-11
large images, editing ... 5-12
steps to scan with ... 5-10
question mark, meaning ... 4-33

questions see: problems
Quick Reference Guide ... 2-14

radio frequency interference statement ... iv
radio reception see: interference
ReadRight ... A-8
file formats supported by ... 4-20
languages supported by ... 4-20
need for ... 4-19, 4-30
rear view, scanner ... 1-5
redo, steps ... 4-45
regulatory statements ... iv
release
lever ... 1-6

5-17



releasing the mouse ... 3-5
repacking the scanner ... 1-8
repair ... C-18, C-20
replacement guide see: Mylar guide

resolution ... 4-21
changing ... 4-11
current setting ... 4-24
custom, setting ... 4-24
default setting ... 4-21

dialog box ... 425
dithered image ... 4-21
grayscale ... 4-22
horizontal and vertical settings ... 4-25
how to select ... 4-21
line art ... 4-21
matching to printer ... 4-15
New Year’s ... 4-21
printer type ... 4-22
quality ... 4-23
range ... 4-25
scale range for width and height scroll bars ... 4-15
scroll bar ... 4-25
steps to change ... 4-24
types ... 4-25
restore see: redo -and- paste
rods see: metal rods
run application

command ... 4-4
sales and support offices ... (C-21-22
save image dialog box ... 3-15,4-38
save text ... 4-20
scale

automatic ... 4-48

in clipboard ... 4-48
in PageMaker ... 5-5
with Ventura Publisher ... 5-9

scan all pages in document feeder ... 420
scan menu, steps ... 4-49
scan types ... 4-5

SCANGAL directory ... 2-12,3-2
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ScanJet Plus User’s Guide

item number ... A-7
scanned as ... 4-6,4-12
scanner

failure ... A-4,2-12-15

item numbers ... A-T

scanner window ... 3-3, 3-8-16, 4-2-34
closing ... 3-16, 3-33
opening ... 4-49
uses for ... 4-2
using keyboard with ... B-8
Scanning Gallery Plus ... 2-13
exiting ... 3-37

reference ... 4-1-54

running applications from ... 4-21
ScanJet compatibility ... xii
starting ... 3-2

using other applications with ... 5-1

ScanPro ... A-8

Scantest ... 2-12-13
SCANTEST.EXE ... 2-13
screen color ... 4-43, B-20

screen colors ... B-21
selection box ... 3-12-13
service see: maintenance
settings menu ... 4-21, 4-51
setup menu ... B-17

shipping see: packaging
shipping list see: box, contents
site see: environment

site, for the scanner ... 1-10

size see: specifications -and- dimensions
final scanned image ... 3-14
height of scanned image ... 3-32
image, changing ... 3-32
image in scanner window ... 4-5
image, scanned ... 4-15
selecting final image size ... 3-32
width of scanned image ... 3-32
windows, changing ... B-2

size image, reducing ... 3-35
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SISETUP ... 2-2
SISETUP, changing graphics cards ... B-21
software
current version number ... 4-44
installation ... 2-2
Installation Help booklet ... 2-2
other packages for scanner ... A-8
problems ... 2-12, A-2
supported ... xi
version number ... 4-4
specify applications ... 4-53
specify detail view, steps ... 4-50
specify ReadRight OCR ... 4-21
start-up ... 2-8
problems ... 2-12,2-14
static electricity ... 2-2
steps
using various ... 4-22

sticky-backed paper, in automatic document feeder ...

supplies, shipped with scanner see: box, contents
switch see: address, switch

switch setting examples ... 2-3

switch settings ... 2-12

system error ... 2-12

system settings, Microsoft Windows ... B-10

temperature
operating range ... C-27
test
automatic document feeder ... 2-12
installation ... 2-11, 2-13
scanner ... 2-12,2-14
Scantest ... 2-12
test program ... 2-2
text scan ... 4-5,4-19
time

D-11

format creating new country settings for ... B-25

setting ... 4-43, B-10
top cover see: copyboard cover
transmission retry setting ... B-17
transparencies, in automatic document feeder ...

D-11
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troubleshooting see: Scantest, see also: maintenance -and-
problems

True Scan ... A-12

TV reception see: interference

typewriter font, use in this guide ... vi

U underlined keys ... 4-29, B-8
underscore see: cursor
undo/redo ... 4-45
unlocking the scanner ... 1-6
unpacking the scanner ... 1-2
user’s guide

edition number ... iil
printing history ... iii
updates ... 1il

Vv Ventura Publisher ... 5-7-9, A-12
steps to merge image with document ... 58
steps to scan with ... 5-7
verification of installation see: installation, test
verifying setup see: installation, test
vertical line dither see: dither patterns
video adapters and monitors, types supported by scanner ...
x
view ... 3-17, 3-34, 4-50
voltage regulator ... C-27

w warning
adapter configuration error ... A-5
no adapter description file ... A-5
warning statements
meaning of ... i
removing copyboard glass ... 1-4
warranty
automatic document feeder ... D-2
hardware ... C-18
service ... C-18, C-20
width see: dimensions
final scanned image ... 3-14
scroll bar ... 3-32, 4-15
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WIN, SCANGAL ... 3-2
Winchester see: disk
windows
active ... 3-3,4-2
changing position of ... 3-3
editing image ... 3-3
minimizing ... 3-3
moving between ... 3-3,4-2
moving images from one to another ... 4-46
picture of ... 3-3
saving image in ... 3-3
scanning image ... 3-3
size ... 4-43
size, changing ... B-2
WIN.INI ... B-27
wire loop connectors ... 2-8
word processing applications ... 5-2-9
word processor
types for applications ... 5-18
WordPerfect ... 5-2
steps to merge image with document ... 5-3
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